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Safety and Preparation for Use

WARNING!

Dangerous voltages, capable of causing injury or death, are present in this instrument.
/\« Use extreme caution whenever the instrument cover is removed. Do not remove the cover

while the unit is plugged into a live outlet.

Line Cord
The RGA built-in power module option (Opt02) has a detachable, three-wire power cord
for connection to the power source and to a protective ground. The exposed metal parts of
the instrument are connected to the outlet ground to protect against electrical shock.
Always use an outlet which has a properly connected protective ground.

Service

Do not attempt to service or adjust this instrument unless another person, capable of
providing first aid or resuscitation, is present.

Do not install substitute parts or perform any unauthorized modifications to this
instrument. Contact the factory for instructions on how to return the instrument for

authorized service and adjustment.

Fan
The fans in the RGA are required to maintain proper operation. Do not block the vents in
the chassis or the unit may not operate properly.
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Specifications

Operational

Mass Range:
RGA120
RGA220
RGA320

Mass filter type

Detector type

Resolution
(per AVS standard 2.3).

Sensitivity (A/Torr)*

Minimum detectable partial
pressure (MDPP)*

Operating pressure range

Max. bakeout temperature
(without ECU)

Operating Temperature

Recommended bakeout
temperature

Total press. measurement

1to 120 amu
1to 220 amu
1to 320 amu

Quadrupole
(Cylindrical rods, rod diameter: 0.25”, rod length: 4.5”)

Faraday cup (FC) - standard
Electron multiplier (CDEM) - optional

Better than 0.5 amu @ 10% peak height
Adjustable to constant peak width throughout the entire mass
range.

2:10* (FC)
<200 (CDEM). User adjustable throughout high voltage range.

510 Torr (FC).
510" Torr (CDEM).

10 Torr to UHV (FC)
10 Torr to UHV (CDEM)

300°C

70 °C (max.)
200 °C (O100HJR Heater Jacket recommended)

Available with FC ion current measurements

* Measured with N, @ 28 amu with 1 amu full peak width @ 10% height, 70 eV electron energy, 12 eV
ion energy and 1 mA electron emission current.

lonizer

Design
Operation
Material

Filament

Open ion source, cylindrical symmetry.
Electron impact ionization.
Stainless steel, type 304.

Thoriated Iridium (dual) with firmware protection. Field
replaceable.
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Degas 1 to 8 W Degas ramp-up.
Electron energy 25 to 110 V, programmable.
lon energy 410 16 V, programmable.
Focus voltage 0to 110 V, programmable.
Electron emission current 0 to 4.0 mA, programmable.

Analog Output

Function Emission Current, RTD Temperature, Flange Temperature, Total Pressure, Mass lon
Current, Analog Scan lon Current, or User Value

Range Voltage 0Oto20V
Current 4to0 20 mA

Resolution  Voltage 0.3 mvVv
Current 0.4 pA

Accuracy! Voltage +0.1% +5mV
Current +0.1 % + 10 pA

1Output accuracy specifications are for User values. For linked output values, the
accuracy is determined by the measured parameter being output

Max Output Current (Voltage Out) 50 mA
Max Load Resistor (Current Out) 750 Q

Analog Input

Functions User Value or Overpressure Indicator

Range Voltage 0Otol0V
Current 4 to 20 mA, 4 to 20 mA with Loop Power
Resolution  Voltage 1pVv
Current 1nA
Accuracy Voltage +0.1% +5mV
Current +0.1 % + 10 pA
Input Impedance
Voltage 10 k€ each lead to ground
Current 100 Q nominal

Absolute Maximum
Voltage 24V
Current 25 mA
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XX Specifications

Loop Power Voltage

Range
Resolution
Max Current

Event Relay

Function

Events

Relay Contact Rating
Max Switching Power
Max Switching Voltage
Max Switching Current

GPIO

Function
Output Events

Output Voltage Limits
Input Voltage Limits
Absolute Maximum

Transition Voltage

RTD Input

Nominal Pt RTD Resistance
Nominal Lead Resistance
Voltage Out Maximum

Current Out Maximum

Oto20V
0.005V
50 mA

configurable DPDT relay that can be set to switch on an event or set by
user

Analog Input Current or VVoltage Limits, Mass lon Current Limit,

Communications Idle Timer

60 W, 75 VA
125 VDC, 150 VAC
2A

configurable digital output or digital input. Digital output can be set to
switch on an event or set by user.

Analog Input Current or Voltage Limits, Mass lon Current Limit,
Communications Idle Timer

LoOV,Hi33V
0to3.3V
3.3V

Programmable. Default 1.65 V

100 Q (at 0 C)
0.25Q
3V

1mA
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Trigger Input
Voltage Limit
Absolute Maximum

Transition Voltage

Computer Interface

Ethernet
Connector
Speed
Protocols

USB
Connector
Speed
Chipset
Device Class
Software Drivers
Baud rate

RS-232
Connector
Format
Baud Rate

General

Probe dimension
Probe insertion

Probe mounting flange
Minimum port 1.D.

ECU dimensions

Oto3.3V
3.3V

Programmable. Default 1.65 V

RJ45
10/100 Base-T
TCP, UDP and DHCP

USB Type B

USB 2.0 Full speed (12 Mbps)
FTDI230XQ

USB communication device class (CDC)
Virtual COM Port (VCP) driver from FTDI
115200

9 pin D-Sub Female Connector
8 Bits, 1 Stop Bit, No Parity, CTS/RTS hardware flow control
28800

8.75” from flange face to top of ionizer

2.0”

2.75” CF

1.375”

9.1” x 4.17x 3.1”. Easily separated from the probe for bakeout.

SRS Residual Gas Analyzer
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xxii ~ Specifications

LED indicators Power (ON/OFF), Filament (ON/OFF), CEM (ON.OFF), Degas
(ON/OFF), Communication Activity (Busy signal),
Communication Error, Pressure Error, and System Error.

Software Windows OS based application.

Power Requirement 24 VDC @ 2.5 Amps. Standard barrel connector, 5.5mm OD, 2
B"S%L'ﬁa 110/120/220/240 VAC (50/60 Hz) built-in power
module.

Weight 6 Ibs.

Warranty One year parts and labor on materials and workmanship.
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Remote Command List

Calibration Commands

LN = 1= I O I R R R O UPUPURRRRN
CALIBRATE ......ccocviivieinnn
CALIBRATE < integer >........
ELECtrometer:CALibrate
ELECtrometer:CALibrate:AUTO < O | 1 | OFF | ON > ..ooiiiiiiiie e esiee st sitee e e e nea e nntae e e e e neeas 6-16
ELECtrometer:CALIDIAtEIAUTO?. ... .eiiiii ettt e st e s e e s e nree e 6-17

lonizer Setting Commands

IONIZER:ELECTRON:VOLT <integer | DEFault> .. 6-17

.. 6-17

IONIZER:ELECTRON:VOLT?....oiiiiiiiiieirit sttt .

IONIZER:EMISsion <floating point value in mA | DEFault | OFF> .........ccccooiiiiiiiiiii e 6-17
IONIZERIEMISSIONT? ...ttt ittt etttk ettt h et bt h ekt b e b e e b et e bt e bt e s b bt e sab e e nbn e e nan e e nnneenanee e 6-18
IONIZER:EMISsion:STORED <value in MillIamPS> ........cuviiiiiiiiiiciie e 6-18
IONIZER:EMISSION:STORED? ...ttt ettt ettt ettt et sie e b bt sis e s bt e san e ser e e nan e e nnneenaree e 6-19
IONIZER:FOCUS:VOLT <volts | DEFault> ... 6-19
IONIZERIFOCUS:VOLT 2 .ttt ittt ettt etttk b bbbt b e s bt sbb e s bt e shb e e s b bt e nan e e sbn e e nab e e nsbeenaree e 6-19
IONIZER:ION:VOLT <value in volts | DEFault | LOW | HIGN> .....cooiiiiiiii e 6-19
IONIZER:ION:VOLT 2 .ttt ettt ettt bttt b ekt b e ekt e b et e be e e ebb e e e b bt e abb e e e bt e e aab e e sbbeesabeesnbeesnnee e 6-20
IONIZER:POTENTIALS:AUTOmMode <0 | 1 | OFF | ON | DEFAUIt >........coociiiiiiiiiieiiiencccenee e 6-20
IONIZER:POTENTIALS:AUTOMOUE? ...ceeiitiie ettt ettt ettt sttt e et e e s bt e s e e e s nne e s 6-20

Scan Commands

SCAN:ANAIOG? ....coovvviiiiee ... 6-21
SCAN:ANAIOG:POINTS?....ceiiiiiiiiiieeeiiieeee .. 6-22
SCAN:FILTER:ENGDIE < O | 1| OFF | ON >ttt ettt ettt ettt snn e nnne s 6-22
SCANIFILTERIENGDIE? ...ttt e e e bt e et e e s e e e nr e e s s 6-23
SCAN:HISTogram?............eueeee ... 6-23
SCAN:HISTOgram:POINTS?.....ooviiiiiiiiiiieee e ... 6-23
SCAN:MASS:FINAL < integer value in mass units > ........ ... 6-24
SCANIMASSIFINAL? ..ttt ettt e e s bt e e ek et e e sb et e e 1a bt e e ab b et e e anbe e e e snbn e e e abr e e e e nnes 6-24
SCAN:MASS:INITial < integer value in MASS UNIS > ......ccoiiiiiiiiiiee et neee e 6-24
SCANIMASSINITIAI? ettt e e et et e e s et e e st e e et et e et e e snb e e e e bn e e e s nnes 6-25
SCAN:MULTIPLE? < (m1, m2, ... mn) > list of integer mass numbers 6-25
SCAN:OFFSET:AUTO <O | 1| OFF |ON >...ciiiiiiiiiiiieee e ... 6-26
SCAN:IOFFESETIAUTO? ..ttt ettt ettt e ettt e et e e bt e e e bt e e e bt e e e bttt e e aabe e e e sn b e e e abneeennnes 6-26
SCAN:OFFSET:AVERAGE < iNteger VAU > ......cooiuiiiiiiiiiieeieee ettt 6-26
SCANIOFFSETIAVERAGE?......ci ittt ettt ettt e s b e e e bt e et e e s e e e e br e e s s 6-27
SCAN:OFFSET:CEM < floating point value in 10-16 A ...t 6-27
SCAN:OFFSET:CEM? ...oiiiiiiiiiiiiiiiiiiiiveieevveivvevevvvvveeaeaeeeees ... 6-27
SCAN:OFFSET:FC < floating point value in 10-16 A >..... ...6-28
SCAN:OFFSETIFC? ..eoiiiiiiiie e ... 6-28
SCAN:RATE < floating point value in amu Per SECONT > .........uuiiiiiiiiiiiiiiiee e 6-28
SO AN R AT E 2 ittt ettt ekt e e a et o bt E bR b et oo e b e e e Rt et e e e e e e e 6-29
SCAN:RATE:ANAlog? .......... ... 6-29
SCAN:RATE:HISTOQram? .....ccovviuvrieiieeiniireeeeee e ... 6-29
SCAN:RESolution < integer divisions per amu > .............. ... 6-29
SCANIRESOIULIONT ...ttt et e e ekt e et e e st e e et et e e e e e e s nn e e e e nn e e s 6-30
SCAN:SETTLINGtime < time in MIllISECONAS >.......cooiiiiiiiiiiii e 6-30
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SC AN SE T TLINGIIME? .eettititeeeeeteeeeeeeeeeeeeeeesesesaeesssasesesesasasesesasesesasesssasesssssasssssssssssssssasssssssnsssssnsnsnsnsnsnsnnnns 6-30
SCAN:SINGLE? < integer value in MaSS UNILS >.......c.vuiiiieiiiiiiiiiieee e st e e e e e s s e e e e e e s searsa e e e e e e s ensnanaeeeas 6-30

Filament Status Commands

FILAMENE EMISSION?. ...ttt et e e e e ettt e e e e e e e ea et e e e e e e e es s e eeeeeessraaaeeeeesesrannnns 6-31
FILament:VOLTage?............. ... 6-31
FILAMENTCURRENL? ...ttt e et e e et e e ettt e e e et eeeat e e e eaa e e st e eetaneestnnaaesnnneaees 6-31

CEM Settings commands

CEM:VOLT <DEFaUlt | VAIUE IN VOIESS ......oiiiiiiiiiiiie ettt st e 6-33
CEM:STORED:GAIN <valuex1000>........... ...6-32
CEM:STORED:GAIN? ....coooviiiiiirrieireennen ... 6-32
CEM:STORED:MASS <value in AMU>....... ... 6-32
CEM:STORED:MASS? ..ottt sttt ettt ettt ettt ettt h et b e b bt s bt e e et bt e s hb e e eh bt e ebe e e bb e e s bbeeebb e e sbbeenbbeeneneenneeas 6-33
CEM:STORED:VOLTAage <VAIUE IN VOIIS> .....oiiiiiiiieiiiiee ettt e e e e s 6-33
CEM:STORED:VOLTAGE? ...ccutitittiatete ittt ettt ettt ette e sttt e sbee e sbeeeabe e e sbe e e stbe e s beeeabbeeabe e e bt e e sbbeeabbeesbbeenbeeesbneenaeeas 6-33

Degas Commands

DEGASIRUNNING? ...ttt ettt e e ettt e e e e e et b ettt e e e e e e a bbb et e e e e e e s aabbbe e e e e e e e sansbbneeeaeaeaan 6-34
DEGAS:START ...6-34
DEGAS:STOP ...6-34
DEGAS:TIME <integer minutes | DEFault> ... 6-35

DEGAS:ITIME? ...ttt ettt e ettt e et e e et e e ekt e e et e e s et e e e e e n e 6-35

Pressure Commands

PRESsure:SENSItivity:PARTIAL < value in MA/TOIT > ...t 6-35
PRESsure:SENSItivity:PARTIAL? ..., ...6-35
PRESsure:SENSitivity: TOTAL < value in mA/Torr >......... ... 6-36
PRESSUre:SENSItIVIY: TOTAL? ....ooiiiiiiiiiiieeee e ... 6-36
PRESsure:SENSItivity: TOTAL:OFFSET < value in 10-16 A > ....ooiiiiiiiiiiiiiee et 6-36
PRESSUre:SENSItIVIty: TOTALIOFFESET? ...coitiiitieitie ettt sttt sttt enanee 6-36
PRESSUre:TOTAL:ENADIE < O | 1 | OFF [ ON S .iiiiiiiiiieiiie ettt sttt sttt sneee e 6-36
PRESSUIE: TOTALIENGADIE? ...ttt e s e e 6-37
P RESSUNEI TOTAL? ..ttt ettt e e e e bt e et e e e bt e e s bt e e a bt e ea b e e e s e e et e e s s e e naneens e e naneean 6-38

Instrument Status Commands

STATuUs:CONDiItion? < Status register NUMDET > ... e
STATus:CONDition? < status register number, integer status bit > ...........ccccoiiii e,
STATUSI CONDIION ASSERT ...ttt ittt a bt e e e bt e e s b e e e e b b et e s aabe e e e asbr e e e abreeennnees
STATUSIDEFAUITMASK. .....ceeeieeeiiiieee ettt e et e e e e e e st et e e e e e e e s bbb et e e e e e e s aabbbeeeeeeeeannnneneeeas
STATus:EVent? < status register number >......................

STATus:EVent? < status register number, status bit >
STATus:EVent:ENable < status register number, integer value >
STATus:EVent:ENable < status register number, status bit, 0 | 1 | OFF | ON >
STATus:EVent:ENable? < status register NUMDET > ...
STATus:EVent:ENable? < status register number, status bit >
STATUSIGLOBAI? ...ttt
STATus:GLOBal? < status register number >................... .
STATuUs:GLOBal:SERVicemask < iNteger VAlUE > ..........ooiiiiiiiiiiiaaee e
STATus:GLOBal:SERVicemask < status register number, 0 | 1 | OFF | ON >.......occociiiiiiiiiieeeiiiee e
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STATUS:GLOBAL:SERVICEMASK?......eiiiiiiiiiiitiitieeeeeereeesesesasesessessesssesesasssesssarererarerererererererrrrrerererererererrrmrr 6-43
STATus:GLOBal:SERVicemask? < status register NUMDET >.........coiiiiiiiiiiiiiiiiee e 6-43

Mass Filter Control Commands

MF:MASS:LOCK < VAIUEB IN AIMU S....iiiiiiiiiiiiie e e et e e e e e e e et tee e e e e e e e eaaaaaeeeeeesssbaaaeeeeeeessaansaaeeees 6-44
Q

QMF Tuning Commands

QMF:DC:OFFSET < value in VOIS | FACTORY > ...ttt ettt ettt 6-45
(01 I B IO @ = =S = PSPPSR ST POPR 6-45
QMF:DC:QUADratic < value in Volts per AMU2 | FACTORY > ....oiiiiiiiiiiiiieeiiee et 6-45
QMF:DC:QUADIALIC? .....ee it ettt ettt ettt ettt bee b sneeeneeas ... 6-46
QMF:DC:SLOPE < value in Volts / AMU / MHz2 | FACTORY > ............. ... 6-46
QMEFIDC:SLOPE? ...ttt ettt ... 6-47
QMF:RF:OFFSET < value in VOItS | FACTORY > ..ottt 6-47
QM IRFIOFFSET? ..ttt ettt ettt ettt b e bt b ekt b et b et e bt ekt e bt e e ket e bt e nbn e e bt e neneennr s 6-47
QMF:RF:QUADratic < value in Volts per AMU2 | FACTORY >.....cooiiiiiiiiiieeiiiee et 6-47
QMPFIRFIQUADTAEC? ....vtitteetet ettt ettt ettt ekt b et h e b et h et et et ekt e bt ek e e e bt e s be e e bt e nbneenbn e e neneennreas 6-48
QMF:RF:SLOPE < value in Volts / AMU / MHz2 | FACTORY > ... 6-48
QMEIRFISLOPE? ...ttt etttk h e bbbt h et eb et ekt e bt ekt e bt b b nen e s 6-48
QMF:SHIFT:POSItion:OFFSET < value in AMU > ..ot et e e e 6-48
QMF:SHIFT:POSItion:SLOPE < value in AMU per AMU > ...t 6-49
QMF:SHIFT:WIDTH:OFFSET < Value in AMU >.....ciiiiiiiiiiiieiie ettt nnne s 6-49
QMF:SHIFT:WIDTH:SLOPE < value in AMU per AMU >.. ... 6-50
QMF:TUNE:AUTO:ENable <O | 1| OFF|ON > ............... ... 6-50
QMF:TUNE:AUTO:ENabDIe?.......cocviiiiiiiiiiiceiceee ... 6-52
QMFTUNE:FACTORY:LOAD. ... et iititeitit ettt ettt ettt et be e sbb e s bt e e sab e e sbb e e sbb e e sbbeeabbeesbeeenbbeesaneenaneas 6-52
QMETUNEIRESULTS? ..ttt ettt ettt ettt ettt b e bbbt s bt e bt e sbe e e bt e s b e e bt e st e e bt e neneennne s 6-52

QMF:TUNE:TABLE < (m1, m2, ... mn) > list of integer mass numbers .. ..6-54

QMETUNE:TABLE? ..ot ... 6-54
QMF:TUNE:WIDTH < value in AMU | DEFault > ............. ... 6-54
QMETUNEIWIDTH? .ttt et s e e e ekt e e s et e e s bt e e e bttt e e aabe e e e snb e e e abne e e s nne s 6-55

Temperature Status Commands

TEM P EIATUIE C P U 2 L. e e e e et e et e e e e et e e e et e e eata e e e at e e et e esaaaeeesatneeeanans 6-55
TEMPEIAtUIEIFLANGE? .. oottt et e et e et e e e et e e e et e e s et e e eatn e e et e e esanaeesatnaaeeranns 6-55
TEMPEIAtUIE I HVIDOAIT?. ... ettt e ettt e e e e e e e e et e e e e e e eeeaaaeeeeeeessssataeeeeeenases 6-55

Trigger Commands

TRIGQEr:SCAN:ENADIE < O | 1| OFF | ON > ..ottt e e e s st e e e e e e s s netaeeeaaeeeannnnes 6-55
TRIGQer:SCAN:ENADIE?........ccooiiiiiiiiiiieeeiece e 6-56
TRIGger:SCAN:MODE <0 |1|2|3|LOw | HIgh | RISING | FALLING > ... 6-56
TRIGGENSCANIMODE?.......oeeiiiiiii ettt et e e st e e et e s sre e e e asre e e e ann e e e s enreeesasneeeennns 6-56
TRIGQEINSOFTWAIEIARM ...ttt ettt e e e et e e e e e e e e et e e e e e e e et e e e s e srnr e e e eeenaannnee 6-57
TRIGger:SOFTware:ENable <0 |1 | OFF|ON>............. 6-57
TRIGger:SOFTware:ENable? ........cccoovviieiiieeeees 6-57
TRIGQErSOFTWAIEIFIRED? ... ... 6-57
TRIGger:SOFTware:MODE <0 | 1|2 |3 | LOw | HIgh | RISING | FALLING >......cccociiiiiiiiieiiiieeeniieeens 6-58
TRIGQENSOFTWANEIMODE? ...ttt e e e e e e et e e e e e e et e e e e e eeeeeenaaannee 6-58
TRIGger:SOFTware:RESET 6-58
TRIGQer:SOFTWare:STATE? ..o ... 6-58
TRIGger:-THRESHOLD < value in VOItS | DEFAUIt > ........cooiiiiiiiiee e 6-59
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LR L T =T I 1 1 N OSSPSR 6-59
TRIGOEIV ALUE?. ... 6-59

Analog Current Output

IOUTPULIENGDIE < OFF | ON | O | L > oottt e e e e ettt e e e e e e e et et e e e e e e easnsnaeeeaaeeeaannees
IOUTpuUt:ENable?.....cccceeeiviiiieieee e, .
IOUTput:MANuUal < value in MIllIAMPS > ...t e e e e e ettt e e e e e e e sebaeeeaaeeeannees

TOUTPRULIMANUAI? ...ttt e e e e et e e e e e e e b e e et e e e e seasatbseeeeeeeasaabbaeeeeesaasasraareeaeeesannres 6-61
IOUTput:MASSreading:AMU < integer in AMU >..............
IOUTput:MASSreading:AMU?.........ccciviieee et
IOUTput:MAXout < DEFault | value in milliAmps > ........... .
IOUT PULIMA X OUL? .ot e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e aaeaaaaaaaaaaaas 6-62
IOUTput:MINout < DEFault | value in MillIAMPS > ......ooiiiii e 6-62
TOUTPULIMINOUL? <.t e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e aaaaaaans 6-63
IOUTput:SELection < integer | KEYWOIT > .....ccoocuuiiiiiiiie ittt st e e e e s

IOUTPULSELECONT ...ttt .
IOUTput:SELection:LOG < integer | keyword, LINear | LOG | O | 1 > ..oiiiiiiiiieiiiiiee e
IOUTput:SELection:LOG? < integer | KEYWOIT > ........oeiiiiiiiiiiiiie et
IOUTput:SELection:MAX <integer | KEYWOrd, VAIUE >.........c.cccvviiiieiieeiiie st e e e saeesiveeseeesvessnaeesneee e
IOUTput:SELection:MAX? < integer | KEYWOI > ........oiiiiiiiiiiiiiieiiiee et
IOUTput:SELection:MIN < integer | keyword, value > .
IOUTput:SELection:MIN? < integer | KEYWOIT > .......uiiiiiiiiiiiiiie ettt

TOUTPULIVALUEB? ..ttt ettt ettt e e+ o ek bbbttt e e o4 e M bbbttt e e e e e e ah b b ettt e e e e e annbbb et e e e e e eanbbbeeeeeeeeaannres 6-65

Analog Voltage Output

VOUTPULENADIE K OFF | ON | 0| L > ittt ettt s et e s abre e e s e e e s snneeeenans 6-65
RV 10 I I o 10 o =1 N = o =PSRRI 6-65
VOUTput:MANual < value in Volts > 6-66
VOUTPUEMANUAI? .. 6-66
VOUTput:MASSreading:AMU < integer in AMU > ............ ... 6-66
VOUTPULMASSIEAAINGIAMU? ...ttt ettt et et e ettt e e b et e e sa bt e e e e e e s bt e e e s asbreenanes 6-66
VOUTput:MAXout < DEFault | value in VOIS > ........ooiiiiiii e 6-66
VOUTPUEMAXOUL? ...ttt e e ettt e e e e e et e e e e e e e s e e e e e e e e s e snnn e et ee e e e snnreeeeeenannnnns 6-67
VOUTput:MINout < DEFault | value iN VOIS > ...
VOUTPUEMINOUE? ..ot .
VOUTpPUL:SELeCtion < integer | KEYWOIT >......coiiiiiiiiiiiii ittt e e et e e e e s e st baeeeaeeeean
VOUTPULSELECHON? ...ttt ettt ettt ettt e e e ek bt e e e sttt e s bb e e e e ehbr e e e anbe e e e sbb e e e s asbreenann 6-67
VOUTput:SELection:LOG < integer | keyword, LINear | LOG |0 | 1>

VOUTput:SELection:LOG? < integer | KEYWOIT > .......coiuiiiiiiiiiiiieee ittt
VOUTput:SELection:MAX < integer | keyword, value in Volts> .
VOUTput:SELection:MAX? < integer | KEYWOIT >.......coiiiiiiiiiiieiiiee ettt
VOUTput:SELection:MIN < integer | keyword, value in VOIS >.........coooiiiiiiiiiiiiee e
VOUTput:SELection:MIN? <integer Or KEYWOIT>.........cooiiiiiiiiiiiiiiiiee e
VOUTPULVALUEB? ettt et e e e ettt e e e e e et e et e e e e e st et e e e e e e e e s nnn et e ee e e e nrnnneeeeenannannne 6-69

Analog Input Commands

[INPULILOOP < VAIUE IN VOIS > .ottt ettt e e e e ettt e e e e e e e e abbbeeeeaeeeannees 6-69
HNPUELOOP?. ...t 6-70
[INput:OVERPRESSURE:ENable <OFF |ON |0 | 1 >..... ... 6-70
[INPUL:OVERPRESSURE:ENGDIE? ......eviiiiiiiiiiiiiite ettt e e e e e et e e e e e s s nstneaeaaeeesnnees 6-70
[INput: OVERPRESSURE: THRESHOLD < Value iN MA > .. ..ot 6-70
[INPUt:OVERPRESSURE:THRESHOLD? ... 6-70
N DU Y AU 2 et e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e aaaaaaaaaas 6-70
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VINput: OVERPRESSURE:ENabIe < OFF | ON [ 0| 1> .eiiieiiiiieiiiiee s ciieeeeeee e reee e seee e s e s nneee e e sneeeeeenes
VINput: OVERPRESSURE:ENGDIE?......ccceeoiiiiiiiiiicciccec e .
VINput: OVERPRESSURE:THRESHOLD < value in VOIS >......c.cciiiiiiiiie e
VINPUt: OVERPRESSURE:THRESHOLD? ..ottt 6-71
VINDUEVALUB? s 6-71

RTD Commands

RTD:CORRection:OFFSET < value in C | DEFAUIL >.........ccooiiiiiiie et seee e 6-71
RTD:CORReCtion:OFFSET?....cccoviiieieieeeee ...6-72
RTD:CORRection:SLOPE < value | DEFault > ................. .. 6-72
RTD:CORREeCction:SLOPE?........coooovvieiii ...6-72
(R I S IS =1 (o YRR 6-73
R DR NN LY T PRPRPRRPPRPNS 6-73
RTDITEMPEIAIUIE? ..oen ittt et e et e e e e e e et e e e et e e e et e e eata e estan e eata e eettneestnnaaeennneaees 6-74

GPIO Direction and Input Commands

GPIO:DIRection < O | 1 [ INPUL | OQUTPUL > ...oiiiiiiiiiee ittt ettt et e et e e st e e e snteeeesneeeesnneeas 6-74
GPIO:DIRECHONT ..ottt ..6-74
GPIO:THRESHOLD < value in VOItS | DEFAUIL > .........ccciiiiiiiiiciieiit et 6-74
GPIO:THRESHOLD? ...ttt ettt ettt h ekt eb e b e bb e b bt e b b e e ket e be e e e bb e e bb e e sbeeenbbeesaneenneeas 6-75
GPIOILEVEL? ..ttt ettt h bbbt bt h e bkt b e bt bbbt ne e nnr s 6-75

Digital Output (Relay/GPIO) Limit Control Commands

GPIO:EVENT:ENable < integer, 0| 1 | OFF | ON >

GPIO:EVENT:ENable < integer bitfield value >.................

GPIO:EVENT:ENable? <integer > .......ccoceevviieeeninneennn

GPIO:EVENT:ENable? .........ccccevvieveennnn, .
GPIO:EVENT:CONDItION? S INEEOET S ....tiiiiiiiiieiiteee ettt ettt e ettt e e e e e e b e e
GPIO:EVENTICONDITIONT ..ttt ettt s e st e s s e e e e e e s s 6-78
GPIO:FORCE <-1|0|1| EVENT |LOw | HIgh>............ 6-78
GPIO:IFORCE?.....ciiiiiiii it 6-78
GPIO:LIMits:COMM:IDLE < integer value in seconds >.... ... 6-79
GPIO:LIMItSICOMMUEIDLE? ...ttt ettt ettt e bt e st e e e e e bn e e s s 6-79
GPIO:LIMits:[INput:HEEENable < O | 1 ] OFF | ON > ..ottt 6-79
GPIO:LIMItS: IINDULHEENGDIE? ...t 6-80
GPIO:LIMits: IINpUt:HEVALUE < VAIUE IN MA > oottt e e e e
GPIO:LIMits: [INPUt:HEVALUE? ..o .
GPIO:LIMits:IINput:HYSTERESIS < ValUE iN MA > ...t
GPIO:LIMItS: IINDULHYSTERESIS? ...ttt ettt ettt e e a e e 6-81
GPIO:LIMits:[INput:LO:ENable < O | 1| OFF | ON > ..ottt ettt 6-81
GPIO:LIMItS: IINPULILO:ENGDIE Y.ttt 6-81
GPIO:LIMits:lINput:LO:VALue < value in mA >................. 6-81
GPIO:LIMits:[INPpUt:LO:VALUE?....coiiieeiiiee e 6-82
GPIO:LIMits:MASSreading:AMU < value in AMU > .......... ... 6-82
GPIO:LIMItS:MASSIEadiNG:AMU?.....coi ittt e e e e ettt e e e e e e s et b be e e e e e e s aanbbreeeaeeeannnneneeeas 6-82
GPIO:LIMits:MASSreading:HI:ENable < O | 1| OFF | ON > ...ttt
GPIO:LIMits:MASSreading:HEENabIE? ...
GPIO:LIMits:MASSreading:HI:VALue < value in 10-16 A> .............cc..e
GPIO:LIMits:MASSreading:HEVALUE? .......uviieiieiiiiiiieee e .
GPIO:LIMits:MASSreading:HYSTEReSIS < value in 10-16 A >.....ccoiiiiiiiiiieiiiieeeie e
GPIO:LIMitS:MASSIreadiNg:HY STERESIS?......ciiiiiiiiiiiiiee ettt e ettt e e e e e s eibb b e e e e e e s s nnneneeeas 6-84
GPIO:LIMits:MASSreading:LO:ENable < O | 1 | OFF | ON > .ottt 6-84
GPIO:LIMits:MASSreading:LO:ENGDIE? .........oiiiiiiee e e e e 6-84
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GPIO:LIMits:MASSreading:LO:VALUE < value in 10-16 A > ...
GPIO:LIMits:MASSreading:LO:VALUE? ........coeveeeiiiiiiiiee e .
GPIO:LIMits:VINput:HEEENaDIe < O | 1 | OFF | ON > ..oeiiiiiiieiieiee ettt e e
GPIO:LIMItS:VINPULHEENGDIE? ...ttt 6-85
GPIO:LIMits:VINpuUt:HEVALUE < Value IN VOIS > ...ttt e e 6-85
GPIO:LIMIES:VINPULHEVALUB? ...ttt e ettt e e e e e sttt e e e e e e s et a e e e e e e s sasabsreeaeeesensnaraeeeas 6-85
GPIO:LIMits:VINput:HYSTEResis < value in Volts > ........ 6-85
GPIO:LIMits:VINPUt:HYSTERESIS?......cccovviieiiriieireeinne 6-86
GPIO:LIMits:VINput:LO:ENable <0 | 1| OFF | ON >........ ... 6-86
GPIO:LIMItS:VINPULLOIENGDIE? ...ttt e e e ettt e e e e e s e e e e e e e e e ennneeeeeas 6-86
GPIO:LIMits:VINput:LO:VALUE < Value iN VOIS >.......oiiiiiiiiiiiiiie ettt
GPIO:LIMits:VINpUt:LO:VALUE? ....oveiieeeeeiiiiiiieee e

GPIOIVALUE? ...oiiiiiiii e

RELAY:EVENT:ENable < integer, 0 | 1| OFF | ON > ....... .
RELAY:EVENT:ENable < INtEQEr VAIUE > .......coiiiiiiiiiii ettt e e e e e e e e
RELAY:EVENT:ENGADIE? S INEGET ... .o ittt ettt e e e e e ettt e e e e e e sttt eea e e e s annnnneeaaeean
RELAY:EVENTIENGDIE?. ...ttt esre e 6-88
RELAY:EVENT:CONDItION? S INTEOET > ..oiiiiiiiiiiiiee ettt ettt ettt e s e e e e
RELAT:EVENT:CONDItION? ...oooiviiiiiieiie e .
RELAY:FORCE <-1 | O | 1| EVENT | LOW | HIGN > ..ooiiiiiiiiiiie e e
RELAY:FORCE? ... ottt ettt sttt et n bt e e et e e et e e i bt e na bt e eab e e ea bt e eat e e s bt e nan e e nnbeenneean 6-89
RELAY:LIMits:COMM:IDLE < integer value iN SECONAS >......ccccuiiiiiiiiiiiiieee it 6-90
RELAY:LIMItSICOMMIIDLE?.....cc ittt et b e s et e e s e e e bt e e abn e e s nnes 6-90
RELAY:LIMits:lINput:HI:ENable <0 | 1| OFF | ON >........ 6-90
RELAY:LIMits:lINput:HEENabIe? ........ccovvveiiiiiiieee, 6-90
RELAY:LIMits:lINput:HI:VALue < value in mA > ............... .. 6-91
RELAY :LIMItSITINDULHEVALUB? ...ttt ettt e et abn e e s 6-91
RELAY:LIMits:IINpUt:HYSTERESIS < ValUE iIN MA >. ..ottt e e
RELAY:LIMits:INpUt:HYSTERESIS? .....ovvveiiiieiiiee e

RELAY:LIMits:lINput:LO:ENable <0 |1 | OFF | ON > ......
RELAY:LIMits:lINput:LO:ENable?........cccccevviiiiiieieiiee, .
RELAY:LIMits:IINpUt:LO:VALUE < VAlIUE IN MA S ...ttt naee e et e e e e e neeas
RELAY :LIMItS TINDULLO:IVALUB? ...ttt ettt ettt e s e et e e e e e 6-92
RELAY:LIMits:MASSreading:AMU < value in AMU > 6-93
RELAY:LIMits:MASSreading:AMU? .........ccoiiiiiiiiiiiie e 6-93
RELAY:LIMits:MASSreading:HI:ENable <0 |1 | OFF | ON >................. ...6-93
RELAY:LIMits:MASSreading:HIEENADIE? ... 6-93
RELAY:LIMits:MASSreading:HI:VALUE < value in 10-16 A > ..ot 6-94
RELAY:LIMitS:MASSIeading:HIXVALUEB? .....ooo ettt e e e e e eea e e e 6-94
RELAY:LIMits:MASSreading:HYSTEReSIS < value in 10-16 A > ......cooviiiiiieiiiie e
RELAY:LIMits:MASSreading:HYSTERESIS? ......cooiuiiiiiiieieiiiiiiieeee e .
RELAY:LIMits:MASSreading:LO:ENable <O | 1 | OFF | ON > .....oiiiiiiiiiiiiieeiie e
RELAY:LIMits:MASSreading:LO:ENGDIE? ... e e e e 6-95
RELAY:LIMits:MASSreading:LO:VALUE < Value iN 10-16 A > .....oooiiiiiiiiiiieeiie e 6-95
RELAY:LIMitS:MASSIeadiNg:LO:VALUE? ...cooi ittt ettt e e e e et e e e e e aebbeeeaaeeeean 6-95
RELAY:LIMits:VINput:HI:ENable <0 | 1| OFF | ON > ...... 6-96
RELAY:LIMits:VINput:HEENable?.........ccvveiiiiiiiieeee, 6-96
RELAY:LIMits:VINput:HI:VALue < value in Volts >........... ... 6-96
RELAY :LIMIES:VINDULHEVALUB?. ..ottt ettt e e e e ettt e e e e e s tb bt e e e e e e s annbbaeeaaeaaaan 6-96
RELAY:LIMits:VINpUt:HYSTERESIS < Value iN VOIS >....ccoiiiiiiiiiiiiiiic et
RELAY:LIMits:VINput:HYSTERESIS? ......cvvvvvieeeiiiiiieeene,

RELAY:LIMits:VINput:LO:ENable <0 |1 | OFF | ON >.....

RELAY:LIMits:VINput:LO:ENable? .........ccccccceeeviiiiiennnnnn. .
RELAY:LIMits:VINput:LO:VALUE < ValUE iN VOIS > ....ccoiiiiiiiiiiie ittt
RELAY :LIMItS:VINDULLO:VALUB? ..ottt ettt sttt e st e e et e e nnes 6-98
RELAY VALUB?. ...ttt etttk ettt et e ekt e o2 bt e e e bt e eH bt e ea bt e 1a b e e ea bt e e a b e e eab e e s a bt e nab e e nnbeeenneean 6-98
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Ethernet Commands

ETHErNet:CONFIG < O | 1| OFF | ON > ..ottt ettt ettt ettt e e sttt e e s e e s st e e e enbneeesnaes 6-99
ETHEIMEECONFIG? ...ttt ettt e bt e e h bt e eab e e s h bt e sab e e eh bt e eabeesabeesnbeesnbeesnneean 6-99
ETHernet:DHCP:ENable <0 |1 | OFF | ON > ..................

ETHernet:DHCP:ENaDIE?......ccvviiiieeeiieee e

ETHernet:DISCovery:ENable <0 |1 | OFF |ON > ...........

ETHErNet:DISCOVEIY:ENGDIE? ...ttt e e e e e ettt e e e e e e s e st e e e e e e e s e nnnneeeeeas 6-100
ETHernet:DNS < x.x.x.X > where X is in the range 0 10 255 ........cccoiiiiiiiiiiee e 6-100
ETHErNEUDNS? ... 6-101
ETHernet: GATEWAY < x.x.x.X > where x is in the range 0 to 255.......... 6-101
ETHErMNELGATEWAY .ottt 6-101
ETHernet:IP < x.x.x.X > where x is in the range 0 10 255 .........oiiiiiiiiii e 6-101
L I (=T 0 1 T=T ] PP PP 6-101
ETHernet:LOGIN <@ followed by string of 0 10 15 DYLES>.......ooiiiiiiie e 6-101
ETHEIMEELOGINT ...ttt s bbb e e s s b e e s st n e e s 6-102
ETHErNet:MACT? ...

ETHernet:NAME <@ followed by string 0f 0 0 15 DYLES>.....ccocuiiiiiiiiiieiiiie e
ETHEIMEUNAMET? ...ttt ettt ettt ettt ettt e e et et et e eeeeeeeeeeeeeeeeeees 6-102
ETHernet:NETMASK< x.x.x.Xx > where X is in the range 0 t0 255 .........cccocviiiiiie i 6-103
ETHEIMMEENETIMASK? oottt ettt h et b e e it e e e h bt e et e e s st e e eabe e s s be e snbeesnbeeenbeesnees 6-103

ETHEMEETIMEOUT 2.ttt e e e e et e e e e e e et e e e e e e e e s e rn e e e e e e saennneeeeas 6-104

Miscellaneous Commands

INSTIUMENEID? ...ttt e st e e ekt e e et e e s n e e e e ns e e e snn e e e nenes 6-104
HVENable: THRESHOLD < value in Volts | DEFault > ......
HVENable: THRESHOLD? .......cccoviiiieiiieicesiee e
HVENGDIEIVALUE?.....cci ettt ettt e ekt e e st e e e e e ek bt e e e st et e e ss b b e e e abne e e s nnnes 6-105

Interlock Commands

INTERLOCK:CEMprotect:ENable <O | 1 | OFF | ON >.....uiiiiiiiiii et 6-105
INTERLOCK:CEMPIOtECEENADIE? ...ttt 6-106
INTERLOCKICEMPIOECT?.....ciiiiiiiieiiiiie sttt ettt st e st e st e s e e s e e e s e e s nnes 6-106
INTERLOCK:PIRANI:ENable <0 |1 | OFF | ON > 6-106
INTERLOCK:PIRANEENGDIE? ...ttt 6-106
INTERLOCKIPIRANI? ...ttt ettt et e e s bt e e ekt e e e st e e n b e e e e as b e e e e anbn e e e s nneas 6-106
INTERLOCK:FILament:ENable < O | 1 | OFF | ON > ..ot se et srneesnneessae e s 6-107
INTERLOCK:FILAMENTENGDIE? ..ot 6-107
INTERLOCK:FILAMENT? ...t
INTERLOCK:FILAMENTSINGLE:ENable <0 | 1| OFF | ON>...............
INTERLOCK:FILAMENTSINGLE:ENabIe? .......ccvvveviieiiiiiiiieee e,

INTERLOCK:FILAMENTSINGLE? ... .ottt ettt e e s e e s 6-108
INTERLOCK:PROBEpresent:ENable <O | 1 | OFF | ON > ..ottt
INTERLOCK:PROBEpresent:ENable? .........cccooiiiieieenninns

INTERLOCK:PROBEPIESENt? .........ccvvvveeeeeiiiiiiieeeee s

INTERLOCK:TEMPerature:ENable <0 | 1| OFF | ON > ..

INTERLOCK:TEMPErature:ENGDIE?......ccoiiiiiiiiiii et 6-109
INTERLOCKITEMPEIAIUIE? ...ccoiiiiieittiee ittt ettt et e s e e e st e e s e e s nn e e e nnnn e e s nnees 6-109
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Instrument Setup Commands

SETUP:DEFAULT ...ttt
SETUPRILOAD ..ot
SETUPISAVE... ..ottt

AULOSAVE ... ittt e et e et e e et e e e et eeeaaas
Default SEtiNGS.......ccvvieieee e
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Legacy Remote Command List

Initialization Commands

|5 2 OO UPPPPTPPR 13-4
N[0T 1N B 1 SR 13-4
[onizer Control COMMANTS ......cooeiiiiiiiii e e e 13-6
DGparam, Param: 0 - 20,% ... ittt ettt ettt et ettt e et e e aeteeereeatrraaees 13-6
EEparam, Param: 25 - 105, ¥, 2. ittt ettt ittt ——————— ittt ——— i ——r—r———o 13-6
FLparam, param: 0.00 - 3.50, ¥, 2 .. oottt ettt et e e e re e e e eeerraeees 13-7
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Chapter 1
Getting Started

This chapter describes the process of unpacking, checking and installing the SRS RGA on a
vacuum system.

Please read and follow all installation instructions to ensure that the optimum performance of the
instrument is not compromised during the installation process.
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Unpacking

Before You Open the Box

1. To reduce the chance of contamination, do not remove the RGA probe from its
plastic shipping container until moments before it is ready to be installed in the
vacuum system.

2. Follow good high vacuum practice. Set aside a clean, dust free, work area next to the
vacuum port before installation begins.

3. Please read and follow all installation instructions in this chapter to insure that the
optimum performance of the instrument is not compromised during the installation
process.

4. Do not power up the instrument until it is instructed in the installation procedure.

5. Take a moment at this time to read the CDEM Handling and Care section of the RGA
Maintenance chapter if your unit includes the electron multiplier option (Option 01).

6. Do not operate the RGA if the pressure in the chamber is greater than 10 Torr.
Consult Appendix B for information on Pressure Reduction Systems.

7. Read the RGA General Operation chapter of this manual for an overview of the
instrument and its functions.

8. Inspect all components of the SRS RGA System upon unpacking. Report any
damage to Stanford Research Systems immediately. Compare the contents of the
shipping container with the Checklist below and report any discrepancies.

Checklist

Standard Equipment / Supplies

1.  One RGA Probe (in sealed plastic container)
2. One Electronics Control Unit box
3. One USB cable (6’ or 1.6 m long)

4.  Three Terminal Block Plugs for analog I/O (6 positions), RTD (8 pos.) and relay
(3pos.) connections

5. Operation Manual

Optional Equipment

1. Option 01 Electron multiplier. Preinstalled at the factory.

2. Option 02 Built-in power module for AC line operation (Option 02).
Preinstalled at the factory. Includes one power cord.
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3.

Option 03

Accessories

1.

2.

6.

7.

O100RF

O100RI

O100EM

O100HJRW

O100MAX

0120C

MRGAX20

Related Equipment

Electron Multiplier lon Counting Output (must also have
Option 01.)

Replacement Thoriated Iridium Filament Kit.

Replacement lonizer Kit (includes filament).

Replacement Electron Multiplier.

200 °C Heater Jacket for RGA (cannot be used with O100MAX)
Maximum Insertion nipple with 4.5 ConFlat (CF) Flange
(Factory installed; standard nipple not supplied when this option
is ordered).

Cable (10 ft.) for user-supplied +24 VDC power supply, locking

Replacement manual for RGA120 family

1. UGA100/200/300 Universal Gas Analyzer system.

2. PPR100/200/300 Vacuum Process Monitoring system.

3. CIS100/200/300 Closed lon Source quadrupole mass spectrometer.

4. 1GC100 lonization Gauge Controller
Installation

Introduction
The standard SRS RGA System consists of:

1. RGA Probe

2. Electronics Control Unit (ECU)

3. RGA Software (RGASoft)

Specific hardware requirements and installation instructions are needed for each one of
the components.

Important
e Follow the installation steps in the strict order in which they are presented in this
chapter.
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Do not power up the instrument until it is indicated in the procedure.

Read the hardware requirements before installation begins. Do not start the
installation procedure until all requirements are met.

Please read and follow all installation instructions to ensure that the optimum
performance of the instrument is not compromised during the installation process.

Probe Installation

The RGA probe can be mounted on any standard 2 3/4" CF port of the vacuum chamber
that provides enough clearance for the ionizer’s outer cage.

A stainless steel tube (RGA Cover Nipple) covers the probe assembly with the exception
of the ionizer. The ionizer is the only component of the probe that protrudes into the
vacuum system (see Figure 1-1.)

Warnings:

*

Do not remove the probe from its plastic shipping cover until it is ready to be
installed in the vacuum system.

Do not remove the RGA Cover Nipple from the probe. The stainless steel tube is an
integral part of the quadrupole assembly and the RGA will not operate properly
without it. Please consult the Hardware Modifications section in the RGA
Quadrupole Probe chapter of this manual for information on operating the RGA
probe without its factory provided cover nipple.

Do not disassemble or modify the quadrupole probe in any way without reading first
the Hardware Modifications section of the RGA Quadrupole Probe chapter.

Use proper vacuum procedures while installing the probe:

Set aside a clean, dust free, work area next to the vacuum port.
Wear gloves!
Do not talk or breathe directly into the probe’s ionizer.
Use clean tools during the installation procedure!

Protect the integrity of the Vacuum seals:
Do not use nonmetal seals.
Avoid scratching the metal seals.

Verify that the vacuum port is electrically grounded before attempting the installation
of the RGA Probe on the vacuum system.

Hardware Requirements

1.

Do not operate the SRS RGA in corrosive gas environments. If the presence of
corrosive gases in the vacuum environment is known or suspected, consult SRS
before installing the probe in the vacuum chamber.

Do not operate the SRS RGA in the presence of strong magnetic fields. Magnetic
fields, such as those caused by superconducting magnets or cold cathode total
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Installation

pressure gauges (i.e., Penning type), can affect the ion trajectories through the
guadrupole filter resulting in very unreliable measurements. If the presence of
magnetic fields in the vacuum environment is known or suspected, consult SRS
before mounting the probe on the vacuum chamber.

The maximum operating pressure of the RGA is 10 Torr. A pressure reduction
system is required if the operating pressure of the vacuum chamber is greater than
10 Torr. Consult Appendix B of this manual for details.

The probe can be mounted directly onto any standard 2 3/4" CF port of a vacuum
chamber provided the following placement requirements are met:

e The vacuum port must have at least 1.375” internal diameter and 2.5” depth to
provide enough clearance for the ionizer (The insertion volume is comparable to
that required by a nude Bayard-Albert ion gauge).

e Any mounting orientation of the probe may be used.

e The ionizer is the only component of the probe that protrudes into the vacuum
system and it must be located close to the point where partial pressures are to be
measured. If placed near a pump, the pressure in the ionizer may be considerably
lower than in the rest of the system. If placed near a gas inlet or source of
contamination, the pressure in the gauge may be much higher. Long tubulation or
other constrictions between the ionizer and the rest of the vacuum system can
cause large errors in the partial pressure readings.

e The probe must be distanced or shielded from all other instruments that could
potentially affect the RGA readings. For example, cross-talk with hot-cathode ion
gauges is possible but easily eliminated by proper shielding or changes in the
relative placement of the gauges.

e The probe must be protected from evaporation sources that could coat the
ionizer.

e Enough clearance must be allowed for the ECU box that attaches directly to the
probe’s feedthru flange.

e Choose the orientation of the ECU box prior to the installation of the probe. Six
different orientations can be obtained rotating the probe about its axis and lining
up the bolt holes of the 2 3/4” CF flanges.

Note: The ECU will operate in any orientation, but limited space, free access to the
rear panel connectors and visual access to the LED’s might limit the orientation
options in your vacuum system.

The following equipment must be available before the installation procedure starts:

e One standard OFHC copper gasket for 2 3/4” CF flange. New and clean!

e Six high-strength stainless steel bolts for 2 3/4” CF flanges: Use six 1/4-28 x 1
3/8” bolts, with one nut and two washers per screw, for flanges with through
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holes; or six 1/4-28 x 7/8” bolts, with one washer per screw, to attach the probe’s
flange to a tapped vacuum port. Both standard hex and 12-point bolt heads are
compatible with the RGA’s flange.

Use silver-plated bolts instead of messy anti-seize lubricants whenever available.

e Wrenches: One or two wrenches will be needed to tighten the six bolts and
compress the copper gasket. Use a 7/16” 12-point wrench for standard hex head
bolts and nuts, or a 1/4” 12-point wrench for 12-point bolt heads.

e Optional adapter flanges: Install an adapter flange in the vacuum system if no 2
3/4” CF ports are available. Zero-Length Adapter flanges, with a 2 3/4” CF
flange on one side and a bigger size flange on the other, are an economical
alternative to reducing nipples.

Procedure

1. Determine the placement of the probe in the vacuum chamber following the
instructions listed in step 3 of the Hardware Requirements section.

2. Remove the probe from its plastic container.
Avoid contamination following good high vacuum practices. Do not touch with bare
fingers any part of the probe that will be exposed to the vacuum. Do not talk directly
at an open vacuum port.

3. Hold the probe in a secured upright position and do a thorough visual inspection of
the part. Check for loose, damaged or misaligned components. Minor misalignments
of the ionizer’s outer cage (i.e., repeller) can occur during shipping and must be
corrected before the ionizer is inserted into the vacuum chamber. Check the integrity
of the metal seals in all CF flanges.

Important: Abort the installation procedure and contact SRS immediately if the
probe appears damaged in any way.

4. Position the copper gasket and insert the probe’s ionizer into the vacuum system.
Rotate the probe about its axis and align the holes on the CF flanges, as necessary to
achieve the desired orientation for the ECU box. Avoid scratching the vacuum seals
and do not use non-metal gaskets.

Important: Avoid touching the internal walls of the vacuum port with the repeller
cage during the installation procedure, since that could lead to serious misalignment
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of the ionizer. Get an extra hand from a co-worker if necessary.

RGA Mounting Flange

Vacuum Chamber

5.

RGA Cover Nipple

Vacuum Port L |onizer <

I Probe Assembly

Figure 1-1 RGA Probe Installation

Insert the 6 bolts through the holes in the flanges and finger-tighten them. Tighten the
bolts according to the standard tightening procedure for 2 3/4” CF flanges. Use 1/8
turns in crisscross order: 1,4, 2,5, 3, 6,4, 1, 5, 2, 6, 3, 1.... until the flanges are in
contact, and finish the tightening process with an extra 1/16 of a turn on each bolt.

Start pumping down the vacuum chamber as soon as the flange connection is sealed.
The RGA probe is pre-cleaned and leak tested at the factory and should only
contribute to the base pressure of the vacuum system through regular outgassing (i.e.,
mostly water) from its walls. If available, use the vacuum system’s total pressure
gauge to leak test the probe’s connection and monitor the chamber’s pressure as a
function of time.

Important:

Redo the metal seal if a leak in the vacuum system is detected after the probe is
installed. Inspect the integrity of the seals before positioning the new copper gasket.

Contact SRS immediately if a leak in the feedthru flange is detected or even
suspected.

Consult the Probe Bakeout instructions of the RGA Maintenance chapter if a bakeout
is needed prior to exposing the probe to the vacuum system’s main chamber.

An overnight pump-down is needed in instruments with the electron multiplier option
(Option 01). Consult the CDEM Pre-conditioning section of the RGA Maintenance
chapter before applying any voltage across the CDEM.

If available, use an ohmmeter to check for shorts between the feedthru flange
connectors and the walls of the vacuum chamber. Vacuum ports with severely
misaligned CF Flanges and/or large internal weld joints are not uncommon, and can
result in a short between the ionizer and the inside walls of the vacuum port tube. If a
short is detected, use the Feedthru Flange Connector Schematic in the RGA Probe
Assembly chapter to identify the probe electrode that is causing the short. If the short
is in the repeller, remove the probe from the vacuum system and correct the
alignment of the outer repeller cage before reattaching the flanges (Correct alignment
is best assured when the two small holes on the side of the repeller cage line up with
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the filament screws). If the vacuum port is severely misaligned, and the short cannot
be eliminated, consider replacing the vacuum port, using a different port or operating
the RGA without the repeller (See Hardware Modifications in the RGA Quadrupole

Probe chapter for instructions on operating without a repeller cage.)

Electronics Control Unit Installation

The Electronics Control Unit (ECU) attaches directly to the probe’s feedthru-flange. Its
correct alignment to the probe is very important during installation. Carefully follow the
instructions below to insure proper alignment.

Warning:

Failure to follow the installation instructions below could result in damage to the
ceramic feedthru connectors of the probe’s flange, and would require sending the
entire unit back to Stanford Research Systems for a complete flange replacement.

Hardware Requirements

1. External Power source:
Standard ECU boxes require an external 24 VV DC power supply @ 3 Amps (i.e. 72
Watt) to power its electronics.
Units with the optional built-in power module (Option 02) plug directly into a wall
AC outlet and require no extra power sources.

2. Power cables:
External 24V power supplies must have a cable with a standard barrel connector (5.5
mm OD, 2.1 mm ID) on the free end.

RGA units with the optional built-in power module (Option 02) are connected
directly to a wall outlet using the three wire power cord provided by SRS.

3. Communication cable:
The ECU can be connected to a computer using either an Ethernet, USB, or RS232
cable. Select one of the communication type and make sure the computer has the
communication interface available.

4. The probe must be installed in the vacuum chamber before the ECU box is mounted
on its flange.
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Procedure

1. Begin by inspecting the front panel of the ECU box. Use the following diagram as a
reference during installation.

Probe alignment holes \

Clearance 4
holes
(6 places)

Internal connectors

Locking screws
(2 places)

Figure 1-2 ECU Front Panel

3. Next, inspect the probe’s feedthru flange:
Eight ceramic feedthru connectors on a 1” diameter circle surround a center tube
terminated by a coaxial connector. Two alignment rods (1/4” diameter) insure the
correct alignment of the ECU box to the probe during installation and two threaded
holes (1/4-28) line up with the locking screws of the ECU box.

4. Push the locking screws of the ECU box as far as they will go into the box.

5. Orient the ECU so that the two small alignment holes (1/4” diameter) on its front
panel and the alignment rods of the flange line up. Note that there is only one correct
way to do this!

6. Slide the ECU into the probe using the alignment rods as a guide, and until physical
contact is made between the probe and the ECU’s internal connectors.

7. Using gentle pressure on the back of the box, push the probe’s conductors into the
ECU’s connectors until the front surface of the ECU rests flat against the back of the
feedthru flange.

Warning:
The alignment of the probe/ECU connections is checked at the factory, for each
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10.

individual RGA system and only slight resistance should be experienced during this
step. If significant resistance is noted while sliding the ECU onto the probe do not
exert excessive force since that might damage the ceramic-to-metal seals of the
feedthrus. Instead, rock the ECU box up and down, while gently pushing on its back,
until the connectors line up. Once the connectors are all lined up, push the box in the
rest of the way.

Once the ECU is in place, use the knobs on the back panel of the ECU box, to turn
the locking screws and lock the assembly in place. Do not over tighten! (Hand
tighten.)

ECU Power Connection:

Important: Do not power up the RGA at this time.

Standard ECU boxes must be connected to the external 24 VDC power supply. Insert
the barrel connector into the ECU connector marked +24 VDC @ 2.5A on the back
panel of the ECU box.

Units with the optional built-in power module (Option 02) plug directly into an AC
outlet and require no extra power sources: Use the power entry module on the back
panel of the ECU box to power the RGA directly from an AC outlet. Use the three-
wire power cord provided by SRS to connect the RGA directly to a properly
grounded wall outlet.

ECU communication cable connection:
Connect a communication (RS232, USB, or Ethernet) cable to connect the computer
to the RGA.

With a USB cable (type A to type B), insert the type B connector into the ECU
connector marked as “USB”, and the type A connector to a USB port on the
computer or a USB hub.

With an Ethernet cable (Cat 5 or 6), insert a connector into the ECU connector
marked as “LAN”, and insert the other connector into an Ethernet switch. The
computer should be connected to the same network with the switch.

With an RS232 cable (straight-through, DB9 Female to DB9 male), insert the 9 pin,
type D male connector into the ECU connector marked as “RS232
DCE/28.8k/N/8/1”, and the 9 pin female connector to an RS232 port on the
computer. For a computer without a RS232 port, you may have to use a RS232-to-
USB adapter.

RGA Software Installation

Minimum System Requirements (Single RGA Operation)

Computer running with Microsoft Windows 10 (64-bit version) or later
USB, Ethernet, or RS232 port available on the computer.

USB (type A to type B), Ethernet (Cat 5 or 6), or RS-232 (Straight through, DB-9 to
DB-9) cable.
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e 200 Mbytes of free hard disk space (more disk space is required for scan data).

¢ RGASOoft software downloaded from the SRS website at www.thinkSRS.com.

Procedure

1. Turn on the computer and start Microsoft Windows.
2. Run the RGASoft installer program (file RGASoft-<version>-x64.exe).

3. The software is automatically and completely installed by the RGASoft Setup
Wizard. Read and follow all instructions.

4. An “SRS RGASoft” program group with the “RGASoft” icon is automatically
created at the end of the installation process. The “Documentation” link provides the
online help on a web browser.

5. Take a moment at this time to read the RGA Software Chapter of this manual.

Turning on the RGA

1. Power up the RGA:
Standard RGA units are powered up by turning on the external 24V power supply.
Units with a built in power module (Option 02) have a power switch on the back
panel of the ECU box.

2. When power is applied to the ECU, a firmware routine automatically checks the
external voltage level and turns on the green Power LED if the voltage is within the
acceptable range of 24 +/-2 VV DC. The SRS RGA is now ready to communicate with
the computer.

Running the SRS RGA System

This section describes how to launch the RGASoft program and start acquiring data from
the RGA. An analog scan from 1 to 65 amu is executed as an example.

Important: The following steps assume that all the installation instructions described in
the previous section were completed. The RGA should be mounted on the vacuum
system, powered up and connected to the RS232 or USB port of the IBM compatible PC
computer. RGASoft program should be installed in the computer and ready to run.

Warning:
Do not operate the RGA if the pressure in the chamber is greater than 10 Torr.

1. Turn on the computer and start MS Windows.

2. Start the RGASoft program:
To start the RGASoft simply double-click on the RGASoft icon in the "SRS
RGASoft" program group or the desktop icon created by the RGASoft installation
program.
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3. Connect to the RGA:

Upon launching, the RGASoft will show the Connections dialog box. Serial
connections are automatically detected and displayed on the table.
Select the COM port to which the RGA is connected, and where the status
shows Available.

Press the Connect button.

The connection is made when the status column shows Connected and the control
panel is enabled. The program will attempt to read the RGA status when the
connection is established.

4. Close the Connections dialog box when the RGA status query is completed.

5. Turn on the filament:

Select menu Probe > Turn On Filament.

The ionizer is biased with default voltage values and the filament is turned on to
the default emission current. It takes a few seconds for the filament wire to warm
up during which a small informative dialog box is active. The Filament status
icon on the side panel stays lit (in green color) as long as the filament is emitting
electrons.

The filament emission can be toggled on/off whenever the system is idle by
selecting menu Probe > Turn On/Off Filament. The ionizer settings can be
changed selecting lonizer Settings from the Probe menu. A green status LED on
the back panel of the ECU box indicates the emission status of the filament at all
times and it provides the fastest way to verify if the filament is emitting
electrons.

6. Perform an analog scan under the current scan conditions:
Analog mode is the spectrum analysis mode common to all Residual Gas Analyzers.
Its scan data is presented on an analog scan plot which consists of an X-Axis
representing the mass range and a Y-Axis representing the measured ion current
amplitudes of each mass increment. Note that the ion current amplitudes are often
converted and showed in a pressure unit. The RGASoft program starts with a single-
step scan sequence by default where the step is an Analog scan mode. The scan range
defaults to 1 to 65 amu.

Select Run from the Scan menu, or simply click on the sidebar’s » Run button,
to trigger an analog scan.

After a short delay, the analog scan data starts to be displayed on the analog plot.

Please refer to the RGA Software chapter of this manual, and the RGASoft On-Line Help
files, provided with the program disks, for detailed information on all the features,
procedures, and commands available in the RGASoft program. Consult the RGA General
Operation chapter of this manual for a general overview of the SRS RGA and its basic
operating modes.
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Remote Interface Configuration

With a computer running Windows 10 or greater, the RGA can be controlled through the
RGASoft Windows PC Application. However, the RGA can also be controlled directly
by remote commands over the RS-232, USB, or Ethernet interfaces on the back panel.

The RGA communications interfaces can be configured most easily using RGASoft.
However, some customer networks may require more advanced configuration.

RS-232

The RS232 RGA interface does not require any configuration. As stated earlier, an
RS232 connection can be made with a standard RS232 straight-through DB9 female to
DB9 male cable. The RGA will connect via RS232 to any host computer terminal
program at 28.8kbaud, 8 bits, 1 stop bit, and no parity. If the host computer does not have
a corresponding RS232 port, an RS232 to USB host adapter may be used.

USB

A USB type B connector is located on the back panel of the RGA. The interface is USB
2.0, Full Speed compatible. USB 2.0 is specified for a maximum cable length of 5 meters.

The RGA comes equipped with an FTDI FT230X USB to UART bridge chip. This may
require installation of driver software to allow the USB interface on the RGA to
communicate with the host computer.

When first connecting an RGA to a host computer running Microsoft Windows OS, you
may be prompted with a “New Hardware Found” message and an invitation to search for
the USB Driver. Depending on the version and configuration, Windows may either
automatically install the drivers or prompt you to search for them. Allow it to install the
drivers if you plan to configure or control the RGA over USB using this computer.

If there are difficulties installing the driver, you may need to manually install the driver.
In this case, refer to Appendix F for more information on how to download and install the
USB driver.

Ethernet

The RGA can be controlled over a TCP/IP connection through the Ethernet port. The
Ethernet port supports communication over 10/100 Base-T Ethernet through an RJ45
connection.

If you want to configure the Ethernet connection within the RGASoft application, refer to
Ethernet Setup Tools section in the Chapter 5.

Connect a standard Ethernet cable (Cat 5 or higher) between the RJ45 connector on the
RGA and your network. When the RGA is powered on, the activity LED should be on or
flashing green. If the LED is not responding in this way, check your Ethernet cable
connection to your network.
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IP Address Configuration
To use the RGA Ethernet interface, the RGA must first be assigned an IP Address.

DHCP Assignment

From the factory, the instrument is configured to accept an IP address from a DHCP
server if one is available. After an Ethernet cable is connected between the RGA and a
network with a DHCP server, the RGA will request an IP address. If successful, the RGA
will automatically accept an IP address assigned by a DHCP server on the connected
network.

To determine the IP address that has been assigned to the RGA, you can use the RGASoft
PC application. The application can search for all RGAs on your local network and will
offer the IP address of all RGAs that are discovered.

Optionally, you may connect to the RGA via RS232 or USB to query the instrument
directly for its IP address. This is done with the following command:

ETHERNET:IP?
The command should return an IP address in standard 1Pv4 format of XXX.XXX.XXX.XXX.
For example:
172.25.70.93
If DHCP has failed to provide an IP address, the RGA will return:
0.0.0.0
In that case, follow the guidelines below to assign an IP address manually.

Manual IP Address Assignment

If there is no DHCP server available, or if you wish to assign an IP address manually, this
must be done over an RS232 or a USB connection.

After connecting to the RGA via USB or RS232, first disable DHCP on the RGA.
ETHERNET : DHCP: ENABLE 0

Or:
ETHERNET : DHCP:ENABLE OFF

Then set the IP address with the following command:
ETHERNET: TP xXX.XXX.XXX.XXX

Where xxx . xxx .xxx .xxx IS a standard IPv4 format address, 4 fields of integers
between 0 and 255. Each field should be separated by a °.” character.
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IMPORTANT: When assigning a specific address to the RGA, make sure that there are
no other devices already using that IP address. If another device on the local network is
assigned the same address, it will cause an IP conflict. Ethernet traffic meant for the RGA
at the assigned IP may not operate as expected.

Optionally, you can set the Ethernet DNS, Gateway, and Netmask with the following
commands:

ETHERNET :DNS XXX .XXX.XXX.XXX

ETHERNET : GATEWAY XXX .XXX.XXX.XXX

ETHERNET :NETMASK XXX .XXX.XXX.XXX
NOTE: As the RGA acts as a server, it will only respond when a TCP/IP telnet
connection is opened directly from a host computer. The DNS, Gateway, and Netmask
fields are not used for Ethernet access.

The RGA will save the settings to non-volatile memory during the next Autosave cycle.
However, the changes may be immediately saved with the following command:

SETUP: SAVE

Operation

Once the RGA IP address has been assigned, a telnet connection can be opened to the
RGA to the IP address at port 818.

When the connection is established, there will be a prompt for a login name and a
password to log into the RGA.

The default login name and password set at the factory is:

Name: admin
Password: admin

The login name and password can be changed with the following commands:

ETHERNET :LOGIN (@name
ETHERNET : PASSWORD @password

Both @name and @password can be a string from 0 to 15 bytes long, starting with a
‘@’ character.

The RGA will save the settings to non-volatile memory during the next Autosave cycle.
However, the changes may be immediately saved with the following command:

SETUP: SAVE
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The telnet connection has an automatic timeout feature in case the host computer does not
close the telnet connection cleanly. This is important as only one Ethernet connection can
be made to the RGA. If the host computer drops the telnet connection, the RGA will be
unreachable for the time of the timeout.

If there is no activity from the host computer for the duration of the timeout timer, the
RGA will close the telnet connection.

By default, the timeout is 30 seconds. This can be changed by the following command:
ETHERNET: TIMEOUT x

where X is the timeout value in seconds. The value must be between 30 seconds and
86400 seconds.

In cases where the Ethernet connection is locked out, the RGA may either be power
cycled, or the following command can be sent via USB or RS232 interface:

ETHERNET : TELNET : CLOSE

This command will reset the telnet connection and make the RGA open for a new telnet
connection.
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Chapter 2

RGA General Operation

This chapter describes the basic properties of the Stanford Research Systems Residual Gas
Analyzer (SRS RGA).
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What is an RGA?

Complete characterization of a vacuum environment requires the detection of all the
component gases present, as well as measurement of the total pressure. The instruments
used for this purpose are called Residual Gas Analyzers or Partial Pressure Analyzers.

A Residual Gas Analyzer (RGA) is a mass spectrometer of small physical dimensions
that can be connected directly to a vacuum system and whose function is to analyze the
gases inside the vacuum chamber.

The principle of operation is the same for all RGA instruments: A small fraction of the
gas molecules are ionized (positive ions), and the resulting ions are separated, detected
and measured according to their molecular masses.

RGA'’s are widely used to quickly identify the different molecules present in a residual
gas environment and, when properly calibrated, can be used to determine the
concentrations or absolute partial pressures of the components of a gas mixture.
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The SRS RGA

The SRS RGA is a mass spectrometer consisting of a quadrupole probe, and an
Electronics Control Unit (ECU) which mounts directly on the probe’s flange, and
contains all the electronics necessary to operate the instrument.

lﬂ—' Electronic Control Unit (ECU) —Vl ‘1‘ Quadrupole Probe—b‘

Figure 2-1 Quadrupole Head Components

The probe is a specially engineered form of quadrupole mass spectrometer sensor that
mounts directly onto any standard 2 3/4" CF port of a vacuum chamber. It is described in
detail in the RGA Probe chapter of this manual. The total probe equipment consists of
three parts: the ionizer (electron impact), the quadrupole mass filter and the ion
detector. All of these parts reside in the vacuum space where the gas analysis
measurements are made. The detector measures the ion currents directly (Faraday Cup)
or, using an optional electron multiplier detector (Option 01), measures an ion signal
proportional to the ion current. A stainless-steel tube (CF Full nipple) covers the probe
assembly except for the ionizer.

The ECU is a densely packed box of electronics (3” x 4” x 9”) that connects directly to
the probe’s feedthru-flange and also to a host computer. It is described in detail in the
“RGA Electronics Control Unit” chapter of this manual. It includes several regulated
power supplies, a microcontroller, control firmware, and multiple communications ports
for Ethernet, USB, and RS232, along with auxiliary 1/0s, and relay closures. It is
powered by either an external 24 VDC (@2.5 Amps) power supply or an optional built-in
power module (Option 02) which plugs directly into an AC outlet. A unique,
temperature-compensated picoammeter built into its box measures the ion currents
collected by the Faraday cup (FC), or electron multiplier (CDEM). The electrometer is
completely auto-ranging and measures both positive and negative currents with the same
accuracy and resolution. Its operating range covers current magnitudes between 10 and
10 A, providing six orders of magnitude dynamic range during single mass
measurements and scans, and detectable partial pressures better than 102 Torr during
electron multiplier detection.

The instrument is completed with the RGA software package that runs on Windows
computers. The intuitive graphical user interface allows measurements to be made and
displayed in a variety of modes. The program is interactive and measurements are set up
quickly and easily with the click of a mouse. The software can run in multiple instances
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to support multiple RGA units. Please refer to the RGA Software chapter of this manual,
and the RGASoft On-Line Help files for detailed information on the features, procedures,
and commands available in the RGA software program.

Intelligent firmware, built into the RGA Head, completely controls the operation of the
instrument, and provides four basic modes of operation of the mass spectrometer:

e Analog scanning

e Histogram scanning

e  Single mass measurement

e Total pressure measurement.

RGASoft program provides fast access to all the RGA functions without the need for any
computer programming; however, the instrument can also be programmed directly using
the RGA Command Set supported by its communication interfaces. Consult the RGA
Programming chapter of this manual for information on the programming options and a
complete listing of the RGA Command Set.

The SRS RGA is available in three different models with mass ranges of 1 to 120
(RGA120), 1 to 220 amu (RGA 220), and 1 to 320 amu (RGA320). All models operate in
the “Constant Resolution” or “Constant Am” mode, with AMaq, preset to one amu at the
factory.

The operating pressure is UHV to 10 Torr for all models.

A complete product specifications listing is included in the introductory sections of this
manual.
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Basic Operating Modes of the SRS RGA

The SRS RGA is a mass spectrometer that analyzes residual gases by ionizing some of
the gas molecules (positive ions), separating the resulting ions according to their
respective masses and measuring the ion currents at each mass. Partial pressure
measurements are determined with the help of previously calculated sensitivity (i.e.
calibration) factors by reference to the abundance of the individual mass numbers
attributed to each gas type.

During analysis, positive ions are formed within the ionizer and directed towards the
spectrometer’s quadrupole mass-filter. The mass filter determines which ions reach the
detector at any given time. It is operated by a combination of RF and DC voltages and the
filtering action is based on the mass-to-charge dependency of the ion trajectories on the
RF and DC fields. The magnitude and frequency of the RF determine the mass-to-charge
ratio of the ions that can pass through the filter without striking the rods (i.e. with stable
oscillations). The RF/DC ratio determines the filter selectivity. lons that successfully pass
through the filter are focused towards the detector and the resulting analog current is
measured by the very sensitive electrometer.

A brief note on Mass Units in Mass Spectrometry:

Since molecules are so small, it is convenient to define a special type of mass units to
express the masses of individual ions. The atomic mass unit, amu, defined as 1/12 of the
mass of a single carbon atom, isotope 12 (i.e. 12C), is the unit of molecular mass most
commonly used in mass spectrometry (1 amu = 1.660 540 x 10"?" kg). To a very accurate
approximation, the mass of a molecule in atomic mass units (amu) is equal to its mass
number M, defined as the sum of the number of protons and neutrons in the molecule.

Mass spectrometers do not actually measure the molecular mass directly, but rather
the mass-to-charge ratio of the ions. The mass-to-charge ratio, M/Q, is defined as the
ratio of the mass number M of the ion to its charge Q, measured in units of the electron
charge e". For example: doubly charged ions of argon isotope 36 (**Ar?*) and singly
charged ions of water, H,'*0O*, have M/Q = 18, and cannot be differentiated from each
other with most mass spectrometers.

For singly charged ions, the mass to charge ratio is numerically equal to the mass of the
ion in atomic mass units (amu).

RGA users often use the term “mass of an ion” when they really mean the mass-to-
charge ratio. This convenient way of speaking is strictly valid for singly charged ions
only.

The SRS RGA as a Mass spectrometer

The SRS RGA can perform both analog and histogram scans over its entire mass range.
Residual gas analysis relies on the interpretation of the spectral data generated by these
two modes to completely characterize, both qualitatively and quantitatively, a vacuum
environment.
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RGASoft program uses the two modes to generate the data for the Analog and Histogram
Scan Modes.

Analog scanning is the most basic operation of the RGA as a quadrupole mass
spectrometer. During analog scanning the quadrupole mass spectrometer is stepped at
fixed mass increments through a pre-specified mass-range. The ion current is measured
after each mass-increment step and transmitted to the host computer over RS232, USB or
Ethernet. Analog scanning allows the detection of fractional masses and provides the
only direct view of the peak shapes and resolution of the instrument.

A Histogram (Bar Mode) Scan consists of a succession of individual peak-height
measurements over a pre-specified mass range. A single value is used to represent the
peak heights at each integer mass within the range. The peak height measurements are
made with the Peak-locking scanning procedure described in the next section. Histogram
scanning is one of the most commonly used modes of operation for the RGA. Its two
main advantages are a faster scan rate than analog scans, and a reduced amount of data
being exchanged during the scan.

The SRS RGA as a Single Gas monitor

The SRS RGA can measure individual peak heights at any integer mass within its mass
range.

This mode of operation is used to generate data for leak testing measurements, and to
track changes in the concentrations of several different components of a mixture as a
function of time. The outputs provided by a set of single mass measurements are often
used in process control programs to control alarms, analog and digital outputs, and relays.

RGASoft program uses this mode to generate its data for the Pressure vs time, and Leak
Detection modes.

Peak Locking procedure: During a Single Mass Measurement the RGA performs a
Miniscan around the mass requested, and the maximum current value measured is sent
out over RS232, USB, or Ethernet. The scanning procedure, referred to as Peak-
Locking, is designed to measure peak currents for individual masses in a mass spectrum
without being affected by drifts in the mass-axis calibration. The Miniscan covers a 0.6
amu range centered at the mass requested, and selects the maximum current from 7
individual measurements performed at 0.1 amu mass increments.

The SRS RGA as a Total Pressure Gauge

The SRS RGA can measure total pressures using the Faraday Cup detector.

The RGA might be thought of as a Total Pressure lonization gauge with a mass analyzer
interposed between the ionizer and the detector. Thus, by disabling the mass-filtering
action of the analyzer section, it is possible to detect the total ion current from the ionizer
and perform total pressure measurements. A total pressure sensitivity factor, stored in the
non-volatile memory of the RGA, is used by RGASoft program to convert total current
measurements into total pressures.
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Important: The RGA’s sensitivity factor for total pressure measurements is highly mass
dependent. Some residual mass discrimination takes place in the filter that results in the
mass dependence of the RGA readings being different from that of the Bayard-Alpert
gauges. Expect to see deviations between the two gauges as the composition of the
residual gas changes.

Do not rely on the RGA total pressure measurement for critical applications where
accurate total pressure measurements are required. A high precision 1GC100
controller connected to a calibrated Bayard-Alpert ionization gauge is
recommended instead.

Residual Gas Analysis Basics

The SRS RGA can perform both qualitative and quantitative analysis of the gases in a
vacuum system. Obtaining spectra with the SRS RGA is very simple. Interpreting the
spectra, that is, understanding what the spectra is trying to tell you about your vacuum
system requires some work.

The following sections will introduce some basic concepts of Spectral Analysis
emphasizing the main aspects of Residual Gas Analysis. Consult Appendix A of this
manual for specific examples on the application of the SRS RGA to vacuum diagnosis

For additional information on the subject of Residual Gas Analysis refer to:

1. J. Drinkwine and D. Lichtman, Partial Pressure Analyzers and Analysis, AVS
Monograph Series published by the Education Committee of the American Vacuum
Society

2. Basford et. al., J. Vac. Sci. Technol. A 11(3) (1993) A22-40 “Recommended Practice for
the Calibration of Mass Spectrometers for Partial Pressure Analysis. Update to AVS
Standard 2.3”.

For information on multiple linear regression analysis consult:

1. William H. Press, et. al., 1992, Numerical Recipes in C, The Art of Scientific Computing,
Second Edition, Cambridge Univ. Press, section 15.4, page 671.

2. Bevington, P.R., 1969, Data Reduction and Error Analysis for the Physical Sciences,
New York, McGraw-Hill, Chapters 8-9.

How Mass Spectra are Interpreted

A mass spectrum, taken in a real system, will almost always contain signals from a
mixture of various gases. Careful and complete interpretation of the spectrum (i.e. a
complete spectral analysis) should reveal the identity, as well as the concentrations, of the
various components which have produced the spectrum.

The first step in the spectral analysis process is to correctly identify the mass-to-charge
ratio of all the peaks in the mass spectrum. A well calibrated mass scale is essential to
this task. See the RGA Tuning Chapter for a detailed description of the mass scale
calibration procedure.
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Once all the peaks have been labeled, the next step is to identify the residual gases that
have produced the spectrum. A knowledge of the recent history of your system may
provide very valuable clues as to the possible gases that may be residuals in the vacuum
chamber. A familiarity with the standard spectra of commonly expected gases will
generally help to determine the major and minor components in the system. Any peak in
the spectrum may consist of contributions from molecular ions and/or fragment ions, or
multiply ionized species. The qualitative spectral analysis is completed when all the
peaks in the spectrum have been “uniquely assigned” to the components of a gas
mixture, in complete agreement with the known fragmentation patterns of the
components.

In cases where only the major components are of interest, some of the minor peaks of the
spectrum will remain unassigned. If only a few species are being monitored, only the
peaks corresponding to the substances of interest need to be assigned and monitored.

Notes on Fragmentation Patterns: The electron impact type of ionizer used in modern
RGA'’s almost always causes more than one kind of ion to be produced from a single type
of gas molecule. Multiple ionization, molecular fragmentation and changes in the isotopic
composition of the molecule are responsible for the effect. All ions formed contribute to
the mass spectrum of the molecule and define its fragmentation pattern. The
identification and interpretation of mass spectra must begin with a knowledge and
understanding of the standard fragment patterns of atoms and molecules that may exist in
the system. The standard fragment patterns of most molecules commonly encountered in
residual gas analysis are well established and listed in the general RGA Literature. A very
complete library can also be accessed through the Gas Library of the RGA software. The
Gas Library Editor supports importing mass spectra from the NIST Chemistry WebBook,
or a mass spectrum from the RGA scan data.

Residual Gas Analysis Tip: Virtually every vacuum system will have detectable
amounts of hydrogen (2 amu), water (18 amu), carbon monoxide (28 amu) and carbon
dioxide (44 amu). Become familiar with these species and their fragmentation patterns,
and use their peaks to verify the correct performance of the instrument (i.e. mass scale
calibration and mass resolution) while operating the RGA.

Partial Pressure Measurement

Once the different components of a mixture have been identified it is possible to use the
SRS RGA to obtain quantitative values for the various partial pressures. This section
describes the basic steps needed to perform quantitative measurements with the
instrument. The formalism presented assumes multiple gas analysis, but is equally valid
for single gas measurements. Please consult the suggested references for details and
examples of these procedures.

The entire mathematical formalism used to derive the partial pressures of a mixture based
on a single mass spectrum is based on one assumption:

The total spectrum is a linear combination of the spectra of the different species that
are present in the mixture. In other words, the total spectrum is equal to the sum of the
individual peaks that would be observed if each constituent were alone in the system.

In mathematical terms, the assumption stated above can be written as the following linear
equation:
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HM = 29 hMg (1)
where:

g is an integer variable that represents the gases present (i.e. assign an integer to
each gas starting with one)

M is an integer variable that represents the mass numbers for the entire mass
range of the spectrum.

H= total peak height (amps) of the spectrum at mass number M.
hMg: peak height contribution (amps) from gas g at mass M.

hMg is related to the fragmentation pattern, the RGA’s sensitivity and the partial pressure of gas g
by the equation:

hMg = aMg Sg Pg (2)
where:

Oumg = Fragmentation factor of gas g at mass M: Ratio of ion signal at mass M to the ion
signal at the principal mass peak for gas g.

Sg = RGA’s partial pressure sensitivity factor for gas g, in amp/Torr (see Partial Pressure
Sensitivity Factor below)

Pg = Partial pressure of gas g in the system.

Equations (1) and (2) are combined to obtain the system of equations:
HM = Zg (Sg aMg) Pg (3)

Since all gases have more than one peak in their fragmentation pattern, the number of peaks (M)
in a real spectrum is generally larger than the number of gases (g). As a result, the system of
equations (3) usually has more equations than unknowns. This situation is sometimes simplified
eliminating some of the extra equations; however, the best results are obtained using all the
equations and a multiple linear regression procedure to calculate the best possible fit to the data.

Obviously, accurate results can only be obtained if the constants Otiymg and Sg are well known for
the RGA being used.

Note: The Scan Analysis utility of RGASoft program uses a Least Squares Fitting algorithm to
automatically calculate the composition of a “typical residual gas environment” at the end of any
spectral scan. Please see the RGASoft On-Line Help files for details.

Standard fragmentation patterns (for example, the fragmentation patterns included in the Gas

Library of RGASoft program) can be used as a source of Otmg values in moderately quantitative
determinations. However, when very precise numbers are desired, one should obtain the
appropriate fragment patterns by introducing pure gas into the RGA being used. The fragment
patterns must be obtained under the same conditions that will be used during regular spectral
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analysis since they depend on many instrumental parameters, including: electron energy,
emission current, ionizer design, mass filter settings, detector type, multiplier gain, etc. The
principal mass peak of a fragmentation pattern is simply the most intense peak of the spectrum,
and the intensity of all the other peaks in the pattern are normalized to its height for the

calculation of fragmentation factors. Note that by our definition the almg value for the
principal mass peak of any gas is equal to one. Principal mass peaks are used in the calculation
of the sensitivity of the SRS RGA to different gases as shown below.

Partial Pressure Sensitivity Factors

The partial pressure sensitivity of the RGA to a gas g, Sg, is defined as the ratio of the
change (H-Ho) in principal mass peak height to the corresponding change (P-Po) in

total pressure due to a change in partial pressure of the particular gas species. Ho and Pg
are background values.

Sg = (H-Ho) / (P-Po)

The units of Sg are of ion current per unit pressure (amp/Torr, for example).

The sensitivity of the RGA varies with different gases, changes with time due to aging of
the head, and is a strong function of the operating conditions of the instrument. Careful

guantitative analysis requires that the sensitivity factor, Sg, be determined for every gas
which may be a component gas in the system being analyzed. The sensitivity factors must
be obtained under the same operating conditions that will be used during general partial
pressure analysis since they depend on many instrumental parameters, including:
ionization energy, emission current, mass filter setting, type of detector, etc.

In order to separate the gain of the electron multiplier from the intrinsic sensitivity of the
RGA head, the sensitivity factors of the SRS RGA are defined for Faraday Cup detection.
A separate Electron Multiplier Gain Factor, is used to correct the ion signals when the
electron multiplier is turned on. See the Sensitivity and Electron Multiplier Tuning
sections of the RGA Tuning Chapter for details.

The basic procedure for determining the sensitivity of a particular gas in the RGA is the
following:

e Introduce the pure gas into the vacuum system, at a known or calculable pressure
(typically around 10 Torr).

e  Measure the output signal from the RGA for the principal mass peak of that gas
using the Faraday cup detector.

e  The ratio of this output signal to the pressure of the gas is the sensitivity factor, Sg.

During these measurements it is very important to insure that the partial pressures of all
other gases in the system are small enough so that they may be neglected. The sensitivity
factors calculated can only be applied to situations where the RGA is used with the same
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operating parameters. See the Sensitivity Tuning section in the RGA Tuning chapter of
this manual for more details on this calibration procedure.

A total pressure sensitivity factor is also needed by the SRS RGA to convert the ion currents
obtained during total pressure measurements into total pressures. Total pressure sensitivity factors
vary with different gases and share many of the properties of the partial pressure factors. They are
determined by a procedure identical to the one described above, but with the partial pressure
measurements replaced by total pressure measurements.

The underlying assumption when using sensitivity factors in quantitative calculations is that there
is a linear relation between the partial pressure and the corresponding RGA signals of the gases.
Deviations from linearity are to be expected above 10° Torr due to space charge effects in the
ionizer and ion-neutral scattering interactions in the filter. A more thorough check of the RGA’s
sensitivity involves measuring the RGA signals over several orders of magnitude of partial
pressure to determine the range over which a linear relationship exists. The sensitivity factor for
the gas is calculated as the slope of the “signal vs. partial pressure” response over the linear
range.

RGASoft uses two sensitivity factors stored in the non-volatile memory of the RGA. The
sensitivity factors, one for total pressure and one for partial pressure, are used as conversion
factors between the ion currents received from the RGA and the pressure units selected by the
user. The sensitivity factors are measured with the Faraday Cup detector and can be updated or
changed very easily using the Sensitivity Tuning command in the Probe menu. A separate
Electron Multiplier Gain Factor, stored in the non-volatile memory of the RGA, is used to correct
the ion signals for the gain of the electron multiplier. The gain of the electron multiplier is highly
mass dependent and defined relative to the corresponding FC signal. An automatic Electron
Multiplier Gain Adjustment command, built into the program, can adjust the CDEM voltage for
any gain between 10 and 10°. Consult the RGASoft On-Line Help Files for details on the
automated tuning procedures built into the RGASoft program. Also see the Sensitivity and
Electron Multiplier Tuning sections of the RGA Tuning Chapter for more general information.

The Mass Table of RGASoft program offers scaling factors for all of its gas masses eliminating
the limitations imposed by the single sensitivity factor on multiple partial pressure calculations.
For example, the scaling factors can be used to display correct partial pressure for all the species
in a table if the ratios between the partial pressure sensitivities of the different components are
known and only principal mass peaks are used to monitor them. The scaling factors can also be
adjusted to correct against the mass discrimination of the electron multiplier’s gain.

Important: Following current industry standards, the partial pressure sensitivity factor stored at
the factory corresponds to N, measured at 28 amu with Amig%=1 amu, default ionizer settings
and Faraday Cup Detection.

Single gas measurement example:
Monitoring the concentrations of one or few components in a system is easy in the absence of
severe spectral interference.

Suppose a system where argon is measured at 40 amu (principal mass), in the absence of any
other gases that contribute a signal at that mass value. The sensitivity to argon was previously

measured at Sar=10* amps/Torr, and the electron multiplier is biased and its gain at mass 40 was
previously measured at §cpem=1.02-10%relative to the FC signal.
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The partial pressure of argon, Pay, is easily calculated measuring the intensity (i.e. peak height)
of the ion current at mass 40, l40.

Par = lag/ (Ocpem - SAr) , units of Torr 4

The peak value, |40, can be extracted from a spectral scan or measured directly using
the single mass measurement mode of the SRS RGA. For example, a 10”° amp peak value
corresponds to 9.8-10° Torr of Ar. Note that equation (4) is a particular case of equation
(3), and that the fragmentation factor for the principal peak of Ar is one by definition.
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RGA Quadrupole Probe

This chapter describes the design and principles of operation of the components of the RGA
Quadrupole probe.

In This Chapter
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Introduction

The SRS RGA is a mass spectrometer consisting of a quadrupole probe, and an
Electronics Control Unit (ECU) which mounts directly on the probe’s flange and
contains all the necessary electronics for operating the instrument.

l— lonizer

lﬂ— Electronic Control Unit (ECU) —’l ‘1‘ Quadrupole Probe—b‘

Figure 3-1 Quadrupole Head Components

The probe is a specially engineered form of quadrupole mass spectrometer sensor. It is
mostly constructed out of type 304 stainless steel and high purity alumina, and mounts
directly onto any standard 2.75" CF port of a vacuum chamber. It analyzes residual gases
ionizing some of the gas molecules (positive ions), separating the resulting ions
according to their respective masses and measuring the ion currents at each mass.

The total probe equipment consists of three parts: the ionizer, the quadrupole filter and

the ion detector. All of these parts reside in the vacuum space where the gas analysis
measurements are made.

! |
lonizer |j:> lon Filter I:':> lon Detector
I

=

Figure 3-2 Probe Components

A stainless steel tube (RGA Cover Nipple) covers the probe assembly with the exception
of the ionizer. A 2.75” CF port with at least 1.375” inside diameter and 2.5 depth is
needed to provide clearance for the insertion of the ionizer into a vacuum system. This
insertion volume is comparable to that taken by a regular Bayard-Albert ion gauge.

A high vacuum environment (10 Torr or less) is required for operation.
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Positive ions are produced in the ionizer by bombarding residual gas molecules with
electrons derived from a heated filament. The ions are then directed toward the entrance
of the ion filter where they are separated based on their mass-to-charge ratio.

Description

The SRS RGA ionizer is of an open design (wire mesh construction) with cylindrical
symmetry and mounted co-axially with the filter assembly. The open configuration
provides unrestricted communication between the vacuum environment and the ionizing
region. The entire assembly is built out of type 304 stainless steel for complete vacuum
compatibility. The simple mesh design is very clean (low outgassing) and easy to service.

The principle parts of the ionizer are: the repeller, the anode grid, the filament and the
focus plate.

Focus Plate

0/ Anode Grid

Filament

()

Repeller

Figure 3-3 lonizer Components

The filament is made out of oxidation-resistant thoria coated iridium wire, which operates
at low temperature and can be exposed to atmosphere without the risk of burn-out. The
circular construction consisting of two ThO./Ir wires surrounding the anode grid
preserves the cylindrical symmetry of the ionizer. Both filaments operate simultaneously
under normal operation, and service is not interrupted if a single filament burns out (i.e.
the emission regulator automatically readjusts the temperature of the remaining filament
to restore the electron emission current). Once they wear out, the filaments can easily be
replaced in the field (Please see the RGA Maintenance chapter for details). A firmware
driven filament-protection feature constantly monitors (675 Hz) for overpressure. If
overpressure is detected the filament is immediately shut off, preserving its life.

Principle of operation

The principle of operation of the ionizer is similar to the Bayard-Alpert gauge, except
there is no central wire collector, and the electron repeller has been added.
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Filament x Repeller
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Figure 3-4 lonizer Schematic

The filament is the source of the electrons used in ionizing the gas molecules. It operates
at a negative potential relative to ground and is resistively heated to incandescence with
an electrical current from the emission regulator. The thermionically emitted electrons are
accelerated towards the anode grid which is positively charged with reference to the
filament and ground. Because of the open (i.e. wire mesh) design of the anode grid cage,
most electrons do not strike the anode immediately, but pass through the cage where they
create ions through electron impact ionization. Electrons which do not strike a grid wire
or ionize any molecules, pass through the grid volume into the region between the anode
grid and the repeller. There they decelerate and re-accelerate back toward the grid
because of the electric field created between the repeller and the anode grid. Electrons
continue circulating in this fashion until they are collected by the grid or are lost by
recapture. The multiple passes increase the ionization efficiency of the electron current
relative to single pass configurations. Within the anode grid volume, ions are attracted to
the center by the negative potential produced by an increasing electron density toward the
center. Hence, the ions, once formed, tend to stay within the anode grid structure, and the
ion distribution is more localized along the axis. The ions formed within the anode grid
volume, are extracted from the ionizer by the electric field produced by the difference in
voltage bias between the anode grid and the focus plate. The focus plate is kept at a
negative potential (relative to ground) and its function is to draw the ions out of the anode
cage and focus them into the filter section. The repeller, which completely encloses the
ionizer, is biased negative relative to the filament and prevents the loss of electrons from
the ion source. The Repeller Grid and the Focus Plate are only biased while the
filament is emitting electrons.

The technique of electron impact ionization requires low pressure for the efficient
production of electrons and the subsequent formation of ions. The ionizer is best suited
for operation in the high and ultrahigh vacuum range (10 to 10°* Torr). Non-linearities
in the ion currents, attributed mostly to space charge effects, are to be expected at
pressures above 10° Torr. Non-linearity effects can be minimized operating at reduced
electron emission current settings.
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Parameter Settings

The parameters that affect the ionization efficiency of the ionizer are: electron energy, ion
energy, electron emission current and focusing voltage. The general principles by which
they affect the performance of the source are well understood.

The ECU contains all the necessary high voltage and current supplies needed to bias the
ionizer’s electrodes and establish an electron emission current. The ionizer settings can
be directly controlled and monitored by the user through the RGA’s high level command
set.

The following table summarizes the ionizer settings available to the user, including
default factory values, parameter ranges and minimum acceptable increments:

lonizer settings:

Units Default Range Min. Incr.
lon Energy eV 12 41016 1
Electron Energy eV 70 2510 110 1
Focus Voltage \Y -90 0to-110 1
Emission Current mA 1.00 0to 4 mA .02

Table 3-1 lonizer settings

The average electron energy, expressed in eV, is equal to the voltage difference between
the filament and the anode grid and can be set anywhere in the range of 25 to 110 eV. For
electrons to produce ionization of gas molecules by bombardment, they must have a
certain minimum Kinetic energy. This minimum energy is called the ionization potential
and is different for every molecule. Above the threshold, the ionization efficiency
increases linearly with the electron energy until a maximum is reached. For most
molecules, this maximum is in the range of about 50 -100 eV, and for electron energies
above the maximum, the ionization efficiency slowly decreases with electron energy.

The kinetic energy of the ions as they move down the ion filter, simply referred to as the
ion energy, and expressed in eV, is equal to the voltage biasing of the anode grid. The
ion energy (i.e., anode grid voltages) can be set between 4 and 16 eV. The ion energy
setting affects the magnitude of the ion signals collected (i.e., sensitivity of the
spectrometer) and limits the ultimate resolution of the mass filter. Newly formed ions are
attracted by the negative potential of the focus plate and passed to the ion filter where
they are decelerated by the ground potential at the central axis of the quadrupole rod
assembly. Hence, the anode grid voltage defines the kinetic energy of the ions as they
enter the ion filter. lon energy determines the time spent by the ions in the filter and
hence, limits the resolution that can be obtained. It is well established that the resolution
limit is governed by the number of cycles of RF field to which the ions are exposed
before they reach the detector. In practice, the minimum resolution, Amzgs, iS mass
independent, linearly related to the ion energy, and inversely proportional to the square of
the product of the quadrupole length and frequency. The available ion energy settings
correspond to ultimate resolutions of approximately 0.2 and 0.6 amu (well under the 1
amu factory default setting). lon energy also determines the time spent by the ions in the
fringing fields at the entrance and exit points of the filter. lons passing through the
fringing fields can collect high transverse velocities and are more likely to collide with
the quadrupole rods and never be collected at the detector. As a result, ion signals (i.e.,
sensitivity) generally increase with ion energy.

SRS Residual Gas Analyzer



3-6 lonizer

The focus plate negative potential can be adjusted to any value within the range of 0 to
-110 V. In general, the voltage is selected so as to optimize the ion signals. The plate
serves the double purpose of drawing the ions away from the anode grid, and containing
the ionizing electrons inside the source. Electron leakage into the filter is only detectable
at low mass settings (1 to 10 amu) and can easily be eliminated biasing the focus plate at
least 30V more negative than the repeller.

The electron emission current is the electron current from the filament to the grid. The
available emission current range is 0 to 4 mA.

When an electron emission current is requested, the RGA biases the ionizer’s electrodes
and activates the filament’s heater until the desired emission current is achieved. A
“Background Filament Protection” Mode is automatically enabled to monitor the
performance of the filament while it is emitting electrons. The Filament LED remains on
as long as the filament is emitting electrons. If a problem is detected in the operation of
the filament (i.e., burnt filament or overpressure), the heater is immediately shut down
and the problem is prompted by the LED’s. If a current of 0 mA is requested, the
filament’s heater is shut down, the repeller and focus plate are biased to ground, the
CDEM is turned off (if necessary), and the Filament LED is turned off to indicate the
absence of emission in the ionizer.

The electron emission current is very tightly regulated by a feedback control loop which
dynamically adjusts the operating temperature of the filaments to keep the total emission
current constant. The emission of electrons from the filaments is limited by space-charge
effects (Child’s Law limitations). The maximum current attainable is a function of the
grid-to-repeller spacing and its potentials. Ideally, the rate of formation of ions should be
proportional to the electron emission current. In practice, the exact dependence between
ion signal and electron emission current in small ion sources is complicated by space-
charge effects and only general trends can be predicted. Greater ionization efficiency is
to be expected as the electron emission current increases.
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Quadrupole mass filter

Positive ions are transferred from the ionizer into the quadrupole where they are filtered
according to their mass-to-charge ratios. lons that successfully pass through the
guadrupole are focused towards the detector by an exit aperture held at ground potential.

Description

The quadrupole mass filter is an electrodynamic quadrupole operated by a combination of
DC and RF voltages. It is constructed of four electrically-conducting, cylindrical rods
accurately held in place by a set of two high-purity alumina insulators.

Quadrupole rods

Spring loaded
perforated screws

Alumina spacers

Figure 3-5 Quadrupole Mass Filter Components

Round electrodes are a common replacement for hyperbolic ones in modern RGA’s and
result in reduced cost and ease of construction. The stainless steel (type 304) rods are
4.5” long, have a 0.250” diameter (100 pin tolerance) and are held in quadrature and
parallel to each other, to tolerances better than 300 pin, by the precision ground alumina
spacers. Spring-loaded, perforated screws fasten the rods to the spacers. The whole
assembly is self-aligning, can easily be taken apart for cleaning and it can withstand
repeated cycling to 300°C for bakeout. The exact placement of the rods is optimized to
minimize the distortion of the electrodynamic quadrupole field by canceling higher order
(multipole) potential terms. The radius of the circle inscribed by the rods is 0.109”. The
frequency of operation is is about 2.7 MHz.
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Principle of operation

The following figure schematically represents the quadrupole mass filter and its
connections.

Quadrupole

b, o7

O,

U+V, coswt

-(U+Vo coswt)

Figure 3-6 Quadrupole Connections

During operation, a two-dimensional (X-Y) quadrupole field is established between the
four cylindrical electrodes with the two opposite rods connected electrically.

lons enter the filter along the Z-axis and start oscillating in the X- and Y- directions. The
ions are separated based on their mass-to-charge ratio by lateral forces resulting from the
electric potentials applied to the rods. A combination of DC and RF voltages control the
guadrupole filter operation. Successful separation of a specific mass species requires
setting the RF and DC values such that only the ions of interest have stable trajectories
down the quadrupole rod assembly. By simultaneously varying the amplitude of the DC
and RF voltages an entire mass spectrum can be scanned.

The RGA is completely calibrated at the factory so that the ECU automatically programs
the RF and DC voltages on the rods to the necessary levels during scans or individual
mass measurements. The calibration parameters can be accessed and modified by the user
in case recalibration or a change in resolution is required. (Please see the RGA Tuning
chapter for details.)
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The quadrupole mass filter must be operated in a vacuum. Linear operation can be
expected up to pressures of the order of 10 Torr. In general quadrupoles can be operated
at relatively high pressures compared to other types of analyzers. The upper limit of
useful operation is determined by the collisions between the ions and the neutral gas
molecules. In order to avoid collisional scattering, it is necessary to maximize the mean
free path of the ions.

The general principle of operation of the filter can be visualized qualitatively in the
following terms: One rod pair (X-Z plane) is connected to a positive DC voltage upon
which a sinusoidal RF voltage is superimposed. The other rod pair (Y-Z plane) is
connected to a negative DC voltage upon which a sinusoidal RF voltage is superimposed,
180 degrees out of phase with the RF voltage of the first set of rods. The potentials are
represented by the expression:

Viy=+/- (U +V cos ot)
where,

U is the magnitude of the DC voltage applied to either pair of rods,
Vo is the amplitude of the RF voltage applied to either set of rods, and
o is the angular frequency (=2=f) of the RF.

Light ions (low mass-to-charge ratio) are able to follow the alternating component of the
field. For the X direction, those ions will stay in phase with the RF drive, gain energy
from the field and oscillate with increasingly large amplitudes until they encounter one of
the rods and are discharged. Therefore, the X direction is a high-pass mass filter: Only
high masses will be transmitted to the other end of the quadrupole without striking the X
electrodes. On the other hand, in the Y direction, heavy ions will be unstable because of
the defocusing effect of the DC component, but some lighter ions will be stabilized by the
alternating component if its magnitude and amplitude are such as to correct the trajectory
whenever its amplitude tends to increase. Thus, the Y direction is a low-pass mass filter:
Only low masses will be transmitted to the other end of the quadrupole without striking
the Y electrodes.

The two directions together give a mass filter suitable for mass analysis: By a suitable
choice of RF/DC ratio the filter can be made to discriminate against both high and low
mass ions to the desired degree.

The RF voltage magnitude and frequency determine the mass of the ions that undergo
stable trajectories down the filter. As the RF amplitude increases, heavier ions start to
oscillate in phase with the RF and collide with the rods. The DC/RF ratio determines the
filter selectivity. As the DC increases (at constant RF) heavier ions are defocused by the
negative DC component.

The attractive features of the quadrupole as a mass analyzer are evident from the above
discussion: The quadrupole provides a convenient filter which can be tuned to the
desired mass by varying the amplitude of the RF voltage; the mass selectivity (i.e.,
resolution) can also be varied electronically by simply adjusting the DC/RF ratio.
Simultaneously varying the amplitude of the DC and RF voltages allows entire mass
spectra to be scanned.
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Mass Range, Resolution and Throughput

The most important characteristics of a quadrupole are the mass range, its ultimate
resolution and its throughput characteristics.

The mass range is the range of masses defined by the lightest and the heaviest singly
charged ions which can be detected by the mass spectrometer. The SRS RGA is offered
in three different models with mass ranges of 1 to 120 (RGA120), 1 to 220 amu (RGA
220) and 1 to 320 amu (RGA320). The main difference between the three models is given
by the maximum supply voltage available to the rods.

The terms Resolution and Resolving Power are often used by mass spectroscopists to
express the ability of a mass filter to resolve ions having different masses:

Resolution, or Absolute Resolution = AMig.: The width AM of the pass band
of the filter, defined as the full width at which the ion current falls down to 10%
of the maximum value. Units = amu.

Resolving Power: R= M/AM1o, : Ratio between a particular mass M and the
resolution, AM1ge , at that mass. Dimensionless ratio.

It is common practice in modern RGA’s to keep AMiq cOnstant at a value which ensures
adequate separation of masses that are 1 amu apart. The SRS RGA quadrupole operates
in that “Constant Resolution” or “Constant Am” mode. AMaqy, is preset at the factory to 1
amu, but it can easily be adjusted by the user all the way to the theoretical ultimate
resolution of the filter.

The following figure illustrates the resolution concepts explained above, using a Krypton
mass spectrum as an example. The different isotopes of the gas are well separated from
each other, and a 1 amu peak width (= Amyo) is measured on the #Kr peak at 10% of its
peak height. Also notice the 20% valley between the 82Kr and 8Kr peaks.
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Figure 3-7 Peak Width Measurement

It is well established that the resolution attainable by a quadrupole is limited by the
number of cycles of RF field to which the ions are exposed before they reach the
detector. In practice, the minimum resolution (AMios) value attainable is mass
independent, linearly related to the ion energy, and inversely proportional to the square of
the product of the quadrupole length and frequency. The available ion energy range of the
RGA correspond to ultimate resolution values of approximately 0.2 amu (4 eV) and 0.6
amu (16 eV) which are well under the factory default setting, and more than adequate to
separate ions which differ in mass by 1 amu or less.

The resolving power, R, at a mass M is strictly related to the DC/RF voltage ratio. An
increase in the resolving power usually results in a decrease in the effective throughput
of the filter. As the DC/RF ratio is increased the amplitude of the ion oscillations within
the filter increase and a greater fraction of the ions are lost to collisions with the analyzer
rods. The throughput of the quadrupole affects the overall sensitivity of the spectrometer
to the mass being filtered. The exact relationship between resolution and sensitivity is
very complex as it depends on the concentration and divergence of the ion beam leaving
the source. It is complicated further by the defocusing action of the fringing fields
between the ion source and the rods. However, as a general rule of thumb Sensitivity
decreases at 1 to 1.5 times the rate of resolving power increase.

The inverse relationship between sensitivity and resolving power is also responsible for a
very important feature of quadrupole mass filters operated at constant resolution: The
throughput of the analyzer decreases with mass. (Since AMioy is constant, the
resolving power, R= M/ AMiqy, increases with mass reducing the effective throughput of
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the filter for high masses. This effect must be taken into account when calculating partial
pressure sensitivities from ion currents.)

Zero Blast Suppression

When the applied potentials are small (or zero) as at the beginning of a scan, ions
entering the filter may be transmitted even though their trajectories are mathematically
unstable. This gives rise to an output signal at the beginning of mass scans called the
“Zero Blast”. In the SRS RGA the Zero Blast is suppressed preventing the DC voltage
from reaching zero under 1.5 amu. Zero Blast suppression is standard practice in all
commercially available RGAs and is responsible for the lack of reliable readings for
hydrogen at 1 amu.
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lon Detector

Positive ions that successfully pass through the quadrupole are focused towards the
detector by an exit aperture held at ground potential. The detector measures the ion
currents directly (Faraday Cup) or, using an optional electron multiplier detector,
measures an electron current proportional to the ion current.

s

ions — ;E :: ' | FC signal

Faraday cup

Description
The following figure describes the detector assembly including the electron multiplier
option.
DEM anode
CDEM
CDEM coxe
Exit Plate - [
T~ | [ [[F—=—" CDEM signal

Probe flange

Faraday cup shield

Figure 3-8 Detector Components

The Faraday Cup (FC) is a small stainless-steel (type 304) metal bucket located on-axis
at the end of the quadrupole. It is shielded from the intense RF and DC fields of the
guadrupole by the grounded exit plate, which also provides some focusing of the ions
into the detector. A cylindrical tube (FC Shield) encloses the FC, protecting it from the
strong electrodynamic potentials of the adjacent rods and from collecting ions originated
at sources other than the ionizer. The signal is carried to the electrometer through a
coaxial feedthru which extends into the ECU box and efficiently shields the small ion
currents. The FC is attached to the center feedthru with a push-on connector and can
easily be pulled out for cleaning or modification.

Notice that an electron suppressor electrode (commonly found in several commercially
available RGA’s) is not part of this detection setup since the large aspect ratio (Iength-to-
diameter) of the FC assures efficient recapture of secondary electrons.

The electron multiplier is a state-of-the-art Macro Multi-Channel Continuous Dynode
Electron Multiplier (CDEM). It consists of a straight, four or six channel tube made out
of a special resistive glass (i.e., high secondary electron emission yield) with a cone of
the same material attached to the front end. It is placed upright, next to the FC, and away
from the axis of the analyzer (off-axis configuration). It is held safely in position by a
clamp and a clip. The clamp is connected to the neighboring rod that carries the voltage
from the High Voltage power supply, and is responsible for biasing the cone as well as
assuring its correct placement next to the FC. A hole on the side of the FC Shield allows
space for mounting the CDEM cone very close to the top of the FC. The clip anchors the
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CDEM glass tube to the side of the FC Shield and holds the lower end of the tube at
ground. Chrome electrical coatings, deposited at both ends of the tube provide the
necessary electrical contacts. A plate (CDEM Anode) mounted at the exit of the CDEM
collects the secondary electrons. The resulting electron current flows into the
electrometer through a separate feedthru of the flange.

The entire setup is self -aligning and easily serviced by the user in the field. For example,
removing the screw that fastens the clamp to the HV rod is all that is needed to replace
the CDEM (Please see the Maintenance chapter for details.)

FC detection is standard in all RGA probes. All FC-only units can be upgraded to
electron multiplier detection without the need to replace the probe. When the electron
multiplier is not turned on, multiplier systems operate exactly like the FC-only systems.
The same electrometer is used to measure the ion (or electron) currents under both
detection schemes. The ECU automatically connects the necessary electrode to the
electrometer depending on the type of detector being used.

Faraday Cup operation

The Faraday Cup (FC) detector, measures the incident ion current directly. Positive ions
enter the grounded detector, strike a metal wall, and are neutralized by electron transfer
from the metal to the ion. The electrons given up in this process establish an electrical
current that has the same intensity as the incoming ion current.

Since the nominal sensitivity of the RGA is in the order of 10* Amps/Torr, the currents
measured are very small: 10° to 10> Amps for pressures in the order of 10° to 10
Torr, respectively. Minimum-detectable-partial pressures as low as 510 Torr are
possible with the FC. However, in real-time applications, FC detectors are rarely used to
measure partial pressures below 10° Torr. At pressures below that value, the CDEM
option becomes a much better alternative allowing for faster scan rates and improved
signal-to-noise ratios.

The best characteristics of FC detection are: simplicity, stability, large dynamic range,
and lack of mass discrimination. All ions are detected with the same efficiency
regardless of their mass.

The ECU automatically connects the FC electrode to the electrometer input upon power-
on reset, and whenever the electron multiplier is not turned on.

Electron Multiplier Operation

An Electron Multiplier upgrade (Option 01) to the standard Faraday Cup (FC) detection
setup is recommended when the SRS RGA is routinely used at pressures under 10° Torr.
The detection upgrade consists of a state-of-the art Macro Multi-Channel Continuous
Dynode Electron Multiplier (CDEM), and a negative high voltage power supply (0 to -
2500V).

Macro Multi-Channel Continuous Dynode Electron Multipliers are used in the SRS
RGA models with the electron multiplier option (Option 01). They consist of a straight
four or six channel tube made out of a special resistive glass (i.e. high secondary electron
emission yield) with a cone of the same material attached to the front end. The extruded
channels run along the length of the device and are twisted at the time the part is drawn to
eliminate ion feedback. Each CDEM is placed upright next to the FC and away from the
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line of sight of the ionizer (i.e. off-axis configuration). When the cone is biased
negatively (-1000 to -2500V) relative to the back end, positive ions are very efficiently
attracted away from the FC and strike the cone at high velocity producing electrons by
secondary electron emission. The secondary electrons are subsequently accelerated down
the four channels and produce more secondary electrons. For each ion entering the cone
of the CDEM, and depending on the bias voltage applied, up to 107 electrons come out at
the back end and are picked up by a grounded plate (the CDEM anode). The resulting
electron current is proportional to the ion current and is measured by a separate
electrometer from the one used in the FC measurements. The sign of the electron
multiplier currents is reversed before the current value is sent to a host computer so that
the computer does not need to do any sign flipping on the currents received when the
CDEM is activated.

The gain of the electron multiplier in the RGA is a function of the bias voltage and is
measured relative to the FC signal. The following figure shows a typical “gain
characteristic” (i.e., gain vs bias voltage) curve obtained for H,O* ions at 18 amu.
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Figure 3-9 Typical CDEM Gain Characteristic Curve

Very high gain values can be obtained and controlled with voltages smaller than -2500
Volts. The sensitivity of the spectrometer increases with the gain of the electron
multiplier. Higher sensitivities provide lower minimum detectable partial pressures and
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faster spectral scans. Minimum detectable partial pressure limits as low as 5:10°* Torr are
commonly achieved.

However, the increase in sensitivity is obtained at the price of limited dynamic range,
mass discrimination effects, gain instabilities and finite lifetime of the device. A good
understanding of these limitations is very important to assure accurate quantitative
measurements.

The dynamic range of electron multipliers is determined by their dark current at the low
end, and by the bias current value at the high end.

The bias current is established by the external voltage drop along the resistive glass tube
and flows along the channel walls replenishing their charge as secondary electrons are
emitted. Channel electron multipliers, operate linearly in the analog mode until the
output current is approximately 10% of the bias current.

The dark current of a multiplier is the electron current measured at its output in the
absence of an input ion current. The minimum output current that can be accurately
measured with the multiplier is equal to the dark current noise.

Example: For a typical resistance of 200 MQ, and a bias voltage of -2000V, the bias
current is 10 pAmps and the output current must be kept under 1 pAmp. Since the gain at
that voltage is roughly 108, the maximum input current at which the output current
behaves linearly is 102 Amps (1 pAmp / 10). Typical dark currents are lower than 102
Amp, and the minimum input current that can be detected is 102 Amps. For a sensitivity
of 10* Amp/Torr, this corresponds to the lower and upper limits of 10°2° and 108 Torr,
respectively, and 7 orders of magnitude of dynamic range.

The total gain of electron multipliers varies as a function of the mass of the incident ions.
As a rule of thumb, and for small molecules, the gain decreases as mass increases. This
mass discrimination effect is caused by the dependence of ion-electron conversion
efficiencies on the velocities of the ions entering the detector. For example, an inverse
relationship with the square root of the mass has been reported for monoatomic ions of
the same energy. For accurate quantitative measurements, it is essential to calibrate in
advance the gain of the multiplier for the specific ionic species being detected.

An important problem when working with multipliers is that their gain changes with
time. Gain degradation is unavoidable, and particularly serious just after the detector
has been exposed to air, or after high quantities of reactive gases have been introduced
into the vacuum system. The increased surface area provided by the extra channels in the
multi-channel devices reduces this problem; however, frequent calibration of the
multiplier gain against the FC output is recommended for reliable quantitative
measurements. This is done automatically with the RGA software.

Gain degradation limits the lifetime of all electron multipliers. Eventually the gain drops
to unacceptable values and the multiplier needs to be replaced. As a rule of thumb, the
multiplier should be replaced when the required gains can no longer be achieved by
increasing the bias voltage. The lifetime of electron multipliers is ultimately dependent
upon the accumulated charge drawn from the multiplier (Gain degradation typically
starts at accumulated output current values of a few thousand pAmp-hr). However,
the lifetime also depends critically on the residual gas environment and the duration of
transient signals. Contamination by organic compounds (i.e., diffusion or mechanical
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pump oil) and the interaction with highly reactive gases must be avoided at all times.

It has been found that, in many cases, channel multipliers may be successfully refreshed
by cleaning them in high purity isopropyl alcohol. The procedure is described in the RGA
Maintenance chapter (CDEM Refreshment section) and, even though it is not
guaranteed to always work, it is worth trying as a last resort before discarding a
multiplier.

Channel electron multipliers have a history of high performance and dependability in
mass spectrometry applications. However, in order to achieve maximum useful lifetime
and optimum performance, it is very important to handle them very carefully. Please read
the CDEM Handling and Care section in the RGA Maintenance chapter to familiarize
yourself with some of the basic procedures that must be followed for the correct
operation of the multipliers.

Hardware Modifications

Warning

The information in this section is for the use of Qualified Personnel only. To avoid
shock and irreparable damage to the unit, do not attempt any of the changes in this
section unless you are authorized to do so.

Read and follow all “Safety and Precaution” instructions before handling the
product.

Because of the danger of introducing additional hazards, do not install substitute
parts or perform any unauthorized modification to the product. Do not use the
product if it has unauthorized modifications. Return the product to SRS for service
and repair to ensure that safety features are maintained.

The SRS RGA is a quadrupole mass spectrometer specially engineered to perform all the
functions of a residual gas analyzer, and its standard electron impact ionizer is designed
specifically for that type of operation. However, the simplicity of design of the probe
facilitates the modification of the instrument so that measurement applications other than
simple partial pressure analysis are possible. The relative insensitivity of quadrupole
mass filters to variations in ion entrance conditions makes it possible to apply quadrupole
mass spectrometers to the detection of ions from sources other than the standard electron
impact ionizers of RGA’s. For example, quadrupole mass filters have been used to
monitor ion formation in plasma, SIMS, electrospray, ICP, laser ionization and surface
desorption experiments.

Many of the changes required to apply the RGA probe to alternative measurement
schemes involve the modification of the ionizer from its standard design. The ionizer is
of a very simple design and can be completely disassembled by the user loosening a few
screws (please see the RGA Maintenance chapter). Ease of disassembly is ideal for
periodic cleaning and very convenient when design modifications are needed. Special
applications might require modifying, replacing or even removing ionizer parts. The
scope of this section is to discuss the effects that design changes will have on the overall
performance of the probe. These types of modifications are most common in research
applications, and obviously should only be attempted by qualified personnel who
completely understand the operation of the quadrupole mass spectrometer.
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It is a good practice to minimize the changes performed on the probe so that the RGA can
still perform its basic functions of residual gas analysis, which are invaluable tools for
vacuum system diagnostics.

Repeller and anode grid modifications

The two ionizer grids can easily be removed from the probe for replacement or
modification. They are structurally very strong because they are made out of sintered
wire mesh (i.e., all crossing wires are welded to each other). Typical modifications, such
as punching holes or cutting slots, can be performed by skilled personnel without
compromising their shape. The replacements and modifications should obviously be
compatible with the operation of the rest of the quadrupole probe. Optimum performance
of the quadrupole can only be achieved if the ions are injected in the form of a beam of
low energy (2 to 15 eV) and low divergence (i.e., close to and parallel to the axis of the
guadrupole). For example, it is well established that the correct alignment of the anode
grid is critical to the operation of RGA spectrometers: a misalignment as small as 0.010”
can result in decreased sensitivity, decreased resolution and peak shape deterioration (i.e.
peak splitting).

The alignment and symmetry of the repeller are not as critical as that of the anode grid.

Repeller removal

It is possible to operate the ionizer without the repeller. The repeller is held in place by a
single, easily accessible screw (See RGA Probe Assembly drawing). It is sometimes
eliminated when a smaller ionizer insertion volume is needed, when a laser beam needs
to be focused into the anode grid or when a collimated beam of molecules needs to be
directed through the anode grid without molecular scattering taking place at the repeller’s
wires.

The repeller serves several purposes in the ionizer that must be carefully considered
before removal:

1. It mechanically protects the delicate filament while the probe is being mounted on the
vacuum system. The filament might easily be damaged during installation without
that protection.

2. It constrains the electrons to the ionizer volume, minimizing cross talk with other
gauges in the vacuum system (Free electrons can affect the readings of neighboring
ion gauges).

3. Itincreases the ionization efficiency by folding the electron trajectories back into the
anode grid (multiple-pass configuration). A decrease in ionization efficiency will
usually be noticed when the repeller is removed.

Operation without a filament

It is possible to use the quadrupole mass filter to detect ions originating from sources
other than the standard electron impact ionizer. For example, the filament and the grids
can easily be removed to expose the quadrupole to ions from a SIMS or Laser desorption
ionization experiment. All the measurement and scanning functions of the mass
spectrometer are still operational when the filament is not installed or not emitting
electrons As mentioned previously, optimum performance of the quadrupole can only be
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achieved if the ions are injected into the filter in the form of a beam of low energy (2 to
15 eV) and low divergence (i.e. close to and parallel to the axis of the quadrupole).

Whenever possible, complete removal of the filament and the grids should be avoided so
that the residual gas analysis functions of the RGA are still available. For example, since
service is not interrupted if a single filament burns out, it might be possible to keep one of
the sides of the filament intact instead of removing it completely.

RGA Cover Nipple Replacement

A stainless-steel tube covers the probe assembly with the exception of the ionizer. This
tube, referred to as the RGA Cover Nipple, contributes to the overall capacitance of the
guadrupole rod assembly, and should not be removed from the probe unless it is replaced
with a similar grounded metal shield tube inside the vacuum system (see below). Failure
to replace the Cover Nipple will push the RF driving circuit out of regulation, and will
limit the operating mass range of the quadrupole filter. The tube also acts as a barrier,
preventing ions from sources other than the RGA’s ionizer from reaching the detector
and affecting the ion current readings.

The RGA Cover Nipple consists of two non-rotatable, 2.75” CF Flanges, connected by a
short section of 1.5” OD tube (0.065” wall thickness). The entire part is made out of
stainless-steel type 304, and its overall length is 6.75” (including the two flanges.)

Some experiments require being able to insert the RGA’s probe deep into the vacuum
chamber. When a large insertion depth is required, the standard RGA Cover Nipple can
be replaced with the O100MAX Maximum Insertion nipple illustrated in Figure 10.

Shield tube (1.58" 0D, 1.37" 10
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Figure 3-10 RGA Probe with Shield Tube

The O100MAX Shield tube consists of a 1.5 OD tube welded onto the large-flange side
of a 4.5”-t0-2.75” Zero Length CF Adapter Flange. The tube has a wall thickness of
0.065” and is strictly perpendicular (90° +0.2°) to the flange’s face. The RGA’s
guadrupole assembly is attached to the small-flange side of the Adapter Flange so that the
tube completely covers the mass filter (replacing the standard RGA Cover Nipple). This
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modified probe can be mounted on any standard 4.5” CF port of a vacuum chamber, and
the ionizer penetrates the vacuum system by roughly 7.

SRS Residual Gas Analyzer



Chapter 4
RGA Electronic Control Unit

This chapter describes the most important features of the RGA Electronics Control Unit.

In This Chapter
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Introduction

The SRS RGA is a mass spectrometer consisting of a quadrupole probe, and an
Electronics Control Unit (ECU). The ECU completely controls the operation of the RGA,
handles its data and transmits it to the computer for analysis and display.

lonizer

lﬂ—' Electronic Control Unit (ECU) —Vl ‘1‘ Quadrupole Probe—b‘

Figure 4-1 Quadrupole Head Components

The ECU is a densely packed box of electronics (3” x 4” x 9”) that connects directly to
the probe’s feedthrough flange and also to a host computer. It includes several regulated
power supplies, a built-in microprocessor, control firmware, and an RS232, a USB and a
Ethernet communication ports. It is powered by either an external 24VDC (@3 Amps)
power supply or an optional, built-in power module which plugs directly into an AC
outlet.

Warning

The ECU does not have any serviceable parts and does not require any routine
maintenance. All calibration procedures should be done using the RS232 interface
and the RGA calibration command set.

During normal operation of the RGA, regulated power supplies built into the ECU set the
electron emission current, the voltage levels on the ionizer electrodes, and the high
voltage across the electron multiplier. RF/DC levels for each mass are also set and
regulated by the ECU, based on internal mass calibration parameters permanently stored
in non-volatile memory. A built-in, electrometer detects the ion currents collected by the
FC, or electron multiplier, and converts them to voltage signals that are read by a built in
AJD converter. The microprocessor automatically computes the magnitude of the ion
currents using internal calibration parameters. The ion currents are then averaged as
needed, offset corrected and transmitted to the host computer for immediate display.

Several built-in checks constantly monitor the operation of the probe and its operating
environment. For example, the filament emission, and the electron multiplier, are
immediately turned off in the case of accidental overpressure.

Active LED's on the rear panel of the ECU provide constant feedback on the status of the
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filament, electron multiplier, electronics system, probe and communications, and alert the
user of any problems.
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Front Panel

The ECU mounts directly on the probe’s feedthru flange. Its front panel is designed to
rest flat against the back surface of the probe’s flange, and it is not visible while the ECU
is locked in place.

Probe alignment holes \

Clearance -
holes
(6 places)

Internal connectors .
Locking screws

(2 places)

Figure 4-2 ECU Front Panel

The front panel of the ECU box has nine holes of three different sizes, and two locking
SCrews.

The big hole in the center provides access to internal connectors that line up with the
feedthru connectors of the probe. The six equally-spaced holes, surrounding the big hole,
provide clearance for the six bolt heads on the back of the probe’s feedthru flange.

The two remaining holes (1/4” diameter) line up with the alignment rods of the probe and
assure the correct alignment between the ECU and the Probe during installation.

The locking screws line up with two threaded holes on the back of the feedthru flange,
and are used to lock the ECU box in place.
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Rear Panel

The rear panel of the standard ECU Box has two connectors, two locking knobs, a
cooling fan, and eight LED’s.

Units with the optional, built-in power module (Option 02) also have a fused Power Entry
Module with a built-in power switch.

USB Z2=2Z6 55
] T 552 8 3
T = AT (D)] 151
( —~ [ F : :
& |t
STATUS o
@ Power : = - Q>(_')((De°;+SENS o
@ Filament OO +RTD | o
Q@ cem A RTD|| o
@ Deass OO~ -SENs |l o
Com Act S ENe 5
@ comEer y OO CPIOTIES
@ Pressure > YEEN ©
SvEE { TRIG °
y L7 Q)6
I DCE/28.8k/N/8/1
T - O O :
00000
On Off
R Relay +24V/[2.5A RS-232 )
| |
( AC Power N
90 - 264 VAC, 47 — 63Hz
IT
()
\& J

See manual. Refer all servicing to qualified personnel
I I

\ WARNING: Dangerous Voltages inside. Do not operate with cover removed.
[

Figure 4-3 ECU Rear Panel with built in power supply module (Option 2)

+24VDC / 2.5A Connector

Use this connector to provide external power to the RGA. The ECU electronics must be
powered with a 24 V (+/- 2V) power supply with 2.5 Amps or more current. The power
supply must have a cable with a barrel connector on the free end.
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USB Connector

Use this connector to interface the RGA to a computer with a type A to type B USB
cable. Use 115200 baud rate, 8 data bits, no parity, 1 stop bit for serial communication
setting.

LAN Connector

Use this connector to interface the RGA to a computer with an Ethernet (Cat 5) cable for
10/100 BASE-T speed

RS232 DCE/28.8k/N/8/1 Connector

Use this connector to interface the RGA to a computer with a RS232 cable. The RS232
interface connector of the RGA is configured as a DCE (transmit on pin 3, receive on pin
2) with full RTS/CTS handshaking enabled. Use a straight through RS232 cable with 9-
pin, type D connectors to connect the computer (usually DTE) to the ECU. The
communication parameters are fixed at: 28,800 baud rate, 8 data bits, no parity and 1 stop
bits.

Relay
Use this relay to turn on/off a resistive load up to 125VDC (30W) or 125 VAC (50 VA)

Analog I/0

Use V+IN and V-IN to monitor a differential voltage input between 0 and 10 V.
Use | IN and GND to monitor a current input between 4 and 20 mA.

Use V OUT and GND to source a voltage output between 0 and 20 V.

Use | OUT and GND to source a current output between 4 and 20 mA.

RTD, GPIO, TRIG, and HV_EN

Connect +RTD and —RTD to a resistive temperature detector (RTD) for 2 wire
measurement.

Connect +RTD, -RTD and +SENSE for 3 wire measurement.

Connect +RTD, -RTD, +SENSE and —SENSE for 4 wire measurement

Use TRIG to trigger an armed scan.
Set HV_EN to GND wiill turn off the filament and CEM HV

General purpose digital input output (GPIO) can be used for 1 bit digital input and out.

LED’s
Eight LED’s provide constant feedback on the operation of the RGA. The function of the
LED’s is described later in this chapter.

Locking Knobs

Use the two knobs to lock the ECU box in place at the end of the ECU installation
procedure. Do not overtighten the knobs. (Hand tighten only.)
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Power entry module (Option 02)

Use this connector to power the RGA directly from an AC outlet. Use the three-wire
power cord provided by SRS to connect the RGA directly to a properly grounded AC
outlet. Use the built in switch to turn the unit on-off.

Refer to the first page of this manual for instructions on selecting the correct line voltage
and fuse. The built-in power module (Option 02), has universal input (90-264 VAC, 47-
63 Hz), and completely eliminates the need for an external 24VVDC power supply
connection.

LED Functionality

LED's on the rear panel of the ECU provide constant feedback on the status of the
filament, electron multiplier, electronics system, probe and communications, and alert the
user of any detected errors. This section describes in detail the function of each LED.
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STATUS (Green) LED’s

Figure 4-4 ECU LED’s

Power: The Power LED is turned on whenever the RGA is successfully powered up.
When power is applied to the ECU, a firmware routine automatically checks the external
voltage level and turns on the Power LED if the voltage is within the acceptable range of
24 +/-2 VV DC. The same test is performed in units with built-in power modules (Option
02) to check the voltage output of the internal switching power supply. If the check fails,
the red Error LED is turned on instead to indicate the problem.

Note: A check on the external power supply can be performed at any time during
operation using the EP? diagnostic command.
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Filament: The Filament LED indicates the presence of electron emission current in the
RGA’s ionizer. It is turned on when a finite emission current is requested by the user and
during Degas processes. It is turned off when the user requests a null emission current or
when a filament error condition (i.e. overpressure, worn out or burnt filament) is detected
and the filament emission is turned off.

Note: Filament error conditions are easily diagnosed with the help of the Pressure LED
and the assortment of diagnostic checks built into the firmware and supported by the
RGASoft program.

CEM: The CEM LED is turned on whenever the electron multiplier detector is active
(i.e., when a finite biasing voltage is applied across the electron multiplier).

Several different mechanisms can turn off the electron multiplier and its LED: a null bias
voltage request by the user, a Degas process, and an overpressure that shuts down the
filament emission.

Degas: The Degas LED is activated during Filament Degas processes.
The Filament LED is also activated during a Degas.
The CEM LED is turned off during a Degas.

ComAct: The communication activity LED reflects the activity on the communication
interfaces (USB, LAN and RS232).

ERROR (Red) LED’s

ComErr: The communication error LED indicates the presence of errors in the
communication interface.

Pressure: The Pressure LED is automatically turned on whenever the filament heater is
unable to establish a requested emission current. The most common reason for this
problem is a serious leak in the vacuum system. In the event of an overpressure detection,
the filament emission and the electron multiplier are immediately turned off, and the
Error and Leak LED’s are turned on to indicate the problem.

Important: The Pressure LED will also be turned on if the thoria coating of the filament is
excessively worn down or damaged. However, this is a rare event due to the long life of
the thoriated iridium filaments.

System: The System LED indicates the presence of errors in the operation of the RGA.
Errors can originate from many different sources including hardware, communications,
probe (i.e., bad filament) and operating environment (i.e. overpressure). Troubleshooting
is simplified by an assortment of diagnostic commands built into the firmware, and fully
supported by the RGA Windows program.
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Tuning chapter.

Maintenance and Service

o The ECU box does not have any serviceable parts and does not require any routine
maintenance.

¢ Do not perform any unauthorized service, adjustment or modification of the
instrument.

e Do not install any substitute parts.

e Contact the factory for instructions on how to return the instrument for authorized
service and adjustment.

SRS Residual Gas Analyzer






Chapter 5
RGA Software

For detailed information of the RGASoft program please refer to the RGASoft Online Help files
provided with the program disks. The Online Help includes current and detailed descriptions of all
the features, procedures, and commands available in the program.

In This Chapter
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Overview

Overview

Software Program Structure

The RGA software program, namely RGASoft, is an interactive Windows program
supporting SRS’s RGA instruments. One RGASoft instance connects and controls one
RGA unit. Likewise, multiple instances of the software program can independently
connect to different RGA units. The number of instances is virtually unlimited and only
constrained by the system resources.

An RGASoft instance, visible as a separate window, is used not only to control and
acquire data from an RGA but also to review saved data and perform offline analysis.
You can have one instance connecting to an RGA to perform a scan, and another one
opening a saved data file.

Once an RGA is connected to RGASoft (via an Ethernet or a Serial connection), you can
calibrate and tune the RGA’s parameters, or perform scans with different modes and
configurations. A scan run is organized as a sequence of scan steps where each step can
be specified by a different scan mode or settings. The acquired data is saved to files. The
saved data includes scan configuration, scan data, and the view. The first two items are
the core of the data and are not meant to be changed later. On the other hand, the view
which contains the visual and analysis settings can be modified when viewing the data.

The RGASoft’s main user interface (UI) consists of a side bar which houses frequently
used controls (RGA connect, scan run, pause, stop, etc.), a collapsible control panel to set
up scan configurations and to view status, and a set of docking windows where each one
contains plots and tables to present the data associated with a scan step. The Ul also
includes the menu to give access to many other components.

RGASoft Files

RGASoft is capable of saving files in a variety of formats. This section describes all the
file formats and their different uses.

RGA data files (.rgadata)

RGA data files are the main files used in RGASoft. They are binary files that contain
scan data with all the information on the scan parameters, scan trigger settings, RGA
status, etc. You can open this file in RGASoft to view the scan data and perform offline
analysis or to load its scan parameters to use in a new scan. The RGA data file is
accompanied with a view file (.rgaview) to store the visual settings.

RGA view files (.rgaview)

An RGA view file supplements an RGA data file (.rgadata) in providing visual settings.
Its file name is the same as the RGA data file name with a different extension. When you
load configuration from an RGA data file, if the view file is available in the same
location as the data file, the visual settings you have saved will also be loaded. Without a
view file, RGASoft will use default visual settings. Visual settings cover a wide set of
settings including the custom display of plots and tables, the alarm settings, or the
composition analysis settings. While the data file stays unchanged after a scan run
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finishes, you can modify the visual settings and save them to the view file. This allows
you to perform offline analysis and save the analysis settings.
Export Text files (.txt)

RGASoft provides options to export plot data or table data to a text file in CSV (comma-
separated values) format. This format can be easily read by a spreadsheet program for
data analysis. The RGASoft program does not read these text files, it only writes to them.
Export Image files (.bmp, .jpg, .gif, .png, .tif)

In addition to text files, RGASoft can also export a plot image to a file with one of the
common graphic formats. These files are easily read by many word processing, page
layout, and graphic programs.

INI file (rgacfg.ini)

This configuration file contains some advanced settings and should only be modified in
special cases such as when you’re experiencing a slow network, or you want to capture a
verbose software log for troubleshooting purposes. The RGASoft program reads the
rgacfg.ini file upon launching. Changing the file requires relaunch of the software for the
settings to take effect.

Log files (.log)

Log files are located under the %temp%\RGASoft folder of the Windows system. Each
instance of RGASoft has a separate log file. It captures various information output by the
software program, ranging from critical errors to status information. In a normal
operation, users may not be concerned with the log file. However, when a problem is
encountered, the log file may provide some clues to the problem.

System Requirements

The RGASoft program system requirements vary depending on the performance required
of the RGA system, on how many software instances are open, and how many RGA are
connected and run simultaneously. The RGA can scan data at different scan rates that
affect noise floor and averaging.

Following, is the minimum recommended system to run a single RGA system:

e Computer with Microsoft Windows 10 or later
e Mouse or equivalent pointing device
e 200 Mbytes of free hard disk spaces (for RGA installation and runtime use)
e One of the following communication ports and matching cables
e USB port and USB A to USB B cable.
e Serial port (or USB serial port adapter) and DB-9 to DB-9 RS232 cable.
e Ethernet port and Cat-5 cable.
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Getting Started

Note:

For detailed information of the RGASoft program please refer to the RGASoft Online Help files
provided with the program disks. The Online Help includes current and detailed description of all
the features, procedures and commands available in the program.

The following sections describe how to launch the RGASoft program and start acquiring data from the
RGA.

Starting RGA Software

To start the RGA software program simply double-click on the RGASoft icon in the
"SRS RGASoft" program group, or the desktop shortcut created by the RGASoft
installation program. You may also type the full path name of the RGASoft program in
the Run command from the Program manager.

Multiple instances of the RGASoft program can run at the same time. You can start a
new instance via one of the ways described above or select menu File > New Window
from an existing instance.

Connecting to RGA

You can connect to an RGA with either a Serial or an Ethernet connection. The RGA120
family instruments support RS232 and USB ports for a serial connection and an Ethernet
port for an Ethernet connection.

Depending on the type of connection, you would need either an RS232, USB or Ethernet
port on your computer. An DB9-DB9 RS232 cable, USB cable or Ethernet cable is also
required.

To connect to an RGA do the following:

1. Connect either an RS232, USB or LAN cable to the RS232, USB or LAN port on the
RGA.

2. Connect the other end of the cable to the corresponding RS232 port (or serial
adapter), USB or LAN port on the computer.

3. Turn on the RGA.
4. Start MS Windows and the RGASoft program.

5. Upon launching, RGASoft shows the Connections dialog box. Serial connections
such as RS232 and USB are automatically detected and displayed in the table. An
Ethernet connection requires the following one-time setup:

Ethernet Connection Setup: Press the Refresh button to search for the new RGA.
Double-click the table row with status New Device to bring up the Ethernet
Connection Settings dialog box. Enter the RGA credentials to save them on the
computer. The default login/password for an RGA120 Series unit is admin/admin. If
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7.

you don’t see your RGA, it is possible that the RGA Ethernet settings haven’t been
configured to work with your network. Press the Set Up RGA Ethernet button to set
it up first.

Select the COM port or the IP address to which the RGA is connected, and where the
status shows Available.

Press the Connect button.

The connection is made when Connected is displayed in the status column of the
Connections dialog box, and the control panel is enabled.

Acquiring Data

Once connected to an RGA, you can customize the scan settings and collect data from the
RGA. Following steps outline the basic procedure for data acquisition:

1. Use the Scan Settings panel to select the scan mode and configure the scan
parameters. Optionally add more steps to the scan sequence.

2. Configure the scan run trigger (Scan Settings panel > Trigger Setup tab) to customize
how to trigger the scans and how recurring scans should run.

3. Turn on the filament (menu Probe > Turn On Filament).

4. Select the scan run command (menu Scan > Run, or the Run button (» icon)).

Note:

Upon launching, RGASoft provides a single-step Analog scan sequence in a continuous
time-triggered mode. Simply performing step 3 & 4 (without step 1 & 2) would give you
analog mass spectrum data.

Shutting Down RGA System
The recommended shutdown procedure is as follows:

1.

Stop the scan if there is one in progress using menu Scan > Stop Now command or
click the shortcut button (the STOP sign button).

Turn off the filament by selecting menu Probe > Turn Off Filament command.

Save the scan data using menu File > Save As command if it’s not automatically
saved.

Terminate the RGASoft program using menu File > Exit command.

Turn off the RGA.

SRS Residual Gas Analyzer



5-8 Features and Operation

Features and Operation

Note:

For detailed information of the RGASoft program please refer to the RGASoft Online Help
provided with the program. The Online Help includes a detailed description of all the features,
procedures and commands available in the program.

RGASOoft Instance

An RGASoft program instance, visible as a main window, connects to an SRS RGA
operating in one or more scan modes. Multiple program instances can run at the same
time to connect to different RGA units. An instance does not need to be connected to an
RGA at all times. You can open an RGASoft instance to view offline data, export data or
perform composition analysis. An RGASoft main window contains a control panel and
one or more dock widgets, each represents the data of a scan step. A dock widget can be
docked to the main window or stay afloat as a separate window. The control panel is
where you set up the scan steps and control the scan run.

Scan Sequence

RGASoft allows different types of data scan to be configured as a scan sequence. The
scan sequence is made up of one or more scan steps. The steps are executed sequentially
in a scan run. You use the Scan Settings panel to add or remove steps, select a scan mode
for each step, and to configure the parameters for that mode.

Each scan step has a corresponding dock widget to display the data. Depending on the
scan mode of the step, the dock widget may contain different widgets to present the step
scan data. Use the dock widget’s menu (= icon) to access its widgets.

Scan Modes

There are four scan modes and a hardware control mode available. The hardware control
mode can be inserted between scan steps to control the hardware settings. A scan mode
has its own display of the scan data, notably a main plot for the mode. For example, the
Analog scan data is presented on the analog plot, the Histogram scan data is presented on
the bar plot, etc. The main plot along with other complement widgets reside on a dock
widget.

Following are the available modes:

Analog

Analog mode is the spectrum analysis mode common to all Residual Gas Analyzers. In
Analog mode the RGA scans from the Start to the Stop mass using the Points Per AMU
scan parameter. This parameter is used to determine the mass increments between data
points. The time to acquire each intensity value depends on the scan rate selected. On the
analog plot, the X-Axis represents the mass range chosen in the scan parameters. The Y-
AXis represents the ion current amplitudes of every mass increment measured.

In addition to the analog plot to display the data, the dock widget of Analog mode comes
with a Derived Pressure vs. Time (PvsT) plot. This time plot lets you display the partial

pressure of a certain gas mass over a period of time. Its data is extracted from the Analog
spectrum. To show traces on this plot, first, use the dock widget’s menu (= icon) to show
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the Mass table. Then select the gas mass on the Mass table to display its data on the
Derived PvsT plot.

Histogram

Histogram mode displays the individual mass amplitudes for the selected scan range on a
bar plot. In this mode the RGA performs a peak-lock for each mass and calculates one
amplitude per mass. This peak is then plotted as a bar at the appropriate mass. The X-
Axis of the bar plot represents the mass range chosen in the scan parameter. The Y-Axis
represents the ion current amplitudes of every mass measured.

In Histogram mode the RGA scans from the Start to the Stop mass. The peak value
within £0.3AMU of each nominal mass is then sent to RGASoft. This results in one point
per mass being plotted as a bar graph. The time to acquire each intensity value depends
on the scan rate selected.

Similar to Analog mode the dock widget of Histogram mode comes with a Derived
Pressure vs. Time (PvsT) plot. This plot lets you display the partial pressure of a certain
gas mass over a time period. Its data is extracted from the Histogram spectrum. To show
traces on this plot, first, use the dock widget’s menu (= icon) to show the Mass table.
Then select the gas mass on the Mass table to display its data on the Derived PvsT plot.

Pressure vs Time

Unlike Analog and Histogram modes where the scan is performed for the whole mass
spectrum, the Pressure versus Time (PvsT) mode lets you specify individual gas masses
to scan. This results in a faster turnaround of scan data. In this mode, the data is presented
in a time plot. The gas masses, hames, and parameters can be set on the Scan Settings
panel. Each PvsT entry can be configured with its own scan rate.

The Mass table on the dock widget displays the partial pressure of each gas mass at a
given time. When the scan is in progress, the latest data is shown. When viewing offline
data, you can browse any data point on the time axis. Use the dock widget’s menu (=
icon) to show or hide the Mass table.

The PvsT mode also provides Annunciator panels. The Annunciator panels use the same
data as in the PvsT plot and the Mass table. They provide an effective way to visually
monitor gas warning levels from a distance. The panels are grouped as boxes where each
represents a gas and alarm level. The partial pressure value is clearly visible and so is the
gas name. When an alarm level is reached, the panel color changes to a preconfigured
color and the appropriate message is shown. Audible alarm is also available. The panels
can share the dock widget’s space with the PvsT plot and the Mass table, or they can be
resized to take up all the space they need. The alarm settings are configured for each gas
mass from the panel or from the Mass table. You can change the alarm settings before or
after the scan run starts.

Leak Test

Leak Test mode provides the most effective way to study the behavior of a single gas. In
this mode the partial pressure for the specified gas is acquired by querying the RGA for
that specific mass only. The time to acquire each partial pressure depends on the scan rate
selected. This mode supports a time plot that monitors the gas trend over a time period, a
Mass table for instantaneous partial pressure readout, and an Alarm message box. The
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alarm colors and messages are configurable. An audible beep with a pitch proportional to
the partial pressure is also available.

The gas mass, hame, and scan parameters are configured on the Scan Settings panel. The
leak unit can be selected to show as pressure or leak rate (Leak Rate Tuning is required
for the leak rate option).

Hardware Control

Hardware Control is not a scan mode but rather a supporting mode that can be inserted
between scan steps in a scan sequence to make changes to the RGA hardware or to delay
a scan step. For instance, if you want to switch the detector type from one scan step to the
next, you can insert the Hardware Control between the two steps and set the detector type
the same as that of the next scan step. The Hardware Control gives you the option to wait
for the detector to be stabilized before proceeding. Without it, the detector change still
takes place, but the switching may not give the detector enough time to stabilize before a
scan.

Scan Parameters

In a scan sequence, every step has its own set of scan parameters depending on the scan
mode. RGASoft uses the parameters to set up display and to acquire data from the RGA.
An RGA must be connected to configure a scan sequence and parameters. In a scan run,
the parameters are sent to the RGA at the beginning of every scan step if parameter
values change.

To change the scan parameters of a step in the sequence, simply select the step —
represented as an accordion tab — on the Scan Settings panel and modify the parameters.
Press the Apply button on the scan step to update the display. You may skip the Apply
button. Pressing the Run button (» icon) updates the display and starts the scan run in a
single step.

Scan Run Trigger

A run trigger tells RGASoft when to start the next scan cycle. A trigger applies to the
whole scan sequence, not individual scan steps. There are two trigger modes: Time
Triggered and Hardware Triggered mode. As the name implies, the Time Triggered mode
gives you the trigger options based on a time variable, whether continuous or a time
interval. The Hardware Triggered mode provides options to initiate the scan when a
hardware signal is detected. This hardware signal comes from an external device
connected to the RGA’s Trigger port.

To modify a run trigger, locate the Trigger Setup tab on the Scan Settings panel. The run
trigger default setting is Time Triggered, continuous run (the setting appears as Triggered
every 0 second). For Time Triggered mode, if the trigger period is non-zero, make sure it
is longer than the time it takes to run one cycle. Otherwise, the next cycle will start
immediately. For Hardware Triggered mode, select how the hardware signal would cause
a trigger: Low, High, Falling Edge or Rising Edge. Specify the trigger timeout. The scan
run will stop if no trigger is detected when the timeout expires. After a trigger is fired,
you have the option to repeat a specified number of scan cycles before re-arming the
trigger. If you wish to continue scanning after a trigger, specify a large number of scan
cycles to avoid re-arming the trigger.
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Data Acquisition

The terms Data Acquisition and Scanning are used interchangeably in the SRS RGA
documentation. A scan implies that the SRS RGA is performing ion current readings and
sending the data over the RS232, USB or LAN cable to the computer running the
RGASoft. This data is presented on the dock widget that is associated with the current
step of the scan sequence. The data update speed depends on the computer’s resources,
the network condition, the scan settings, etc.

The main procedure for establishing a live scan is outlined below:
1. Turnonthe SRS RGA.

2. Establish a connection between the RGASoft and the RGA unit (menu File >
Connect RGA command or Connection button).

3. Turn on the filament (menu Probe > Turn On Filament command).

4. Select the desired scan mode and parameters on the Scan Settings panel. Optionally
add more scan steps. The default scan sequence is a single-step, Analog mode.

5. Select the scan trigger options (Scan Settings panel > Trigger Setup tab).
6. Select the scan run command (menu Scan > Run or Run button (» icon)).

Scan Data Saving

The scan data is continuously saved to a file while the scan run is in progress. If the data
auto save is enabled (the default setting), the scan data is saved to a file whose name is
created by a preferred format. The available formats are Scan Mode, RGA Serial
Number, or User Defined. If auto save is not enabled, the scan data is saved to a
temporary file. You can perform a save-as on demand later. The data location is specified
under File > Preferences menu.

It is possible to do a save-as while the scan run is in progress. This allows you to save the
on-going scan data to a separate file without stopping the scan. You can then open the file
in another RGASoft instance without interfering with the scan process.

Once the data is displayed on a plot or table, it can be copied to the system clipboard or
exported to a text file. The CSV formatted text can be easily imported into a spreadsheet
program. The plot display can also be exported as an image in a similar way.

Data Display

RGASoft presents data using plots, tables and other widgets. Except for the Hardware
Control mode which does not have any data, each scan step in the scan sequence has a
corresponding dock widget. This section discusses in detail the dock widget and other
graphical user interface (GUI) components that it contains.

Dock Widgets

RGASoft makes use of docking windows, also known as dock widgets, to organize GUI
components. A dock widget can be docked to the main window or can stay afloat as a
modeless dialog box. Each scan step in the scan sequence is associated with a dock

SRS Residual Gas Analyzer



5-12 Features and Operation

widget. Gas Library and Composition Analysis also utilize dock widgets to present the
data. A dock widget contains other widgets such as plots, tables, panels, etc. to display
the data. It provides a menu (= icon) to access its components. Use the horizontal handle
(--... icon) or vertical handle (} icon) to resize the components. Press and hold down the
mouse over the top area of a dock widget and drag it to dock/undock or to move it.

Context Menu

To get to options and actions of a widget such as a plot or a table, context menus are
often used. You invoke a context menu by right-clicking your mouse on the GUI
component. A widget may have different context menus depending on where the mouse
pointer is at the time of selection.

Plots

Plots are widely used in RGASoft to present data. Most of plot options and actions are
available from the plot’s context menu which can be invoked from the plot canvas. The
Customize Plot option from this menu gives you more visual settings to control the plot’s
look and behavior. A new plot would take the default settings from the Preferences (File
menu).

To customize the display of a trace in a time plot use the context menu invoked from the
trace’s legend. The custom settings are saved to the RGA view file (.rgaview). This view
file is paired with the RGA data file (.rgadata) when saved. When you load the
configuration from a file (menu File > Load Configuration), the custom visual settings
will be loaded from the RGA view file.

Each scan mode has a main plot which resides on the top of the dock widget associated
with the scan step. For example, Analog scan comes with an analog plot, PvsT scan
comes with an PvsT plot, etc. The main plot is supplied with a toolbar that holds most
frequently used options and scan browsing controls «=- = «.»_ The plot toolbar can
be shown or hidden from the dock widget’s menu (= icon). When you view offline data,
the scan browsing controls let you navigate to a scan of interest.

Tables
RGASOoft uses tables to provide a snapshot of a data series. A Mass table, an Auxiliary
Signal table or a Composition table (in Composition Analysis) are a few examples.

A Mass table, which is available on a dock widget of a scan step, provides the scan data
of that step in a cycle. In a live scan, a Mass table shows the latest scan data. In an offline
view, you can jump to any scan from the plot and the Mass table is updated with the scan
data. In Analog and Histogram scan mode, the Mass table also gives you the options to
extract the data for the Derived PvsT plot. Simply selecting a gas mass on the Mass table,
you can plot the partial pressure of the gas on the time plot.

An Auxiliary Signal table accompanies a Mass table, displaying data for total pressure,
temperature measurements or 1/O signals. The Auxiliary Signal table resides below the
Mass table and can be accessed via the dock widget’s menu.

Like other GUI components, a table context menu provides options and actions you can
perform on the table data. For example, the Mass table lists the options to export the data
on its context menu while the Auxiliary Signal table provides shortcuts to set up 1/0
signals.
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Annunciators

In PvsT mode, annunciator panels are included on the dock widget along with the PvsT
plot. They can be shown by selecting a show option from the dock widget’s menu or by
simply holding and dragging the horizontal handle (..... icon) separating the plot and the
annunciator container. Annunciator panels give you a large display of gas information.
They are automatically resized and rearranged to make the best use of the space they
occupy. Double-clicking on an annunciator panel would bring up the alarm setup dialog
box. You can set up the alarm before or after starting a scan run. If you don’t see the
annunciator panel for newly added gas, press the Apply button on the scan step
configuration panel to update the display.

Background Data

When setting up a scan step, you have the option to apply background data subtraction to
yield a clean baseline. When the option is enabled, the background data is subtracted
from the newly acquired scans. The background data comes from a data file you collect
when you set up your environment with just the background noise. The background data
and the new scans must have the same spectrum range or same individual gas masses.
The background subtraction option is available in Histogram and PvsT mode.

Setup Procedure

1. Prepare your vacuum system with just the background noise.

2. Setupascan in the target mode. For example, if you intend to do a Histogram scan
later, then configure a Histogram scan now with the same mass range as you would
use later. If doing a PvsT scan, then specify the same set of gas masses.

3. Start the scan run and save data to a file. This is your background data. You can run
as many scans as you would like. The last scan would be used as the background
data.

4. Now, in another scan where you would like to use the background data, go to the
scan step on Scan Settings panel and press the More Options button to show the
options. Check the Enable Background Subtraction checkbox. Make sure the scan
mode is the same as the one you did in step 2.

5. Provide the data file you collect in step 3. Specify how the newly acquired data
would be calculated from the reference, whether the scan data is subtracted from the
reference, or the reference is subtracted from the scan data.

Data Averaging

One of the methods to improve noisy signals is signal averaging. RGASoft supports data
averaging in Analog and Histogram modes. The averaging can be applied directly to the
acquiring data or applied after you collect your data. The latter option lets you try
different averaging functions and settings.

To apply averaging to the acquiring data, on the scan step of the Scan Settings panel,
press the More Options button and check the Enable Data Averaging checkbox. Make
sure the scan step is in either Analog or Histogram mode. Specify the averaging function
and parameters. The collected data will be averaged, and you wouldn’t be able to change
the averaging parameters later.
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When you are not sure what averaging function and parameters are best for your data,
you can collect a small set of scans without applying averaging. Then follow the steps
below to try out different averaging settings.

1. Open the offline data.

2. On the dock widget of an Analog or Histogram scan step, press the menu (= icon)
and select Apply Data Averaging from the dropdown menu.

3. On the Average Setup dialog box, select the averaging function and parameters and
press the OK button. The data will be updated based on your settings. If you want to
reset the data, select None for the averaging function.

I/O Signals

With the RGA120 Series supporting various 1/0 ports from RTD to Analog I/O, you can
interface the RGA with external devices to utilize the I/O signals for a wide range of
applications. Use menu ECU > Set Up 1/0 to set up I/O signals. For input signals,
RGASoft supports RTD, Analog Input Voltage and Current, and GPIO input. These
signals are grouped under the Auxiliary Signal table of the dock widget of each scan step.
Use the dock widget’s menu (= icon) to access the table. Selecting a signal would plot it
on the right Y-Axis of the PvsT time plot. The I/O signal intensities can be displayed
alongside the partial pressure of individual gas masses on the same plot. Their
timestamps are synchronized to give an easy view of the signals.

The Analog Input Voltage/Current values can be mapped to a measurement range in
linear or logarithmic scale so that the actual measurement unit of the connected device is
shown instead of the voltage or the current values. The opposite is also available for
Analog Output signals where an RGA measurement is mapped to a provided range of
output voltage or current.

An addition to input ports on the RGA120 Series is the dedicated Trigger port. This port
gives you the option to trigger a scan based on the connected signal. With the Trigger
port connected, you can configure the scan run trigger with the Hardware Triggered mode
under the Trigger Setup tab of the Scan Settings panel.

Composition Analysis

Mass spectrum analysis takes you one step beyond visual analysis and Gas Library
lookup. Based on your provided gas species, RGASoft applies the Least Squares Fitting
algorithm to approximate the composition of the residual gas. The composition can be
expressed in either pressure units or percentages. The scan spectrum should cover the
highest AMU value of anticipated gases. The analysis can be done with both live scan
data and offline data.

Analysis Procedure
This procedure can be done before, in the middle, or after a scan run. If you work with
live scan data, do it before starting a scan run so that you wouldn’t lose any analysis data.

1. On adock widget that associated with an Analog or a Histogram scan step, click on
the menu (= icon) and select Show Scan Analysis from the dropdown menu. An
Analysis dock widget is opened. It’s linked to the dock widget of the scan spectrum.
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2. On the Analysis dock widget, click the menu (= icon) to select the Select Gases for
Analysis option from the dropdown menu. You can also use the composition table’s
context menu to choose the same command (the composition table is located on the
top right corner of the dock widget).

3. On the pop-up dialog box, check the checkbox for the gases or gas mixtures you
would expect from your vacuum system. This gas list is populated from the gas
library file. For better fitting calculation, select only the gases that have the mass
spectrum covered by your scan spectrum. Press the OK button to add the gas list to
the composition table.

4. Optional — If you want to capture the gas composition data in a text file, press the
Log Save button to show the save settings. Provide the information for data auto-
save.

5. On the Scan Data group box, check the Auto Update with Live Scans checkbox if you
work with live scan data. The live scan data will be imported at the end of the scan
step. If you perform the analysis with offline data, press the Select Scans button to
bring up the scan selection dialog box. On this dialog box, select a single or multiple
scans to import.

Once the scan spectrum is imported, either with a live scan update or with manual scan
selection, the Analysis plot will display the best fit of the scan spectrum and the provided
gases. Use the plot’s context menu to access different options. To change the bar color of
a gas, use the context menu of the composition table.

The composition table shows the partial pressure of each gas and its composition as a
percentage. Note that the partial pressure value of a gas is the same as the intensity of the
principal mass. Double-clicking on a gas name would bring up a panel showing the gas’
fragmentation pattern in a table. The Edit Gas command on the composition table’s
context menu gives you the option to edit the attributes of a gas. The Gas Editor dialog
box invoked from this command saves the gas attributes directly to the Gas Library file.
Use the reload button (< icon) below the composition table to reload the gas list from the
library file.

In addition to the Analysis plot which presents the composition per mass spectrum, the
Composition vs Time plot displays the composition over a time period. Use the Analysis
dock widget’s menu (= icon) item Show Composition vs Time Plot to show this plot. You
navigate this plot the same way you do with other time plots. Use the plot’s context menu
to change the display of the Y-Axis as a pressure unit or as a percentage.

Preferences

The menu File > Preferences gives access to the Preferences dialog box where you can
set default options for various settings. The display options serve as the default settings
for a new GUI component. You often can customize local settings for each component
independently. The Alarms and Data options are global settings. For example, if you
change the pressure unit, data of all scan steps will be shown in the new unit. The
Preferences menu item is enabled only when the system is idle.
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Utilities
Note:
For detailed information of the RGASoft program please refer to the RGASoft Online Help

provided with the program. The Online Help includes a detailed description of all the features,
procedures and commands available in the program.

Gas Library

A Gas Library lets you find a chemical species and view its fragmentation pattern in the
tabular or graphical representation. Select menu Utilities > Gas Library to open the Gas
Library dock widget. Deselect the option to close it. The content of the Gas Library is
read from the library file specified under the Preferences (menu File > Preferences > Data
> Gas Library).

Mass Spectrum View

On the Gas Library dock widget, simply selecting a gas to display its mass spectrum on a
bar chart. The fragmentation factors as percentages are shown in the fragment table. Note
that the intensities are normalized to the principal mass (a mass with highest intensity). In
the Normalized display mode, the principal mass carries a value of 1.0 on the bar chart
and 100.0% in the fragment table. If you have a reference partial pressure of a gas, you
can display the intensities of the gas masses in the pressure unit. Use the Reference
Partial Pressure display mode in this case.

Gas Search

The Gas Library supports searching of a chemical species by its name or chemical
formula. Simply provide a name or a chemical formula in the search box and press the
Search button to perform a search. Note that formula is an optional attribute of a gas item
therefore it may be empty as in the case of a gas mixture.

In addition to searching by name, you can also search for gas candidates based on a list of
masses. The advanced mass search provides a further option by searching only the major
peaks for gas candidates. This option helps to narrow down candidates when you are
more interested in the gas’ major peaks.

Gas Library Editor

RGASoft comes with a default gas library. The library data file is listed under the
Preferences (menu File > Preferences > Data > Gas Library). The Gas Library Editor is
provided as a tool to edit the content of this file. You can build your own version of the
library by modifying an existing gas, or import a mass spectrum either from an RGA data
file (*.rgadata) or from a NIST Chemistry WebBook JCAMP-DX file (*.jdx). To open
the library editor, select menu Utilities > Edit Gas Library. The editor is a modeless
dialog box. Upon opening, it reads the library data file and loads its content.

Modifying a Gas
A gas is identified by its name. You should keep the name unique.

1. Double-click a gas or gas mixture listed in the table to bring up the individual Gas
Editor dialog box where you can modify the mass spectrum and gas attributes.
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2.

When done editing on the Gas Editor dialog box, press the OK button to accept the
changes.

On the library editor, press the Save button to save the library content back to the
data file. If you want to save the library as a different file, press the Save As button
and provide a file name. You must later specify the new file under Preferences to
use it.

Importing from JCAMP-DX File

Suppose you have downloaded a .jdx file containing a chemical species with the mass
spectrum from NIST Chemistry WebBook, follow steps below to import the gas:

1.

2.

On the library editor, press the Import button.
On the file dialog box, select the JCAMP-DX (*.jdx) file filter.

Locate your directory and select one or more .jdx files. Press the Open button to
import.

Press the Save button to save the library content back to the data file or press the
Save As button to save it to a different file.

Importing from RGA Data File

Suppose you have collected either an Analog scan or a Histogram scan and saved it to an
RGA data file (.rgadata). Follow steps below to import the mass spectrum:

1.

2.

On the library editor, press the Import button.
On the file dialog box, select the RGA Data File (*.rgadata) file filter.

Locate your data directory and select the .rgadata file. Press the Open button to
start the import process.

An import dialog box is shown detailing the content of the data file. On this dialog
box, you can select a particular scan to extract the data. Other options include the
mass range and the peak threshold value. A data point with an intensity equal to or
above the threshold is considered a peak.

Press the Extract button (» icon) to extract the mass spectrum. Adjust the gas
masses and intensities if necessary.

Provide the name and other attributes for the gas. Press the Import button to import
the gas to the gas library.

On the library editor, press the Save button to save the library content back to the
data file or press the Save As button to save it to a different file.

Common Gases Editor

Common gases refer to a set of gas molecules frequently present in your vacuum system
or ones that you are most interested in. You can label the common gases on an analog or
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histogram plot to have a quick view of the gases present in your system. The Common
Gases Editor allows you to edit the list of the gases that more relevant to your
environment.

To open the editor dialog box, select menu Utilities > Edit Common Gases. The editor
allows you to modify a gas item, add a new one or remove an irrelevant one. A gas item
consists of a gas name and an associated mass.

Once done editing, press the OK button to save the list. The list is stored in the system
registry and recalled when you launch the software.

Audible Alarm

The audible alarm option allows you to enable the audio for the alarm when it’s triggered
in PvsT or Leak Test mode. In the PvsT mode, the audio file specified in the Preferences
(menu File > Preferences > Alarms > Wave File) is played. In the Leak Test mode, the
alarm uses the system beep with a varied pitch and rate depending on the signal strength.
Select menu Utilities > Enable Audible Alarm to turn on the sound. Deselect the option to
turn it off.

Ethernet Setup Tools

A new RGA120 Series unit must have its Ethernet settings correctly configured to be
used in a network environment. The Ethernet Setup Tools facilitate the configuration

tasks.
i RGA/REA Ethernet Setup Tools X
f_:'\ Search SetUpIP... Modify Login... | | Test Connection...
Name S/N MAC IP Subnet  Gateway Status Device |*
REA 4 00:19:b3:04:2... | 172.25.40.... | 255.255.... | 172.25.0.1 Occupied REA
REA 3 00:19:b3:04:2... | 172.25.40.... | 255.255.... | 172.25.0.1 Occupied REA

RGA120 12012345 00:19:b3:0e... 172.25.7... 255.25... 172.25... ReadyforSetup RGA320
1 »

Local Computer: IP Address [ Subnet Mask [ Gateway
172,25.70.124  255,255.0.0 f 172.25.0.1

& Connect RGA... Close

Figure 5-1 Ethernet Setup Tools Dialog Box

IP Address Setup
To set up a new IP address for the RGA, follow the steps below:

1. Keep the RGA powered off.
2. Connect the RGA to the local area network (LAN) with an Ethernet cable.

3. Get the RGA in the Setup state by detaching the probe from the Electronic Control
Unit (ECU) then power up the ECU. It is important to power up the ECU without
the probe plugged in.

4. Open the Ethernet Setup Tools dialog box from menu Utilities > Set Up RGA
Ethernet. Upon opening the dialog box, the software program broadcasts a status
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request to all RGA units on the LAN. Reachable units are displayed in the table as
illustrated in Figure 5-1. The units which are in the Setup state are shown with the
status Ready for Setup. If the Ethernet Setup Tools dialog box is opened before step
3, press the Search button to find your device.

5. Select your RGA unit in the table and press the Set Up IP button. Make sure its status
is labeled Ready for Setup. Use the serial number to identify the unit if necessary.

6. On the IP Setup dialog box (Figure 5-2), select either to use a static IP address or to
obtain a dynamic IP address (DHCP). If you choose to use a static IP address,
provide the IP address, subnet mask and the gateway information. Check the Reset
Username/Password checkbox if you wish to reset the username and password to the
defaults. If you choose to obtain an IP address automatically, make sure a DHCP
server is running in your network.

& IP Setup 4

# Obtain an 1P Address Automatically (DHCP)

Use Static IP Address

DHCP [s successiil.

Close Apply

Figure 5-2 IP Setup Dialog Box

7. Press the Apply button on the IP Setup dialog box to send the request to the RGA.
Progress messages are displayed near the bottom of the dialog box to tell you when
the configuration is complete.

8. Press the Close button to close the IP Setup dialog box. The table in the Ethernet
Setup Tools dialog box will refresh to show the updated status for the RGA. An RGA
is ready when its status is either Available or Available (DHCP).

Modify Login

An RGA’s login credentials, or its name can be modified once its IP address is
successfully set up. To change a unit’s login information, follow steps below:

1. Select an RGA on the Ethernet Setup Tools dialog box (Figure 5-21) with the status
Available or Available (DHCP), then press the Modify Login button.

2. On the popup Modify Login dialog box (Figure 5-3), provide the RGA’s current login
credentials and press the Login button to log in. The default username and password
are admin/admin.
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3. After successfully logged in, provide a new name or a new username/password under
the Device Settings group. The device name is limited to 15-character long for the
RGA120 Series.

4. Press the Apply button to send the request to the RGA. The device settings will be
refreshed with the updated values.

5. Press the Close button when done.

5 Madify Login (172.25.70.5) *

Usemame Password

admin sanns Login

Cose

Figure 5-3 Modify Login Dialog Box
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RGA Calibration

Note:

For detailed information of the RGASoft program please refer to the RGASoft Online Help
provided with the program. The Online Help includes current and detailed description of all the
features, procedures and commands available in the program.

WARNING!

The sensitivity tuning procedure should be performed by qualified personnel only. A mistuned
RGA could give erroneous readings until it is retuned properly.

Please refer to the RGA Tuning Chapter for more information about tuning and calibration.

Sensitivity Tuning

To set the sensitivity factors of the RGA you must have a reference pressure gauge
installed on your vacuum system. There are two sensitivity factors, one for total pressure
and one for partial pressure. Both factors are stored in non-volatile memory of the
RGA’s ECU. Follow the procedure below for sensitivity factor tuning.

Note:
While performing the tuning procedure the total pressure in the vacuum chamber should
be around 10° Torr.

Tuning Procedure

1.

2.

Select menu Probe > Sensitivity Tuning.

Select which sensitivity factor you would like to adjust from the Measurement Mode
section (Partial Pressure or Total Pressure).

3. If you select Partial Pressure, then enter the mass whose pressure you will be
measuring in the Mass edit box.

4. Enter the pressure indicated by your pressure gauge in the Reference Pressure edit
box.

5. Press the Measure button. The Sensitivity Factor section will update the ion current
reading from the RGA, and the calculated sensitivity factor.

6. Press the Save button to save the new factor to the RGA.

CEM Tuning

When Channel Electron Multiplier (CEM) is specified as the detector in a scan run, the
RGASoft program takes into account the CEM gain to calculate the signal intensity. To
find the required high voltage for a desired gain (or vice versa), CEM Tuning is needed.

To adjust the CEM gain, there must be a partial pressure reading detectable by the
Faraday cup at the Reference mass. The signal at the Reference mass must be large

SRS Residual Gas Analyzer



5-22 RGA Calibration

enough to detect with the Faraday cup, but not so large that the CEM signal is saturated.
The readings from the two detectors are compared to establish the desired gain.

Tuning Procedure

1. Select menu Probe > CEM Tuning.

2. Select the setting option:

e Set Gain: set your desired gain and the program will search the required high
voltage for the gain. This procedure usually takes longer than the Set Voltage
option.

e Set Voltage: set your desired high voltage and the program will calculate the
corresponding gain.

3. Specify the desired value on either the Gain or the Voltage edit box based on the
option in the previous step.

4. Specify the gas mass on the Reference Mass edit box.

5. Press the Start Tuning button. The program will perform a series of ion current
readings with Faraday cup and CEM as the detector and find the gain and high
voltage values.

6. Press the Save & Close button after the tuning complete to save the values to the
RGA. Press the Cancel button to close the dialog box without saving.

Peak Tuning

Peak Tuning allows the user to calibrate the mass scale and the resolution, A mig, Of the
mass spectrometer. The procedure requires a mixture of gases whose mass spectra is well
known. There are two tuning modes: manual tuning and auto tuning. In the manual tuning
mode, a two-gas mixture, one with low mass peaks and one with high mass peaks, is
sufficient. The auto tuning mode supports up to 10 mass peaks.

Auto Tuning Procedure

The auto peak tuning works by gradually fitting the mass peak to the center of a target
mass with the specified peak width. A peak should not drift too far from its target mass
before the tuning. The auto tune is more successful if the peak is within +/- 1.5 AMU of
the target mass. It supports up to 10 mass peaks. You can run the scan continuously or
one at a time until you are satisfied with the tuning results. The procedure is as follows:

1. Select menu Probe > Peak Tuning.

2. Select Auto option under the Tuning Mode.

3. On Target Mass Peaks table, provide 2 to 10 gas masses that you know have
noticeable signals.

Requirements: A mass must be in the range of 12-200 AMU. Mass values must be at
least 2-AMU apart.
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Specify the peak width at FWHM (the width of the spectrum curve at half of its
maximum amplitude). A value of 0.6 AMU is equivalent to a width of 1 AMU at
10% of maximum amplitude (A mio).

Optionally specify the scan rate.

Start the scan run and observe the peak at the specified masses. At the end of each
scan cycle, the peak positions and widths are displayed on the Analog plot. You can
pause the scan run to have more time to review the tuning results.

When you are satisfied with the tuning results, stop the scan run and close the Peak
Tuning to save the tuning parameters to the RGA. To revert the tuning parameters to
the original values (the values before entering the Peak Tuning), press the Reset
button.

Manual Tuning Procedure

The manual peak tuning requires a low and high mass gas mixture. You basically observe
how each mass peak looks and manually adjust the position and the width of the peak.
The procedure for RGA120 Series is as follows:

1.

2.

Select menu Probe > Peak Tuning.
Select Manual option under the Tuning Mode.

Provide the low and high mass of the gas mixture that was introduced in the vacuum.
Optionally specify the scan rate.

Start a scan run to see where the peaks are positioned and how wide they are. Mass
spectra will be shown on the Low and High Mass Analog Scan plots.

Adjust the position of the Low Mass and High Mass peak if the peak does not fall
exactly at its required mass. Also, adjust the width of the mass peaks so that the full
width at 10% of its maximum amplitude is less than or equal to 1 AMU (A myoe= 1
AMU). Start a scan run.

Repeat step 5 as needed. If you’re satisfied with the results, close the Peak Tuning.
To revert tuning parameters to the initial settings (the values before entering the Peak
Tuning), press the Reset button.

Leak Rate Tuning

Leak rate tuning is required for the RGASoft program to properly display leak rates in the
Leak Test mode. The leak rate factor is computed by measuring the partial pressure of a
gas from a calibrated leak and calculating the effective pumping speed of the system
based on the known leak rate.

Follow steps below for the tuning procedure:

1.

Select menu Probe > Leak Rate Tuning.
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Enter the known leak rate in the Reference Leak Rate edit box. The value is in units
of Torr*Liter/Second.

Enter the gas mass whose pressure you will be measuring.

Press the Measure button to perform pressure reading from the RGA. The partial
pressure reading along with the calculated leak rate factor are shown in the Leak Rate
Factor field.

Press the OK button to accept the value. The value is stored in the system registry
and the data file. Since it is not stored in the non-volatile memory of the RGA, you
need to tune the leak rate for different RGA units.

Electronics Calibration

There are various procedures to calibrate different components of RGA electronics.
Follow the steps below to perform electronics calibration:

1.

2.

Select menu ECU > Calibrate Electronics.
Make sure the checkbox for the procedure you want to run is checked.

Press the Calibrate button to start. The status for each selected procedure will cycle

through Pending — In Progress — Complete. Some procedures may take longer than
others.

Close the dialog box when all the procedures are finished. If a procedure failed, the
RGA would report a Procedure_Fail error, and a Failed status will be displayed for
that procedure.

RGASoft Online Help

The RGASoft Online Help contains detailed information on operations of the program that may not be
covered in this manual. Use the Online Help to get up to date detailed information on the RGASoft
program. The following sections describe the different ways to use RGASoft Online Help.

Context Sensitive Help

Context Sensitive Help provides a quick and direct way to display information on a
specific topic. Make sure the GUI component has the mouse focus. Press F1 key to
launch the Help Browser. The help topic of the component in focus will be shown. If the
Help Browser is already open, changing the mouse focus on the RGASoft program will
switch the help topic to the component that has the focus if the help topic is available.

Help Search

You may search the RGASoft Online Help for any topic or keyword. Once you have the
Help Browser open, select menu View > Search or click on the Search tab to show the
Help Search. Enter any keyword to display that topic.
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Help Index

The Help Browser’s Index displays a comprehensive index to information contained in
the RGASoft Online Help. Once you have the Help Browser open, select menu View >
Index or click on the Index tab to show the Help Index. Double-click on a topic to view
it. You can also search for a topic on the index list.
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Chapter 6

Remote Commands

This chapter describes how to control and configure the RGA head from a host computer using the
remote commands over remote communication interfaces.

In This Chapter
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Introduction

The functionality of the RGA is accessed by sending and receiving data over a remote
communications interface. The RGA comes standard with an RS232 communications
port, a USB communications port, and an Ethernet port. A host computer interfaced to
the RGA can configure, calibrate, diagnose and operate the quadrupole mass
spectrometer and other components using ASCII commands. The RGA executes the
commands in the order received and, when information is requested, data is returned to
the computer for analysis and display.

The command set detailed in this chapter describes how to interface with all the features
available from the RGA.

External Interface

RS-232 Interface

The RS232 interface connector of the RGA is a standard 9 pin, type D, female connector
configured as a DCE (transmit on pin 3, receive on pin 2) with full RTS/CTS
handshaking enabled. The CTS signal (pin 8) is an output indicating that the RGA is
ready, while the RTS signal (pin 7) is an input that is used by the host computer to
control the RGA's data transmission.

The default communications parameters are set to:

28800 baud
8 data bits
1 stop bit
no parity

This is provided for legacy device support where user software may expect to
communicate with the RGA over 28.8k baud.

Cable Connection

Use a straight through RS232 cable with 9-pin, type D connectors to connect the host
computer to the RGA. A DB9 to DB25 adapter will be needed if the host computer
has a 25 pin type D connector.

USB Interface

The USB interface on the RGA is a type B USB connector. The connection is compatible
with USB2.0 Full Speed protocol. Connecting a host computer to the RGA with a USB
cable will show the RGA as a USB Serial Device.

SRS Residual Gas Analyzer



6-10 LED Indicators

The default communications parameters are set to:

115200 baud
8 data bits

1 stop bit

no parity

Important

To use the USB Serial Interface, the host computer should have all required drivers
installed before communication is attempted. See Appendix x for more information on
how to install USB Serial drivers.

Ethernet Interface

The RGA comes standard with an RJ-45 network communications port located on the
rear panel. The port may be used to communicate with the RGA over a 10/100 Base-T
Ethernet connected network or LAN. Before connecting the RGA to your LAN, check
with your network administrator for the proper method of configuration of networked

instruments on your network.

By default, when the RGA is powered up and an Ethernet cable is connected, the RGA
will use DHCP to search for a DHCP server to request for an IP address. If there is no
DHCP server available, you will need to set up the RGA Ethernet IP address manually
through a serial interface, or through the RGASoft Application.

Network Security

Network security is an important consideration for all TCP/IP networks. Please bear
in mind that the RGA does NOT provide security controls, such as encryption, for
controlling access to the RGA. If such controls are needed, you must provide it at a
higher level on your network. This might be achieved, for example, by setting up a
firewall and operating the RGA behind it.

LED Indicators

To assist in programming, the RGA has two status LEDs on the rear panel.

e COM Act: The activity indicator will flash whenever a character is received or
transmitted over any of the interfaces.

e COM Err: The error indicator will flash momentarily when a command or
execution error has been detected.
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SCPI Command Language

The RGA uses the SCPI (Standard Commands for Programmable Instruments) language
for controlling the instrument over a remote interface. The SCPI language is an ASCII
based command language that organizes functions into a hierarchical tree of commands
with branches of the tree separated by colons.

SubSystems

The base or root of the tree represents a subsystem of the instrument. Each succeeding
branch of the tree subdivides the subsystem into related categories of functionality. The
final branch of the tree identifies a command related to the subsystem that can be
executed by the RGA120. This structure facilitates understanding of the functions carried
out by commands. As an example, consider the subset of the STATus subsystem shown
below.

STATus:

GLOBal?

GLOBal:
SERVicemask (?)
TEXT?

CONDition?

CONDition:
ASSERT
TEXT?

EVent?

EVent:
ENable (?)
TEXT?

DEFaultmask

STATus is asubsystem of the RGA and it is at the root of the tree. At the next level
down, the STATus subsystem is divided into multiple branches. Each of these
categories can then be further subdivided into more branches. However, because of the
hierarchical structure of the language, we can infer that the commands listed under the
Global branch refer to global status register, while those listed under CONDition refer
to condition status registers. Thus, the hierarchical structure of the commands aids the
user in interpreting the scope of execution carried out by the individual commands.

Understanding Command Syntax

SCPI commands often take one or more parameters which modify or identify the
numerical value a variable should take. Some parameters are required. Others may be
optional. Furthermore, the data types for each parameter may differ. Thus, for brevity, we
need a set of conventions for defining commands which clearly identifies all the valid
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variations of the command without having the list each possibility separately. These
conventions are set forth here.

Three example commands are illustrated below:

FILament:EMISsion <milliAmps>
ANAlog:0UTput:VOUT:SELection:MIN <selection>, <value>
ION:VOLT {<voltage>|DEFault |MINimum|MAXimum}

Keyword Case

Keywords are defined with a mixture of upper-case and lower-case letters. The upper-
case letters indicate the short or abbreviated version of the keyword. The user may send
either the short version or the entire long version of the keyword in their programs. The
case of the letters sent to the RGA does not matter. It is only used here to succinctly
identify the two versions of the keyword. Thus, FILament, filament, and Fil are
all acceptable forms of the keyword. Other forms, such as FILA, or FILAM, are not.
Given the definition above, the following commands are all identical:

e FIL:EMIS 1
e FILAMENT:EMISSION 1
e ANA:0OUT:VOUT:SEL:MIN 1, 1.0

Punctuation Used in Definitions

The following punctuation is used to identify variations and options for the command:

. Braces ( { }) enclose different parameter choices. The braces, themselves, are
not sent with the command

. A vertical bar (| ) separates alternative parameter choices for the command. In
the third example above, the choices are a <voltage> or one of the
keywords:DEFault, MINimum, or MAXimum. The vertical bar is not sent with
the command. Thus, one could set the ion energy to the default by sending the
following command:

ION:VOLT DEF

. Triangle brackets ( < >) indicate that you must specify a numerical value. In the
example above, <voltage> would be specified as a number. The triangle brackets
are not sent with the command. Thus, one could set the ion energy using the
following command:

ION:VOLT 12
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Examples

Putting it all together, all of the following commands are valid given the example
definitions presented above.

ANALOG:0UT:VOUT:SELECTION:MINIMUM 1, le-4
FIL:EMIS 0.1

ANALOG:0UT:VOUT:SEL:MINIMUM 2, 0.4
Analog:0Out:Vout:Sel:Min 0, -2.0

Queries

Command queries are usually formed by appending a question mark ( ? ) to the
command. To query the measured filament emission current we use the following
command:

FILament:EMISsion?

Separators

As mentioned above, a colon ( : ) separates the different keywords that make up a
command. If a command takes a parameter, a space MUST separate the last keyword of a
command and the first parameter of that command. If a command takes multiple
parameters, they are separated from each other with a comma (, ). Finally, a semicolon (
;) is used to separate multiple commands on the same line. If the following command is
in the same subsystem as the preceding command then the subsystem is not repeated for
the second command. Otherwise the command must be fully specified and preceded by a
colon. Given the example command tree presented in section SubSystems above, the
following commands are valid:

STAT:EV:EN 1, 256; TEXT? 1
STAT:COND? 2, 1; :FIL:EMIS?

In the first line, both ENable and TEXT are in the same subsystem, STATus:EVent, so
that portion of the command is omitted for the TEXT? query. However, in the second set,
the two command queries are in different subsystems, so the filament emission current
query is preceded by a colon and fully specified on the command line.

When multiple queries, separated by semicolons, are made in a single command line, the
responses from the individual queries are separated by a semicolon as well.

Parameter Types
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The SCPI language supports several different data types for use with command
parameters.

Numeric Values

Parameters that take numeric values accept all common decimal representations of
numbers, including optional signs, decimal points, or scientific notation. Hexadecimal
values specified with a prefix of Ox prefix as used in the C language are also accepted. If
only certain values are allowed, numeric entries will be rounded to the nearest allowed
value. The following examples are all valid numeric entries:

100
-123.456
+1.23456e2
-.456

0x64

The last example, 0x64, is the hexadecimal representation for the decimal number 100.

Many commands that take numeric parameters will also accept the keywords MINimum,
MAXimum, Ofr DEFault to set the parameter to the requested value for that parameter.

Discrete Parameters

Some parameters take one of a small list of allowed keywords. In addition to numeric
value parameters, some commands define a set of keywords that can be used in place of
numeric values. These keywords may help readability or reduce confusion when entering
the command interactively or when reviewing commands used in an execution script.

Consider the following command definitions:

IOUTput:ENable <OFF | ON | O | 1>
IOUTput:ENable?

When using the set command, TOUT : EN, any one of the following arguments may be
used for the command: OFF, ON, 0, 1. The case of the keyword is ignored. Uppercase
and lowercase are allowed.

For query commands, numeric values are always returned.

String Parameters

Quoted string parameters allow one to send almost any sequence of characters, including
characters that are normally reserved as separator characters, such as a comma,
semicolon, or colon. The string must begin and end with the same quote character: either
a single quote, or a double quote. The quote delimiter may itself be included in the string
if it is typed twice without any characters in between.
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Command Termination

Commands should be terminated with a carriage return <CR>. An optional line feed
<LF> can precede or follow the carriage return <CR>, however, the line feed <LF> will
be ignored. As previously noted, multiple commands may be sent in a single line if they
are separated by a semicolon ( ;). Commands are executed in the order received and
execution commences once the command separator or terminator is received.

Remote Command Set

Calibration Commands

INITialize<0]|1]|2>
Initialize the RGA to a known state.
Three different levels of initialization are provided.
Command execution times vary depending on the pre-existing ionizer conditions.
INIT O:Initialize communications and check ECU hardware.

The input and output data buffers are emptied (all communications are disabled while
this happens)

INIT 1: Reset the RGA to default settings

In addition to INIT 0, the RGA ionizer and scan settings are reprogrammed to its
default (preferred) values:

Total Pressure measurement is enabled

Default parameter settings are selected for:
SCAN:MASS:INITIAL 1
SCAN:MASS:FINAL MAX
SCAN:RESolution 20
SCAN:RATE 8.0
IONIZER:ION:VOLT 12

IONIZER:ELECTRON:VOLT 70
IONIZER:FOCUS:VOLT 90

The filament electron emission setting is left unmodified and the ionizer is biased to
default voltages if necessary.

INIT 2: Activate Standby Mode
In addition to the changes in INIT 1, the filament and CEM are turned off.

IONIZER:EMISSION O
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CEM:VOLT 0

CALIBRATE
CALIBRATE <integer >

This command will perform a calibration of one or more subsystems of the RGA
instrument.

If an integer argument is provided, one of the following internal calibrations will be
performed:

Repeller Offset

Grid Offset

Analog Scan High Mass Offset
RF Phase Tracker

Low Mass RF Frequency

lon Detector Offset

RF Detector Offset

Table 6-1 Arguments of the CALIBRATE command

N[OOI WIN(F-

If no argument is provided, each of the calibration steps will be performed in turn. If any
calibration fails, a status bit will indicate that an error occurred and further calibration
steps will not be performed.

Command execution times vary depending on the pre-existing ionizer conditions.

The full calibration is performed when the instrument is first powered on.

ELECtrometer:CALibrate

This command will perform an immediate calibration of the RGA electrometer using an
internal precious current source. The result of the calibration will be saved for use in
future scans.

The user can use this command to perform a single calibration and then a series of fast
scans with low time pre-scan overhead with the automatic electrometer calibration
disabled.

ELECtrometer:CALibrate:AUTO <0 ]| 1| OFF | ON >

Allowed values: 0, OFF — Disables electrometer calibration per scan
1, ON - Enables electrometer calibration per scan
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Before any analog or histogram scan, the RGA instrument can be set to calibrate the
electrometer using an internal precision current source. This calibration is part of the
overhead at the start of each scan.

The user can reduce the overhead time prior to each scan by disabling the automatic
calibration using this command. However, the electrometer response may drift after time
due to temperature or other changes.

ELECtrometer:CALibrate:AUTO?

Returns whether the instrument will perform an automatic electrometer calibration before
each scan.

0 — Per scan electrometer calibration disabled
1 — Per scan electrometer calibration enabled

lonizer Setting Commands

IONIZER:ELECTRON:VOLT <integer | DEFault>

Allowed values: 25 — 110 eV, DEFault = 70 eV

Set the Electron Impact lonization Energy of the lonizer. The parameter represents the
desired electron ionization energy in units of eV.

If the filament is emitting electrons at the time the command is invoked, the repeller
voltage is immediately reconfigured to provide the desired electron energy, while the ion
energy and electron emission currents remain unaffected.

If the filament is off, the new electron energy is stored in memory for the next time the
filament’s emission is activated.

Note: The instrument can be configured to set the repeller voltage when the filament is
off by changing the lonizer Potentials Auto mode to OFF. See
IONIZER:POTENTIALSs : AUTOmode for more information.

Note: The Electron Impact lonization Energy is set to the default value when the unit is
turned on.

IONIZER:ELECTRON:VOLT?

The electron energy parameter setting is returned in units of eV.

IONIZER:EMISsion <floating point value in mA | DEFault | OFF>

Allowed values: 0, 0.01 — 4.0 mA, DEFault =1 mA, OFF =0 mA
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Set the electron emission current level in the ionizer. The parameter represents the
desired electron emission current in units of mA.

When a value other than 0 is entered, the instrument biases the ionizer’s repeller, grid,
and focus plate, and activates the filament’s heater until the requested electron current is
established.

For a value of 0, the instrument turns off the filament and grounds the ionizer’s repeller,
grid, and focus plate.

Command execution times vary depending on the pre-existing ionizer conditions. The
instrument will buffer any subsequent commands until the filament emission target is
reached or an error has occurred. In the event of an error, the filament will be shut off,
and an instrument status bit will be set to indicate the nature of the error.

The Filament LED reflects the ionizer’s energized status at all times. When off, the
filament is de-energized. When lit, the filament is energized. The filament may not be
emitting electrons even when the LED is lit.

Note: The instrument can be configured to maintain voltage potentials on the repeller,
grid, and focus plate when the filament is off by changing the lonizer Potentials Auto
mode to OFF. See TONIZER: POTENTIALs : AUTOmode for more information.

Note on filament emission errors

The RGA internally monitors the state of the filament to protect the instrument from
over-pressure conditions. When the filament starts from a deenergized state, the filament
may fail to start heating because the RGA has detected an over-pressure event. If the total
pressure is within acceptable limits when this occurs, try to energize the filament once
again.

IONIZER:EMISsion?
Returns the setpoint of electron emission current requested in mA.

To return a reading of the measured electron emission current, use the command
FILament:EMISsion?

IONIZER:EMISsion:STORED <value in milliamps>

Allowed values: 0.01to 4.0

Store a value of ionizer electron emission current in non-volatile memory in the RGA.
The parameter is expressed in milliamps. The stored voltage value is helpful to reference
a filament emission current for a later time.

Note: The emission current stored by this command is not used directly by the RGA. This
value is used for storage for later retrieval by a controlling host computer.

SRS Residual Gas Analyzer



Remote Command Set 6-19

IONIZER:EMISsion:STORED?

Returns the ionizer electron emission current value stored in non-volatile memory in the
RGA. This can be used by a controlling host computer to retrieve previous settings at a
later time.

IONIZER:FOCUS:VOLT <volts | DEFault>
Valid values: 0 - 110 V. DEFault = 90 Volts

Set the focus plate bias voltage in the ionizer. The value represents the magnitude of the
bias voltage (negative) in Volts. Although the valid values of this command are positive
values, they represent negative bias voltages applied to the focus plate.

The ions formed inside the anode grid are extracted into the quadrupole mass filter by the
negative attractive potential of the "Focus" or Extraction Plate. The plate serves the dual
purpose of drawing the ions away from the anode grid, and containing the ionizing
electrons inside the source. Electron leakage into the filter is only detectable at low mass
settings (1 to 10 amu) and can be easily eliminated by biasing the focus plate at least 30V
more negative than the repeller.

Careful adjustment of the voltage results in optimum coupling of the ion bean into the
QMF and maximum sensitivity.

This potential is applied only when the filament is energized. If the filament is on, the
new setting will be applied immediately. If the filament is off, the focus plate potential,
along with repeller and grid anode, will remain near 0 V. The new potential value will be
applied when the filament is once again energized.

Note: The instrument can be configured to set the focus plate voltage when the filament
is off by changing the lonizer Potentials Auto mode to OFF. See
IONIZER:POTENTIALs : AUTOmode for more information.

Note: The Focus Plate bias voltage is set to the default value when the RGA is powered
on.

IONIZER:FOCUS:VOLT?

This will return the requested focus plate bias setting in units of Volts.

IONIZER:ION:VOLT <value in volts | DEFault | LOw | HIgh>
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Valid values: 4 - 16 V. DEFault =12V, LOw =8 V, High=12 V.
Set the lon Energy in electron-volts. This is equal to the anode grid voltage.

This potential is applied only when the filament is energized. If the filament is on, the
new setting will be applied immediately. If the filament is off, the anode grid potential,
along with repeller and focus plate, will remain near 0 V. The new potential value will be
applied when the filament is once again energized.

Note: The instrument can be configured to set the focus plate voltage when the filament
is off by changing the lonizer Potentials Auto mode to OFF. See
IONIZER: POTENTIALs: AUTOmode for more information.

Note: The lon Energy is set to the default value when the RGA is powered on.

IONIZER:ION:VOLT?

This will return the requested ion energy setting in eV.

IONIZER:POTENTIALs:AUTOmode <0 | 1 | OFF | ON | DEFault >

During normal operation, when the filament is off, the ionizer potentials are
automatically grounded. The repeller, grid, and focus plate voltages are brought down to
near ground potential. When the filament is turned on, the potentials for the ionizer
elements are brought to their setpoints.

However, this command and be used to keep the ionizer potentials in place even when the
filament is off. This may be useful for specialized uses of the RGA where filament is not
required, but the electric field created by the ionizer elements are still necessary.

Possible values for AUTOmode are as follows:
1, ON, DEFault— Auto mode on, lonizer potentials are set when the filament is on,
and grounded when the filament is off.
0, OFF - Auto mode off. lonizer potentials remain at their set points even
when the filament is off.

Note: On instrument startup, the ionizer potentials automode is always set to ON.

IONIZER:POTENTIALS:AUTOmode?
Returns the state of the ionizer potentials automatic mode. Possible values are:

1 —ionizer element potentials automatically grounded when filament is off
0 — ionizer element potentials remain at their setpoints when filament is off
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Scan Commands

SCAN:ANAlog?
Execute an analog scan under the present scan conditions.

Analog scanning is the most basic operation of the RGA as a quadrupole mass
spectrometer. During analog scanning, the quadrupole mass spectrometer is stepped at
fixed mass increments through a pre-specified mass range. The ion current is measured
after each mass increment step and transmitted to the host computer over the external
interface used when entering this command. The mass range for the scan is set in advance
with the commands SCAN:MASS : INITIAL (initial mass), SCAN : MASS : FINAL (final
mass), and mass increments are fixed with the command SCAN:RESolution (Scan
resolution points per amu)

The type of detector used, whether Faraday Cup or CEM, is determined using the
CEM:VOLT command. The scan rate, how fast measurements progress, is set using the
SCAN:RATE command. A current value is transmitted for each mass increment value
between initial and final mass for a total of (final mass — initial mass) * scan resolution +
1 measurements. (See SCAN:ANAlog: POINTS?)

The ion currents are represented as 32-bit single precision floating point numbers in units
of 10"%®* Amps, and transmitted directly in hex format (four bytes, 2’s complement, little
endian format).

Important:

Any command received by the RGA in the middle of a scan will immediately stop the
scan, halt transmission and clear the RGA’s transmit buffer.

The detector’s zero offset and the internal scan parameters are checked and corrected at
the beginning of each scan resulting in a slight delay before the scan actually starts. See
SCAN:OFFSET : AUTO to disable this feature to reduce scan overhead.

A Total Pressure measurement is performed at the end of each scan and transmitted out to
the host computer. See the PRESSURE : TOTAL : ENable command to disable or enable
this measurement. If this measurement is disabled, the measurement will not be made,
however, the total pressure will still be reported as a 4-byte floating point number
representing O pressure.

Programming Tips:

Any command received by the RGA while scanning will immediately stop the scan
process and clear he RGA’s transmit buffer. Remember to also clear the computer’s
receive buffer to reset the communications. The new command which stopped the scan
will be executed.

The RGA has the ability to store a complete scan in its output buffer. The scan remains in
memory until all the data is transmitted out to the host computer. As a result of the high
acquisition rate of the RGA, there might be a delay between the time at which the data is
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collected internally and the time at which a complete spectrum is transmitted to the host
computer. The time lag between data acquisition and transmission depends on a large
number of factors including the scan rate (SCAN: RATE) of the RGA, the host
computer’s processing speed, and the amount of handshaking activity over the external
interface.

SCAN:ANAI0g:POINTS?

Query the total number of ion currents that will be measured and transmitted during an
analog scan under the current scan conditions.

Important: The query response does not include the extra current (4 bytes) corresponding
to the total pressure measurement performed at the end of the analog scans (Please see
SCAN:ANAlog? command for details.)

The number of points (i.e. ion currents) returned is calculated based on the initial mass,
final mass, and scan resolution parameters. Number of points = (final mass — initial mass)
* scan resolution + 1. The first point corresponds to the initial mass value and the
subsequent values are from scanning to the final mass with the scan resolution steps per
amu. Each point transmitted represents an ion current and as such corresponds to 4 bytes
being received by the host computer.

The query is used to verify that the RGA and the host computer agree on the number of
bytes that will be exchanged over the remote interface during an analog scan.

The total number of bytes sent out to the host computer during an analog scan is obtained
by multiplying by four the number returned by the query plus the four bytes that
corresponds to the total pressure measurement. Note that if the total pressure
measurement is disabled, the four bytes are still transmitted that represents zero.

SCAN:FILTER:ENable <0 | 1| OFF | ON >
Allowed values:

. 0 or OFF disables this feature
. 1 or ON enables this feature

Enables (or disables) the ion current noise filter when performing an Analog Scan (using
SCAN:ANAlog?), a Histogram Scan (using SCAN:HISTogram?), Or asingle or
multiple mass scan (SCAN: SINGLE? or SCAN:MULTIPLE?).

The ion current noise filter smooths out high-frequency noise components from the ion
current measurement by selectively averaging measurements from nearby mass
increments. This results in more easily recognizable mass peaks for each mass number.
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SCAN:FILTER:ENable?

Returns the state of the ion current noise filter. The possible return values are:

0 — noise filter disabled
1 — noise filter enabled

SCAN:HISTogram?

Execute a histogram scan under the present scan conditions.

A histogram scan consists of a succession of individual mass measurements (see
SCAN: SINGLE command) over a pre-specified mass range.

The mass range for the scan is set in advance with the commands
SCAN:MASS:INITIAL (initial mass) and SCAN:MASS : FINAL (final mass). The type
of detector used, whether Faraday Cup or CEM, is determined using the CEM: VOLT
command. The scan rate, how fast measurements progress, is set using the SCAN: RATE
command. A current value is transmitted for each integer mass value between initial and
final mass for a total of (final mass — initial mass + 1) measurements. (See
SCAN:HISTogram: POINTS?)

For maximum data throughput, ion currents are represented as 32-bit single precision
floating point numbers in units of 10-* Amps, and transmitted directly in hex format
(four bytes, 2’s complement, little endian format).

Important:

Any command received by the RGA in the middle of a scan will immediately stop the
scan, halt transmission and clear the RGA’s transmit buffer.

The detector’s zero offset and the internal scan parameters are checked and corrected at
the beginning of each scan resulting in a slight delay before the scan actually starts. See
SCAN:OFFSET : AUTO to disable this feature to reduce scan overhead.

A Total Pressure measurement is performed at the end of each scan and transmitted out to
the host computer. See the PRESSURE : TOTAL : ENable command to disable or enable
this measurement. If this measurement is disabled, the measurement will not be made,
however, the total pressure will still be reported as a 4-byte floating point number
representing O pressure.

SCAN:HISTogram:POINTS?

Query the total number of ion currents that will be measured and transmitted during a
histogram scan under the current scan conditions.

Important: The query response does not include the extra current (4 bytes) corresponding
to the total pressure measurement performed at the end of the histogram scan (Please see
SCAN:HISTogram? command for details.)
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The number of points (i.e. ion currents) returned is calculated based on the initial mass
and final mass parameters. Number of points = (final mass — initial mass) + 1. The first
point corresponds to the initial mass value and the subsequent values are from scanning
to the final mass with scan resolution of one step per amu. Each point transmitted
represents an ion current and as such corresponds to 4 bytes being received by the host
computer.

The query is used to verify that the RGA and the host computer agree on the number of
bytes that will be exchanged over the remote interface during a histogram scan.

The total number of bytes sent out to the host computer during a histogram scan is
obtained by multiplying by four the number returned by the query plus the four bytes that
corresponds to the total pressure measurement. Note that if the total pressure
measurement is disabled, the four bytes are still transmitted that represents zero.

SCAN:MASS:FINAL < integer value in mass units >
Allowed values: 1 to M_MAX where M_MAX is based on the RGA model (120, 220, or
320)
Set the final mass value (in amu) for Analog and Histogram scans.

The last ion current measurement during an analog or histogram scan corresponds to the
mass-to-charge ratio specified by the parameter to this command.

Note that the final mass setting is shared by both Histogram and Analog scans, and must
be an integer number.

The argument value must be within the allowed range and must be greater than or equal
to the final mass value given by SCAN:MASS: INITIAL.

SCAN:MASS:FINAL?

Returns the final mass value to be measured during an analog or histogram scan.

SCAN:MASS:INITial < integer value in mass units >

Allowed values: 1 to M_MAX where M_MAX is based on the RGA model (120, 220, or
320)

Set the initial mass value (in amu) for Analog and Histogram scans.

The first ion current measurement during an analog or histogram scan corresponds to the
mass-to-charge ratio specified by the parameter to this command.

Note that the initial mass setting is shared by both Histogram and Analog scans, and must
be an integer number.
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The argument value must be within the allowed range and must be less than or equal to
the final mass value given by SCAN:MASS : FINAL.

SCAN:MASS:INITial?

Returns the initial mass value to be measured during an analog or histogram scan.

SCAN:MULTIPLE? < (m1, my, ... my) > list of integer mass numbers

Allowed values: A table of up to 20 integer mass numbers, from 1 to M_MAX where
M_MAX is 120, 220, or 320 depending on the RGA model. Each
mass should be separated by commands, and the entire list should be
surrounded by parentheses.

Example:
SCAN:MULTPLE? (14, 18, 28, 32, 40, 44)

Execute multiple single ion current measurements at specified mass settings. The
parameters are the integer mass numbers (mass-to-charge ratio in amu units) at which the
measurements are performed.

The type of detector and scan rate settings to be used by the measurement must be
selected in advance with the CEM: VOLT and SCAN: RATE commands.

The precision and duration of the measurement are totally determined by the
SCAN:RATE setting. The command execution time includes some initial time spent
waiting for the Quadrupole Mass Filter and the electrometer response to settle. As usual,
a compromise must be made between signal-to-noise and measurement time.

The ion currents are expressed in the same format as for analog and histogram scans: 4
bytes long, single-precision floating point number in little-endian format representing the
ion current in units of 10" A. One 4 byte value will be transmitted for each mass in the
argument list.

This command can be used to perform multiple single mass scan measurements at
different masses while avoiding the overhead from remote interface communications and
pre-scan offset measurement and RF settling time.

The masses can be listed in any order, and may be repeated within the command. The ion
currents will be scanned and transmitted in the order requested in the list.

Important:

During a Multiple Mass Measurement, the RGA performs a “Miniscan” around each
mass requested, and the maximum current value measured is sent to the host computer
over the external interface. The scanning procedure, referred to as Peak-Locking, is
designed to measure peak currents for individual masses in a mass spectrum without
being affected by drifts in the mass-axis calibration. The Miniscan covers a 0.6 amu
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range centered at the mass requested, and selects the maximum current from 13
individual measurements performed at 0.05 amu mass increments.

The detector settings (type of detector and scan rate settings) to be used during the
measurement must be selected in advance with the CEM: VOLT and SCAN: RATE
commands. The measurements are performed with the detector settings at the time the
scan is triggered.

The ion detector offset is measured at the start of this command. The noise level
associated with this offset measurement correlates with the speed of the scan through the
SCAN:RATE parameter. This offset measurement requires some amount of time to
complete. This offset measurement can be bypassed using the SCAN: OFFSET : AUTO
command. Note: If the offset has not been measured yet since power on, the first scan
will force one offset measurement regardless of the setting for SCAN : OFFSET : AUTO.

SCAN:OFFSET:AUTO <0 | 1| OFF | ON >

Allowed values: 0, OFF — Disables automatic offset measurements
1, ON — Enables automatic offset measurements

Prior to any ion mass scan, whether analog, histogram, single, or multiple, a detector
offset reading is usually made to estimate the detector zero level. This measurement can
be disabled to reduce time overhead prior to each scan.

Note: Regardless of the setting of this command, if the offset has not yet been measured
since power-on, the RGA will force one measurement of the offset at the start of the first
scan.

SCAN:OFFSET:AUTO?

Returns whether detector offsets will be measured automatically before any ion current
scan.

Return values:

0 — Offset Measurements Disabled
1 — Offset Measurements Enabled

SCAN:OFFSET:AVERAGE < integer value >
Allowed values: integer value from 1 to 100.

Set the averaging constant used to smooth out variations in scan-to-scan detector offset
measurements.

Detector offset measurements may be subject to noise. Any one noisy detector offset
measurement may cause an entire scan spectrum to change by the noise in the offset
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measurement. By averaging the offset measurement over several scans, the effect on each
scan’s overall offset noise level can be reduced.

The parameter is used as the smoothing factor in an exponential moving average filter,
where the smoothing factor is the inverse of the integer argument.

A value of 1 indicates no averaging while larger values indicate a longer filter time.
While some filtering is useful to filter out short-term noise, it is usually best to keep the
averaging constant small. Large filter constants can cause a long lag if the detector zero
does shift due to external factors such as change in temperature, and this change in offset
may not be seen for a significant time if too large a filter value is used.

Note:

Regardless of the offset average filter constant, the first offset value measured at the first
scan will be used as the starting point for future filtering.

SCAN:OFFSET:AVERAGE?

Returns an integer indicating the exponential average filter constant used for filtering the
noise in the electrometer offset value measurement from scan to scan. The value returned
is the inverse of the smoothing constant in the exponential average filter used.

SCAN:OFFSET:CEM < floating point value in 101 A >
Allowed values: Any value representable as a single precision 32-bit floating point value.

Manually set the detector offset value used for scans using the CEM as the electrometer
detector. Normally, this command is unnecessary. The electrometer offset value is
measured at the start of a scan initiated by the user. However, this command allows the
user flexibility to set a manual value if desired.

Note: While the user can set this value, it remains subject to change with future scans. To
set this value as a constant, be sure to disable automatic offset measurements with
SCAN:OFFSET:AUTO OFF.

SCAN:OFFSET:CEM?

Returns the detector offset value that was last set or measured using the CEM as the
electrometer detector.

This value is updated after it is set manually using SCAN: OFFSET : CEM or after an
offset measurement is made before a scan when SCAN: OFFSET : AUTO is enabled. Any
offset measurement made before a scan is filtered with an exponential moving average
filter described by SCAN: OFFSET : AVERAGE. The filtered value is the offset value set
here and is used as the offset value for the scan that follows.
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SCAN:OFFSET:FC < floating point value in 1016 A >
Allowed values: Any value representable as a single precision 32-bit floating point value.

Manually set the detector offset value used for scans using the Faraday Cup as the
electrometer detector. Normally, this command is unnecessary. The electrometer offset
value is measured at the start of a scan initiated by the user. However, this command
allows the user flexibility to set a manual value if desired.

Note: While the user can set this value, it remains subject to change with future scans. To
set this value as a constant, be sure to disable automatic offset measurements with
SCAN:OFFSET:AUTO OFF.

SCAN:OFFSET:FC?

Returns the detector offset value that was last set or measured using the Faraday Cup as
the electrometer detector.

This value is updated after it is set manually using SCAN: OFFSET : FC or after an offset
measurement is made before a scan when SCAN: OFFSET : AUTO is enabled. Any offset
measurement made before a scan is filtered with an exponential moving average filter
described by SCAN: OFFSET : AVERAGE. The filtered value is the offset value set here
and is used as the offset value for the scan that follows.

SCAN:RATE < floating point value in amu per second >
Allowed values: 0.08 to 260.4 amu per second
Set the rate for ion current measurements.

A decrease in scan rate setting results in cleaner baselines and lower detection limits
during scans and single mass measurements, but also means longer measurement and
scanning times due to the reduced bandwidth of the electrometer and increased
averaging,

The SCAN: RATE parameter bust be chosen keeping in mind the strong interplay between
detection limits and acquisition speed.

Histogram scans, analog scans, single-mass measurements, multiple mass measurements,
and total pressure measurements all share the same value of SCAN: RATE.

Important: The SCAN : RATE parameter is set to its default value with the RGA is
powered on.

The scan rate indicates how quickly a scan will progress. For example, an analog scan
from 1 to 100 with a scan rate of 1 Amu/second should take about 99 seconds to
complete after the initial pre-scan overhead is completed. This remains true for all scan
resolution settings. The scan rate set here is the target scan rate. Internally, the actual scan
rate is calculated to be as close as possible to the requested scan rate. The analog scan
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rate will depend on the SCAN: RESolution parameter value. The histogram scan rate
will be calculated based on the fixed 0.05 amu scan resolution.

See either SCAN:RATE : ANAlog? Of SCAN:RATE : HISTogram? to read back the
actual scan rate that will be used for a scan.

Note: single-mass and multiple-mass measurements will use the
SCAN:RATE:HISTogram? calculated scan rate value.

SCAN:RATE?

Returns the target scan rate in amu/s for an ion current mass scan.

SCAN:RATE:ANAlog?

The user sets the target scan rate using the SCAN : RATE command. The actual scan rate
for an analog scan is limited based on the scan resolution. This command returns the
closest scan rate that will be used for an analog scan.

Note: To achieve the highest scan rates, it is necessary to reduce the
SCAN:RESolution to lower values. The maximum scan rate of 260.4 amu/s can be
achieved only for a scan resolution of 10 points per amu.

SCAN:RATE:HISTogram?

The user sets the target scan rate using the SCAN : RATE command. The actual scan rate
for a histogram scan is limited based on the fixed resolution steps used for a histogram
scan. This command returns the closest scan rate that will be used for a histogram scan,
or for a single-mass or multiple-mass measurement.

Note: The fixed resolution of a histogram scan limits the upper-end of the scan rate to
about 130.2 amu/second.

SCAN:RESolution <integer divisions per amu >
Allowed values: integer value from 10 to 25.

Set the number of steps executed per amu for an analog scan. The parameter specifies the
number of steps per amu.

During an analog scan, the quadrupole mass filter is stepped at fixed mass increments
through the mass range specified by the initial mass (MASS: INITIAL) and final mass
(MASS: FINAL) values. An ion current is measured after each step and transmitted to the
host computer over the remote interface. This command programs the number of steps
executed by the RGA per amu of an analog scan. The fixed mass increment is equal to
the inverse of the command parameter value. The parameter value can be interpreted as
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the approximate number of ion currents to be collected for each mass peak in the
spectrum.

SCAN:RESolution?

Returns the number of steps per amu currently in use for analog scans. lon currents will
be returned for an analog scan for each mass increment from initial mass to final mass,
and the mass increment will be equal to the inverse of the scan resolution returned by this
command.

SCAN:SETTLINGtime < time in milliseconds >
Allowed values: 0 to 2000.0 milliseconds

This sets the amount of time that will be used for the initial Quadrupole Mass Filter
RF/DC setting for settling to its initial state before starting a scan or a measurement.

Normally, this command is unnecessary. The factory setting for settling time is sufficient
to settle the RF/DC settings prior to the start of measurements. However, this command is
made available for situations where the user may benefit from longer or shorter settling
times.

SCAN:SETTLINGtime?

Before a scan is started, the Quadrupole Mass Filter RF/DC voltages are set. These take
some time to settle to their set value. This command returns the number of milliseconds
that the instrument idles while it waits for the RF/DC voltages to settle.

SCAN:SINGLE? < integer value in mass units >

Allowed values: 1 to M_MAX where M_MAX is 120, 220, or 320 depending on the
RGA model.

Execute a single ion current measurement at a specified mass setting. The parameter is an
integer mass number (mass-to-charge ratio in amu units) at which the measurement is
performed.

The type of detector and scan rate settings to be used by the measurement must be
selected in advance with the CEM: VOLT and SCAN : RATE commands.

The precision and duration of the measurement are totally determined by the
SCAN:RATE setting. The command execution time includes some initial time spent
waiting for the Quadrupole Mass Filter and the electrometer response to settle. As usual,
a compromise must be made between signal-to-noise and measurement time.

SRS Residual Gas Analyzer



Remote Command Set 6-31

The ion current is expressed in the same format as for analog and histogram scans: 4
bytes long, single-precision floating point number in little-endian format representing the
ion current in units of 1026 A,

Important:

During a Single Mass Measurement, the RGA performs a “Miniscan” around the mass
requested, and the maximum current value measured is sent to the host computer over the
external interface. The scanning procedure, referred to as Peak-Locking, is designed to
measure peak currents for individual masses in a mass spectrum without being affected
by drifts in the mass-axis calibration. The Miniscan covers a 0.6 amu range centered at
the mass requested, and selects the maximum current from 13 individual measurements
performed at 0.05 amu mass increments.

The detector settings (type of detector and scan rate settings) to be used during the
measurement must be selected in advance with the CEM: VOLT and SCAN: RATE
commands. The measurements are performed with the detector settings at the time the
scan is triggered.

The ion detector offset is measured at the start of this command. The noise level
associated with this offset measurement correlates with the speed of the scan through the
SCAN:RATE parameter. This offset measurement requires some amount of time to
complete. This offset measurement can be bypassed using the SCAN: OFFSET :ENable
command. Note: If the offset has not been measured yet since power on, the first scan
will force one offset measurement regardless of the setting for
SCAN:OFFSET:ENable.

Filament Status Commands

FILament:EMISsion?

The filament electron emission current is monitored on a regular basis. Readings are
taken every 20 milliseconds. This command returns the last measurement of filament
emission current in milliamps. If the filament is not energized, or if the reading is below
the minimal possible reading, a value of 0.00 is returned.

FlLament:VOLTage?

Returns the last reading of the measured voltage drop over the filament in volts.
Readings are taken every 20 milliseconds. If the filament is not energized, a value of 0.00
is returned.

FlLament:CURRent?

Returns the last reading of the measured current through the filament in amperes.
Readings are taken every 20 milliseconds. If the filament is not energized, a value of 0.00
is returned.
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CEM Settings commands

CEM:OPTION?
Query the electron multiplier (CEM) option in the RGA unit being programmed.
The RGA is provided standard with a Faraday Cup detector. For increased sensitivity and
faster scan rates, an optional CEM is offered. The MO? command can be used to
determine whether the CEM detector is an option for this RGA.

Possible return values:

0 — CEM option is not available
1 - CEM option is available

CEM:STORED:GAIN <valuex1000>
Valid values: 0.0 to 2000.0

Store a value of electron multiplier (CEM) gain in non-volatile memory in the RGA. The
gain parameter value is expressed in units of thousands.

The command is typically used with CEM: STORED : MASS and
CEM: STORED:VOLTage to store the set of values associated with calibrating the gain
of the CEM module.

Note: The gain stored by this command is not used by the RGA to correct ion currents
measured with the CEM. This value is used for storage for later retrieval by a controlling
host computer.

CEM:STORED:GAIN?

Returns the CEM gain value stored in non-volatile memory in the RGA. This can be used
by a controlling host computer to retrieve previous settings at a later time.

CEM:STORED:MASS <value in AMU>
Valid values: 0 to maximum mass of instrument model (120, 220, 320)

Store a mass in non-volatile memory in the RGA. The mass parameter is expressed in
units of AMU. The stored mass value is helpful to reference which mass value was used
to calculate the stored gain and voltage settings.

The command is typically used with CEM: STORED : GAIN and
CEM: STORED:VOLTage to store the set of values associated with calibrating the gain
of the CEM module.
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Note: The mass stored by this command is not used by the RGA to correct ion currents
measured with the CEM. This value is used for storage for later retrieval by a controlling
host computer.

CEM:STORED:MASS?

Returns the CEM mass value stored in non-volatile memory in the RGA. This can be
used by a controlling host computer to retrieve previous settings at a later time.

CEM:STORED:VOLTage <value in Volts>
Allowed values: 0.0 to 2490.0

Store a value of electron multiplier (CEM) voltage in non-volatile memory in the RGA.
The voltage parameter is expressed in Volts. The stored voltage value is helpful to
reference a CEM voltage potential for CEM operation at a later time.

The command is typically used with CEM: STORED: MASS and CEM: STORED : GAIN to
store the set of values associated with calibrating the gain of the CEM module.

Note: The voltage stored by this command is not used by the RGA to correct ion currents
measured with the CEM. This value is used for storage for later retrieval by a controlling
host computer.

CEM:STORED:VOLTage?

Returns the CEM voltage value stored in non-volatile memory in the RGA. This can be
used by a controlling host computer to retrieve previous settings at a later time.

CEM:VOLT <DEFault | value in volts>

Valid values: 0 — 2490 V. DEFault = 1400 V

Set a negative voltage potential across the electron multiplier. The parameter value
represents the magnitude of the bias voltage in Volts. The high voltage on the CEM
allows the CEM to magnify ion currents. This increases the sensitivity of the
electrometer. The electrometer can then measure these magnified currents that would
otherwise be too small to be measured using the Faraday Cup.

NOTE: When the RGA is powered on, the RGA electrometer is set to measure ion
currents from the Faraday Cup. To use the CEM, this command must be used to enable
the CEM and set the voltage potential.

NOTE: The voltage set by this command is the output of the high voltage power supply.
A 2 MOhm resistor is placed between that output and the CEM cone. The internal
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resistance of a typical CEM have a range between 50-2500 MOhm. The CEM becomes
part of a voltage divider in conjunction with the 2 MOhm resistor. As a result, the
voltage measured on the CEM will always have a magnitude smaller than the value set by
this command.

CEM:VOLT 0

. When set to 0 volts, the instrument will be configured to measure ion
currents from the Faraday Cup.

. lon current will be reported to the host system during subsequent
. The CEM indicator LED will be turned off as an outward sign that the
CEM is off.

CEM:VOLT <wvalue> value>0

. This will enable the CEM for ion current detection.

. The requested bias voltage is set on the CEM.

. The electrometer is configured to measure the CEM electron current.

. Electron currents will be reported to the host system controlling the RGA

during all subsequent scans.

. The CEM indicator LED will be turned on as an outward sign that the
CEM ison.

Degas Commands

DEGAS:RUNNING?

Query the state of the DEGAS procedure. Return values are 0 - not running, 1 - running.

DEGAS:START

Start the degas procedure. The evolution of the procedure is outlined above. After
entering this command, control is immediately released back to the user.

Changes to instrument voltages and other internal parameters are locked out until the
procedure has completed or is stopped with DEGAS : STOP. If such an attempt is made,
the status bit PROCEDURE_RUNNING will be set. See Instrument Status for more
details.

DEGAS:STOP
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Stops the degas procedure if it is currently running. Filament emission, CEM bias
voltage, and ionizer potentials will be restored to the original values from before the
procedure started.

DEGAS:TIME <integer minutes | DEFault>
Allowed values: 0 — 20 minutes, DEFault = 3 minutes

This command sets the total time for the degas procedure. This includes the initial ramp-
up time of 1 minute.

The parameter is an integer with a range of 0 to 20 minutes. If the time is set to 0,
DEGAS : START will immediately end with no degas procedure.

DEGAS:TIME?

Returns the requested total time for the degas procedure in minutes. The value will be an
integer from O to 20.

Pressure Commands

PRESsure:SENSitivity: PARTIAL <value in mA/Torr >
Allowed values: 0.0 — 10.0 mA/Torr

Store a value of Partial Pressure Sensitivity, expressed in mA/Torr, in non-volatile
memory of the SRS RGA head.

Important: The sensitivity factor is not used internally by the RGA to convert ion currents
into partial pressures. It is simply stored in memory so it can be read and used by any
host computer connected to the instrument.

Partial Pressure Sensitivity factors are gas specific, probe specific, and highly dependent
on the ionizer and quadrupole mass filter conditions and on aging of the probe.

Note: The parameter value loaded at the factory is the partial pressure sensitivity factor
for N2 under default ionizer conditions.

Typical value is 0.1 under default ionizer settings.

PRESsure:SENSitivity: PARTIAL?

Returns the partial pressure sensitivity factor stored in non-volatile memory in the RGA.
The value is in units of mA/Torr.
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PRESsure:SENSiItivity: TOTAL < value in mA/Torr >
Allowed values: 0.0 — 100.0 mA/Torr

Store a value of Total Pressure Sensitivity, expressed in mA/Torr, in non-volatile
memory of the SRS RGA head.

Important: The sensitivity factor is not used internally by the RGA to convert ion currents
into a total pressure. It is simply stored in memory so it can be read and used by any host
computer connected to the instrument.

Total Pressure Sensitivity factors are gas specific, probe specific, and highly dependent
on the ionizer and quadrupole mass filter conditions and on aging of the probe.

Note: The parameter value loaded at the factory is the total pressure sensitivity factor for
N2 under default ionizer conditions.

Typical value is 0.01 under default ionizer settings.

PRESsure:SENSitivity: TOTAL?

Returns the total pressure sensitivity factor stored in non-volatile memory in the RGA.
The value is in units of mA/Torr.

PRESsure:SENSitivity: TOTAL:OFFSET < value in 101 A >
Allowed values: Any floating point value

Store a value of Total Pressure offset ion current, expressed in 101® A, in non-volatile
memory of the SRS RGA head.

Important: The total pressure offset is not used internally by the RGA to convert ion
currents into a total pressure. It is simply stored in memory so it can be read and used by
any host computer connected to the instrument.

Note: The parameter value loaded at the factory is the total pressure offset factor for N
under default ionizer conditions.

PRESsure:SENSitivity: TOTAL:OFFSET?

Returns the total pressure offset stored in non-volatile memory in the RGA. The value is
in units of 10 A.

PRESsure:TOTAL:ENable <0 |1 | OFF | ON >

Allowed values: 0, OFF — Disables total pressure measurements
1, ON - Enables total pressure measurements
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Total pressure measurements are automatically requested at the end of each analog and
histogram scan, and can also be made directly by the user with the PRESsure: TOTAL?
Command. The response of the RGA to a total pressure measurements request at the end
of an analog or histogram scan depends on the status of this parameter at the time the
measurement is requested.

If enabled, the measurement is performed and the total ion current is transmitted over the
external interface.

If disabled, no measurement is made. A zero ion current is returned at the request for any
total pressure measurement. This includes at the end of an analog or histogram scan.

Total pressure measurements are enabled on power-on reset and is disabled when the
CEM is activated.

When a total pressure measurement is made at the end of an analog or histogram scan,
the total ion current measured by the electrometer is transmitted as a 4-byte long single-
precision floating point number in little endian format representing ion current in units of
1016 A,

If a total pressure measurement is made on demand with PRESsure: TOTAL?, the total
ion current will be returned as a floating point number in ASCII format.

Notes:

While performing a total pressure measurement, the RF in the quadrupole mass filter is
set to a low mass value and the DC bias is set near zero. All ionic species have stable
trajectories down the filter under those conditions and reach the ion current detector with
different efficiencies.

The Total Pressure Measurement is disabled whenever the CEM is energized to any
voltage more than 0 V. This is done to protect the multiplier from large ion currents. The
Total Pressure Measurement may be enabled after energizing the CEM after making sure
the total pressure is in a “safe” range for the CEM.

The sensitivity of the RGA for total pressure measurements will usually be affected after
mass axis recalibrations. Check the sensitivity calibration after any peak tuning
procedure.

Important: The sensitivity factor for the Total Pressure measurements is highly mass
dependent. The additional mass discrimination that takes place in the filter results in the
mass dependence of the RGA readings being very different from that of the Bayard
Alpert gauge readings. Expect to see deviations between the two gauges as the
composition of a residual gas changes.

PRESsure: TOTAL:ENable?

Returns the state of total pressure measurements. If disabled, any request for a total
pressure measurement will return a value of 0.0
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0 — Total Pressure measurements Disabled
1 — Total Pressure measurements Enabled

PRESsure:TOTAL?

If total pressure measurements are enabled, this command will start a total pressure
measurement and return the total ion current as a floating point value in ASCII format in
units of 10 A.

If total pressure measurements are disabled, this command will return 0.0. A total
pressure measurement is not started.
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Instrument Status Commands

Instrument Status Registers are used to communicate to the user unusual or abnormal
status events that have occurred in the instrument. By monitoring the status registers on a
regular basis, the user can be informed of errors or problems encountered by the
instrument, and can take action appropriately.

The status registers are broken down into a set of related events. Each register consists of
up to 16 bits. Each bit corresponds to one type of instrument status.

The general status register description is listed in the table below. For additional
information about the individual events in each register, consult the Instrument Status
section of the manual.

Register Number | Weight | Description
0 1 Communications
1 2 Filament
2 4 QMF
3 8 CEM
4 16 Auxiliary 1/0
5 32 lon Detector
6 64 Power Supply
7 128 lonizer
8 256 Electronics
9 512 Pressure

Table 6-2 Instrument Status Registers

STATus:CONDition? < status register number >
STATus:CONDition? < status register number, integer status bit >

Read the status condition register or an individual status condition register bit.

The first form of the command, using the status condition register number as a single
parameter, will give a result of all the status condition bits in a status condition register.

The return value is an integer that is the sum of the individual weights for those status
conditions that are set within the specified register.

The second form allows the user to query a specific individual status condition within the
status condition register.

Possible return values when querying an individual status condition bit

0 — Status condition not set
1 — Status condition set
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The Instrument Status section details the status conditions defined for each register.

STATus:CONDition:ASSERT

This command copies any bits that are set in each status condition register onto their
respective event register.

When a status condition is detected, the corresponding bit in the event register is also set.
When the event register is read, all bits in the event register are cleared. However, if the
condition remains active, the bit in the corresponding event register does not get set again
immediately.

Normally, an event register bit is set only when a status condition is detected and changes
from O to 1. If the status condition does not reset to 0, the corresponding bit in the event
register will not be set even though the status condition bit is set to 1.

This command can be used to see what status conditions may still persist even though the
event register was set. This may be useful if the event register was read, and thus reset to
0, and needs to be read once again at some future time.

STATus:DEFaultmask

This command resets the instrument status event enabled bits to their default settings. It
also resets the Service LED register mask to the default setting back to the power-on
condition.

See the Instrument Status section for more details on the default settings that are applied
by this command.

STATus:EVent? < status register number >
STATus:EVent? < status register number, status bit >

Read the status event register or an individual status event register bit.

The first form of the command, using the status event register number as a single
parameter, will give a result of all the status event bits in a status event register.

The return value is an integer that is the sum of the individual weights for those status
events that are set within the specified register.

The second form allows the user to query a specific individual status event within the
status event register.

Possible return values when querying an individual status event bit
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0 — Status event not set
1 — Status event set

The Instrument Status section details the status conditions defined for each register.

Note: When an event register is queried, the entire event register is cleared back to 0.
When an individual event bit is queried, only that event bit is cleared back to 0.

After a status event has been cleared, it may remain cleared even when the corresponding
status condition remains set. The status event will be set only after the status condition is
reset first and set afterwards.

STATus:EVent:ENable < status register number, integer value >
STATus:EVent:ENable < status register number, status bit,0| 1 | OFF | ON >

Set all bits for an instrument status event enabled register or an individual status event
enabled bit in one register. When an event enabled bit is set to 1 or ON, the event bit will
be set when the corresponding status condition changes from unset to set.

In the first form of the command, the user can set or reset all event bits within an entire
status event register. The allowed range of register numbers is detailed in the Table 6-2
Instrument Status Registers above.

The event enable parameter value is formed by adding the weights of all event bits that
are to be enabled. All other bits in the register will be disabled.

Event register have a maximum of 16 event bits. The second parameter has a range of

values of 0 to 65535. This allows access to set and reset all 16 possible event bits in the
specified register

In the second form of the command, the user can set or reset an individual event bit
within a status event register.

The allowed range of register numbers is detailed in the Table 6-2 Instrument Status
Registers above.

The second parameter specifies the event enabled bit within the status register. There are
a total of up to 16 event bits per register. The allowed values are integers from 0 to 15.

The event bit state specifies what the event enabled bit should be set to by this command.

Allowed values: 0, OFF — Disables status event
1, ON — Enables status event
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STATus:EVent:ENable? < status register number >
STATus:EVent:ENable? < status register number, status bit >

This command returns the setting for the specified instrument status event enabled
register, or for an individual event within an instrument status event enabled register.

When enabled, the instrument status registers can be used to notify the user of error or
problems inside the instrument.

In the first form of the command, the command returns the combined setting for event
enabled bits within an individual register. The value is the sum of all the weights for each
event that is enabled. All other events within a register are disabled. The allowed range of
register numbers is detailed in the Table 6-2 Instrument Status Registers above.

In the second form of the command, the command returns the event enabled status for an
individual event.

The allowed range of register numbers is detailed in the Table 6-2 Instrument Status
Registers above.

The second parameter specifies the event enabled bit within the status register. There are
a total of up to 16 event bits per register. The allowed values are integers from 0 to 15.

Possible return values are:

0 — Instrument Status Event is disabled
1 — Instrument Status Event is enabled.

STATus:GLOBal?
STATus:GLOBal? < status register number >

This command returns the combined event state for all instrument status event registers
or for an individual status event register.

This allows for a quick summary of all enabled instrument status events rather than
guerying each status event register individually.

In the first form of the command, the command returns the combined state of all enabled
events within each status event register. The value is the sum of all the weights for each
event register that has at least one event enabled and set. The weights are listed in the
Table 6-2 Instrument Status Registers above.

In the second form of the command, the parameter specifies the status event register to be
queried. The allowed range of register numbers is detailed in the Table 6-2 Instrument
Status Registers above.
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The returned value indicates if any status event for the specified register is enabled and
set.

Possible return values are:

0 — No events are enabled and set in the status event register
1 — At least one event is enabled and set in the status event register

STATus:GLOBal:SERVicemask < integer value >
STATus:GLOBal:SERVicemask < status register number, 0| 1| OFF | ON >

This command connects the combined status of a status event register to the Service LED
on the back panel. This can be used to notify the user with the indicator light that the
instrument has encountered an error or other problem that should be addressed.

In the first form of the command, the user can connect or disconnect all the status event
register settings for the Service LED.

The parameter value is formed by adding the weights of all event registers to be
connected to the Service LED. All other event registers will be disconnected. For event
status register weights, see the Table 6-2 Instrument Status Registers above.

In the second form of the command, the user can connect or disconnect an individual
status event register to the Service LED.

The allowed range of register numbers is detailed in the Table 6-2 Instrument Status
Registers above.

The second parameter specifies whether the status event register is connected to the
Service LED or not.

Allowed values: 0, OFF — Status event register is disconnected from Service LED
1, ON — Status event register is connected to Service LED

STATus:GLOBal:SERVicemask?
STATus:GLOBal:SERVicemask? < status register number >

This command returns the combined value for all status event registers connected to the
Service LED or the connected status for an individual status event register.

This shows which status event registers are connected to the Service LED. When
connected, any status event that is enabled and set will cause the Service LED to light up.
This gives an external and immediate indication of a potential instrument error or
problem that should be addressed.
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In the first form of the command, the command returns the combined state of all
connected status event registers. The value is the sum of all the weights for each event
register that is connected. The weights are listed in the Table 6-2 Instrument Status
Registers above.

In the second form of the command, the parameter specifies the status event register to be
gueried. The allowed range of register numbers is detailed in the Table 6-2 Instrument
Status Registers above.

The returned value indicates if the status event register is connected to the Service LED.

Possible return values are:

0 — Status event register is not connected to the Service LED
1 — Status event register is connected to the Service LED.

Mass Filter Control Commands

QMF:MASS:LOCK < value in amu >

Allowed values: 0to M_MAX where M_MAX is based on the RGA model (120, 220,
or 320)

Activate the quadrupole mass filter (QMF) and center its pass-band at the mass value
specified by the parameter. The QMF is parked at the mass requested but no ion current
measurements take place.

The command execution involves two steps:

1. The RF/DC levels corresponding to the mass requested are calculated and set on
the QMF rods based on the mass axis calibration parameter values specified by
the last Peak Tuning procedure.

2. The firmware stabilizes the voltage output of the RF Driver’s controller against
temperature fluctuations.

3. The firmware also controls the RF frequency to maintain resonance between the
driver circuitry and the RF output on the rods.

Use QMF : MASS : LOCK 0 to turn off the RF/DC voltages when finished performing
measurements and before quitting the program controlling the RGA.
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QMF Tuning Commands

The QMF Tuning Commands relate a set of RF/DC tuning parameters to a calculation for
RF and DC voltages to be applied to the Quadrupole Mass Field.

The basic relationship is:

4

RF(V) = RFygpe (i) + MCAMU) % REf,oq(MHZ?) + RFyprsae(V) + REcopy(V)
4 2 2

DC(V) = DCslope (m) * M(AMU) * DCfreq (MHZ ) + DCoffset(V) + DCcorr(V)

RF/DC slope, offset, and correction factors can be adjusted using the commands in this
section. The RF Frequency is constantly being tuned by the RGA firmware. In practice,
this frequency is nominally between 2.6 and 2.8 MHz, but it is dependent on the RGA
and probe combination.

QMF:DC:OFFSET < value in Volts | FACTORY >

This is one parameter of the set of RF/DC tuning parameters. This 